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Technical Support

Contacting Technical
Support

You can contact Applied Biosystems for technical support by telephone or fax, by 
e-mail, or through the Internet. You can order Applied Biosystems user documents, 
MSDSs, certificates of analysis, and other related documents 24 hours a day. In 
addition, you can download documents in PDF format from the Applied Biosystems 
Web site (please see the section “To Obtain Documents on Demand” following the 
telephone information below).

To Contact Technical
Support by E-Mail

Contact technical support by e-mail for help in the following product areas:

Hours for Telephone
Technical Support

In the United States and Canada, technical support is available at the following times:

To Contact Technical
Support by

Telephone or Fax

In North America

To contact Applied Biosystems Technical Support, use the telephone or fax numbers 
given below. (To open a service call for other support needs, or in case of an 
emergency, dial 1-800-831-6844 and press 1.)

Product Area E-mail address

Genetic Analysis (DNA Sequencing) galab@appliedbiosystems.com

Sequence Detection Systems and PCR pcrlab@appliedbiosystems.com

Protein Sequencing, 
Peptide and DNA Synthesis

corelab@appliedbiosystems.com

Biochromatography, PerSeptive DNA, PNA 
and Peptide Synthesis systems, CytoFluor®, 
FMAT™, Voyager™, and Mariner™ Mass 
Spectrometers

tsupport@appliedbiosystems.com

Applied Biosystems/MDS Sciex api3-support@sciex.com

Chemiluminescence (Tropix) tropix@appliedbiosystems.com

Product Hours

Chemiluminescence 8:30 a.m. to 5:30 p.m. Eastern Time

Framingham support 8:00 a.m. to 6:00 p.m. Eastern Time

All Other Products 5:30 a.m. to 5:00 p.m. Pacific Time

Product or
Product Area

Telephone
Dial...

Fax
Dial...

ABI PRISM® 3700 DNA Analyzer 1-800-831-6844,
then press 8

1-650-638-5981

DNA Synthesis 1-800-831-6844,
then press 21

1-650-638-5981

Fluorescent DNA Sequencing 1-800-831-6844,
then press 22

1-650-638-5981

Fluorescent Fragment Analysis (includes 
GeneScan® applications)

1-800-831-6844,
then press 23

1-650-638-5981

Integrated Thermal Cyclers (ABI PRISM® 

877 and Catalyst 800 instruments)
1-800-831-6844,
then press 24

1-650-638-5981
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Outside North America

ABI PRISM® 3100 Genetic Analyzer 1-800-831-6844,
then press 26

1-650-638-5981

BioInformatics (includes BioLIMS™, 
BioMerge™, and SQL GT™ 
applications)

1-800-831-6844,
then press 25

1-505-982-7690

Peptide Synthesis (433 and 43X 
Systems)

1-800-831-6844,
then press 31

1-650-638-5981

Protein Sequencing (Procise Protein 
Sequencing Systems)

1-800-831-6844,
then press 32

1-650-638-5981

PCR and Sequence Detection 1-800-762-4001,
then press 1 for PCR,
2 for the 7700 or 5700,
6 for the 6700
or dial 1-800-831-6844, 
then press 5

1-240-453-4613

Voyager MALDI-TOF Biospectrometry 
and Mariner ESI-TOF Mass 
Spectrometry Workstations

1-800-899-5858,
then press 13

1-508-383-7855

Biochromatography (BioCAD 
Workstations and Poros Perfusion 
Chromatography Products)

1-800-899-5858,
then press 14

1-508-383-7855

Expedite Nucleic acid Synthesis 
Systems

1-800-899-5858,
then press 15

1-508-383-7855

Peptide Synthesis (Pioneer and 9050 
Plus Peptide Synthesizers)

1-800-899-5858,
then press 15

1-508-383-7855

PNA Custom and Synthesis 1-800-899-5858,
then press 15

1-508-383-7855

FMAT 8100 HTS System and 
Cytofluor 4000 Fluorescence Plate 
Reader

1-800-899-5858,
then press 16

1-508-383-7855

Chemiluminescence (Tropix) 1-800-542-2369 (U.S. 
only),
or 1-781-271-0045

1-781-275-8581

Applied Biosystems/MDS Sciex 1-800-952-4716 1-650-638-6223

Region
Telephone
Dial...

Fax
Dial...

Africa and the Middle East

Africa (English Speaking) and West Asia 
(Fairlands, South Africa)

27 11 478 0411 27 11 478 0349

South Africa (Johannesburg) 27 11 478 0411 27 11 478 0349

Middle Eastern Countries and North 
Africa (Monza, Italia)

39 (0)39 8389 481 39 (0)39 8389 493

Eastern Asia, China, Oceania

Australia (Scoresby, Victoria) 61 3 9730 8600 61 3 9730 8799

China (Beijing) 86 10 64106608 86 10 64106617

Product or
Product Area

Telephone
Dial...

Fax
Dial...
xviii



Hong Kong 852 2756 6928 852 2756 6968

Korea (Seoul) 82 2 593 6470/6471 82 2 593 6472

Malaysia (Petaling Jaya) 60 3 758 8268 60 3 754 9043

Singapore 65 896 2168 65 896 2147

Taiwan (Taipei Hsien) 886 2 22358 2838 886 2 2358 2839

Thailand (Bangkok) 66 2 719 6405 66 2 319 9788

Europe

Austria (Wien) 43 (0)1 867 35 75 0 43 (0)1 867 35 75 11

Belgium 32 (0)2 712 5555 32 (0)2 712 5516

Czech Republic and Slovakia (Praha) 420 2 61 222 164 420 2 61 222 168

Denmark (Naerum) 45 45 58 60 00 45 45 58 60 01

Finland (Espoo) 358 (0)9 251 24 250 358 (0)9 251 24 243

France (Paris) 33 (0)1 69 59 85 85 33 (0)1 69 59 85 00

Germany (Weiterstadt) 49 (0) 6150 101 0 49 (0) 6150 101 101

Hungary (Budapest) 36 (0)1 270 8398 36 (0)1 270 8288

Italy (Milano) 39 (0)39 83891 39 (0)39 838 9492

Norway (Oslo) 47 23 12 06 05 47 23 12 05 75

Poland, Lithuania, Latvia, and Estonia 
(Warszawa)

48 (22) 866 40 10 48 (22) 866 40 20

Portugal (Lisboa) 351 (0)22 605 33 14 351 (0)22 605 33 15

Russia (Moskva) 7 095 935 8888 7 095 564 8787

South East Europe (Zagreb, Croatia) 385 1 34 91 927 385 1 34 91 840

Spain (Tres Cantos) 34 (0)91 806 1210 34 (0)91 806 1206

Sweden (Stockholm) 46 (0)8 619 4400 46 (0)8 619 4401

Switzerland (Rotkreuz) 41 (0)41 799 7777 41 (0)41 790 0676

The Netherlands (Nieuwerkerk a/d 
IJssel)

31 (0)180 331400 31 (0)180 331409

United Kingdom (Warrington, Cheshire) 44 (0)1925 825650 44 (0)1925 282502

All other countries not listed
(Warrington, UK)

44 (0)1925 282481 44 (0)1925 282509

Japan

Japan (Hacchobori, Chuo-Ku, Tokyo) 81 3 5566 6230 81 3 5566 6507

Latin America

Del.A. Obregon, Mexico 305-670-4350 305-670-4349

Region
Telephone
Dial...

Fax
Dial...
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To Reach Technical
Support Through

the Internet

We strongly encourage you to visit our Web site for answers to frequently asked 
questions and for more information about our products. You can also order technical 
documents or an index of available documents and have them faxed or e-mailed to 
you through our site. The Applied Biosystems Web site address is

http://www.appliedbiosystems.com/techsupp

To Obtain
Documents on

Demand

Free, 24-hour access to Applied Biosystems technical documents, including MSDSs, 
is available by fax or e-mail or by download from our Web site.

To submit technical questions from North America or Europe:

Step Action

1 Access the Applied Biosystems Technical Support Web site.

2 Under the Troubleshooting heading, click Support Request Forms, then select the 
relevant support region for the product area of interest.

3 Enter the requested information and your question in the displayed form, then click 
Ask Us RIGHT NOW (blue button with yellow text).

4 Enter the required information in the next form (if you have not already done so), 
then click Ask Us RIGHT NOW.

You will receive an e-mail reply to your question from one of our technical experts 
within 24 to 48 hours.

To order 
documents... Then...

by index number a. Access the Applied Biosystems Technical Support Web site at 
http://www.appliedbiosystems.com/techsupp

b. Click the Index link for the document type you want, then find the 
document you want and record the index number.

c. Use the index number when requesting documents following the 
procedures below.

by phone for fax 
delivery

a. From the U.S. or Canada, call 1-800-487-6809, or
from outside the U.S. and Canada, call 1-858-712-0317.

b. Follow the voice instructions to order the documents you want.

Note There is a limit of five documents per request.

through the 
Internet for fax or 
e-mail delivery

a. Access the Applied Biosystems Technical Support Web site at 
http://www.appliedbiosystems.com/techsupp

b. Under Resource Libraries, click the type of document you want.

c. Enter or select the requested information in the displayed form, then 
click Search.

d. In the displayed search results, select a check box for the method of 
delivery for each document that matches your criteria, then click 
Deliver Selected Documents Now (or click the PDF icon for the 
document to download it immediately).

e. Fill in the information form (if you have not previously done so), then 
click Deliver Selected Documents Now to submit your order.

Note There is a limit of five documents per request for fax delivery 
but no limit on the number of documents you can order for e-mail 
delivery.
xx



Safety Information For information on instrument, and chemical safety related to the operation of 
the 310 Genetic Analyzer, refer to the Site Preparation and Safety Guide 
(P/N 903558).
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How the ABI PRISM 310 
Genetic Analyzer Works 1
Introduction

In This Chapter Topics in this chapter include the following:

ABI PRISM 310 Genetic Analyzer

Introduction The ABI PRISM® 310 Genetic Analyzer is a system composed of instrument hardware, 
a Macintosh® computer, several types of software, and consumables.

This overview will help you identify parts of the ABI PRISM® 310 Genetic Analyzer and 
understand how it works.

Topics See page
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What the 310 Genetic Analyzer Does 1-2

Instrument Hardware: Front 1-5

Instrument Hardware: Back 1-6

Instrument Hardware: Behind the Doors 1-8
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GeneScan Consumables 1-25
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What the 310 Genetic Analyzer Does

DNA Sequencing About DNA Sequencing

DNA sequencing experiments determine the order of the bases in a DNA sample.

Fluorescently labeled dyes are attached to ACGT extension products in DNA 
sequencing reactions. Dye labels are incorporated using either 5´-dye labeled primers 
or 3´-dye labeled dideoxynucleotide terminators. Polymerases such as AmpliTaq® FS 
are used for primer extension.

The sequencing reaction sample tubes are placed in a tray in the instrument’s 
autosampler. The autosampler successively brings each sample into contact with the 
cathode electrode and one end of a glass capillary filled with polymer. An anode 
electrode at the other end of the capillary is immersed in buffer.

A portion of the sample enters the capillary as current flows from the cathode to the 
anode. This is called electrokinetic injection. The end of the capillary near the cathode 
is then placed in buffer. Current is applied again to continue electrophoresis.

When the nucleotides reach a detector window in the capillary coating, a laser excites 
the fluorescent dye labels. Emitted fluorescence from the dyes is collected by a CCD 
camera. The software interprets the result, calling the bases from the fluorescence 
intensity at each data point.

Required Software Files 

A number of software files are required by the instrument to perform this process:

Software File Purpose

Sample Sheet The Sample Sheet associates sample information (name and type of 
analysis) with a sample tube position.

Injection List The Injection List specifies the order for running samples, how many 
injections are made from each sample, and the module and running 
conditions for each injection.

Mobility Files The mobility files, also called Dye Set/Primer Files, adjust the data for the 
mobility of the sequencing primer in the polymer.

Modules The 310 Genetic Analyzer executes the steps in a run module to process a 
sample. Run time, temperature and voltage, prerun time, injection time 
and voltage are some of the run parameters controlled by the run module. 

Matrix Files Matrix files contain information that corrects for “spectral overlap”. 
Fluorescent dye labels are sold in sets of four. The emission spectra of the 
dyes overlap slightly. Although an effort is made to select dyes for each set 
that overlap minimally, spectral overlap still occurs to some extent.

Preference 
Files

Preferences record the default for a number of different selections in the 
software.
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Data Collection Software

The ABI PRISM® 310 Data Collection software collects raw data and allows real-time 
run monitoring in four software windows that show:

� Sample raw data

� Run status

� Electrophoresis record

� Instrument log file

ABI PRISM® DNA Sequencing Analysis Software analyzes the raw data and calls the 
bases.

GeneScan Software About the GeneScan® Analysis Software

GeneScan® Analysis Software analyzes raw data to quantify the DNA fragments and 
determine the size of the fragments by comparing them to fragments contained in a 
size standard.

Each sample is labeled with one fluorescent dye. A dye-labeled internal size standard 
is also placed in the tube. Three samples and a size standard can be electrophoresed 
simultaneously, as dyes come in sets of four colors.

The sample tubes are placed in a tray in the instrument’s autosampler. The 
autosampler successively brings each sample into contact with the cathode electrode 
and one end of a glass capillary filled with polymer. An anode electrode at the other 
end of the capillary is immersed in buffer.

A portion of the sample enters the capillary as current flows from the cathode to the 
anode. This is called electrokinetic injection. The end of the capillary near the cathode 
is then placed in buffer. Current is applied again to continue electrophoresis.

When the DNA fragments reach a detector window in the capillary coating, a laser 
excites the fluorescent dye labels. Emitted fluorescence from the dyes is collected by 
a CCD camera. The software interprets the result, calculating the size or quantity of 
the fragments from the fluorescence intensity at each data point.

Software Files Required

A number of software files are required by the instrument to perform these functions:

Software files: 

Software File Purpose

Sample Sheet The Sample Sheet associates sample information (name and type of 
analysis) with a sample tube position.

Injection List The Injection List specifies the order for running samples, how many 
injections are made from each sample, and the module and running 
conditions for each injection.

Modules The ABI PRISM® 310 Genetic Analyzer executes the steps in a run module 
to process a sample. Run time, temperature and voltage, prerun time, 
injection time and voltage are some of the run parameters controlled by 
the run module. 

Matrix Files Matrix files contain information that corrects for “spectral overlap”. 
Fluorescent dye labels are sold in sets of four. The emission spectra of the 
dyes overlap slightly. Although an effort is made to select dyes for each set 
that overlap minimally, spectral overlap still occurs to some extent.
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Data Collection Software

The Data Collection software collects raw data and allows real-time run monitoring in 
four software windows that show:

� Raw data

� Run status

� Electrophoresis record

� Instrument log file

Size 
Standards 
Files

The Size Standard file holds the results of a run performed with fragments 
of known length. 

The file can be used to analyze other samples run with the same size 
standard under the same conditions to determine the size of fragments of 
unknown length.

Analysis 
Parameters

The Analysis Parameters file holds the default start and stop point for data 
analysis, the default peak height and width threshold, and the default 
size-calling method.

Preference 
Files

Preferences record the default for a number of different selections in the 
software.

Software files: (continued)

Software File Purpose
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Instrument Hardware: Front

Front of Instrument

Led Status
Indicators

The LED Status Indicators are red, amber, and green lights. The pattern of lights 
indicates the instrument’s state.

Doors The doors protect you from exposure to the instrument's laser and electrophoresis 
power supply.

The doors must be closed to begin a run. The run interrupts if they are opened.

LED Status Indicators

Right Door

Left Door

Instrument Status LED Pattern

Ready For Use Steady green

Running Blinking green

End of Run Steady green with blinking amber

Paused, Door Open, or Awaiting Completion 
of Self-test

Amber blinking

Failure (check the error log in the 310 
Collection software for details)

Red
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Instrument Hardware: Back

Back of Instrument For a description of the call outs, see “Service LEDs” below.

On/Off Switch This switch turns power to the instrument on and off.

Service LEDs The following table lists the Service LEDs in the above figure. The LEDs are red lights. 
The pattern of lights indicates the instrument’s state.

On/Off Switch

Reset Button

Power Cord Receptacle

Serial Connections

1

2

Call 
Out LED Purpose

1 Init Indicates board is functioning properly.

Spare Not used.

Tray Indicates 48- or 96-well tray.

� On = 48-well tray

� Off = 96-well tray

X, Y, and Z 
limit

Lit when autosampler is at the furthest extent of its travel. Thus, when 
the electrode is at the front left of the autosampler, all lights should be 
on.

2 Firmware 
status 

Lights 2 through 9 indicate the status of the firmware. 

� Flashing lights indicate the firmware is loaded.

� All lights off mean the board has a problem.

� Four lights on and four off means you need to reload the 
firmware. 

XLX  When flashing, indicates the logic board is functioning properly.
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Communications
Reset Button

This button resets instrument–computer communications. Insert a pen or a similar thin 
object to push the recessed button and activate the reset.

For more information, see “How to Reset The Genetic Analyzer” on page 433.

Serial Connections

Power Cord
Receptacle

A power cord delivers power to the instrument from a wall receptacle and is rated for 
110 or 230 VAC.

For information about the power, refer to the ABI PRISM® 310 Genetic Analyzer Site 
Preparation and Safety Guide.

Port Purpose

Control/Data Connects the instrument to the Macintosh modem port.

Diagnostics Connects the instrument to a diagnostics device or the Macintosh 
printer port.

Aux/Serial Auxiliary serial connection.
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Instrument Hardware: Behind the Doors

Overview Hardware located inside the ABI PRISM 310 is responsible for:

� Automated sample handling

� Electrophoresis

� Fluorescence detection

Some of this hardware is located directly behind the doors. Other parts, such as 
power supplies, electronics, detection optics and the laser are only accessible by a 
service technician.

Instrument with
Door Open

The following is a diagram of the instrument with the doors open.

continued on next page

Autosampler 
Region

Detection 
Region

Pump Block 
Region

Gel Block Region
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Autosampler Region
Diagram

The following is a diagram of the autosampler region.

Autosampler Region
Diagram Described

The following table lists the parts to the above diagram. The autosampler moves 
buffers and samples to the capillary.

continued on next page

Autosampler

Cathode Electrode

48- or 96-well Tray

Electrode Thumbscrew

Part Purpose

Autosampler Holds the sample tray and consumable tubes: 

� Two 4-mL buffer vials

� One 1.5-mL Eppendorf tube

� Up to three 0.5-mL tubes

The autosampler moves the tray and tubes so the capillary can 
be inserted into them.

Cathode Electrode Provides a negative pole for electrical current for electrophoresis.

48-well Tray Holds a maximum of 48 0.5-mL tubes in a 6 x 8 format.

96-well Tray Holds a maximum of 96 0.2-mL tubes in an 8 x 12 format.

Electrode Thumbscrew Holds the electrode. It also has a hole through which you thread 
the capillary.
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Gel Block Region
Diagram

The following is a diagram of the Gel Block region.

Gel Block Region
Described

The following table lists the parts to the above diagram. The pump block controls the 
flow of polymer and samples through the capillary.

Syringe Drive

Syringe Guide

Waste Vial

Waste Valve

Capillary Ferrule

Luer Valve

Anode Buffer Valve

Anode Electrode

Anode Buffer Reservoir

Drip Tray

Gel Button

Tray Button

Anode Buffer Valve Actuator

Syringe Drive Toggle

Glass Syringe

Gel Block Region described: 

Part Purpose

Gel Pump Button Launches the Gel Pump Fill module to pump polymer from 
the plastic syringe into the 250-µL glass syringe through the 
pump block (DNA Sequencing Polymer).

Tray Button Moves the autosampler in and out so you can put a sample 
tray on the autosampler or a sample into the sample tray.

Syringe Drive Provides positive pressure to the syringe.

Syringe Drive Toggle Allows you to switch the syringe drive to either the glass or 
plastic syringe.

Syringe Guide Holds the plastic and glass syringes in position.

Luer Valve (plastic syringe) Attaches the plastic syringe to the pump block.

Anode Electrode Provides a positive electrical current for electrophoresis.

Anode Buffer Valve Closes access to the buffer when filling the capillary. Opens 
access to the buffer for electrophoresis. 

Anode Buffer Reservoir Contains the buffer required for electrophoresis.

Glass Syringe Stores the polymer between runs and generates the 
necessary force to fill the capillary with polymer.
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Detection Region
Diagram

The following is a diagram of the Detection Region.

continued on next page

Waste Valve Valve for waste flow when priming and cleaning the pump 
block channels.

Waste Vial (optional) Collects waste put through the waste valve.

Capillary Ferrule Attaches the capillary to the pump block.

Anode Buffer Valve Actuator Opens and closes the buffer valve.

Drip Tray Catches any liquids that drip from the pump block.

Gel Block Region described: (continued)

Part Purpose

Capillary

Heat Plate

Thermal Tape

Detector Window

Detector Door

Detector Plate
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Detection Region
Described

The following table lists the parts to the above diagram. The detection region collects 
data from the samples as they migrate past the capillary window.

Detection Region Described: 

Part Purpose

Charge-Coupled Device 
(CCD)a

a. The CCD is accessible to service technicians only. It is not shown in the drawing above.

The laser excites the dyes in the sample and their 
fluorescence is detected by the CCD camera. 

Laser Detector Window and 
Door

The capillary window is placed over the laser detector 
window. 

The door holds the capillary in place and protects you 
from exposure to the laser.

Heat Plate The heat plate heats the capillary during electrophoresis

Capillary A capillary is a glass tube filled with polymer that carries 
the sample past the laser to the pump block.

Heater Doorb

b. The Heater Door covers the Heat Plate. It is not shown in the drawing above.

The heater door insulates the capillary during 
electrophoresis and protects you from burns.

Thermal Tape Thermal tape holds the capillary in place against the heat 
plate.
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About the Macintosh Computer

Overview The Macintosh® computer collects and analyzes data from the ABI PRISM 310 Genetic 
Analyzer.

The ABI PRISM® 310 Data Collection Software collects what is called the “raw data”: 
fluorescence which is detected on the CCD array as the labeled fragments, separated 
in the capillary by electrophoresis and excited by the laser, pass the detection window.

The ABI PRISM® DNA Sequencing Analysis Software and the GeneScan® Analysis 
Software programs are used to analyze the raw data, converting it to DNA sequence 
or DNA fragment size/quantitation data.

Other programs are available from Applied Biosystems to align sequences, identify 
previously unsequenced regions, archive data, identify patterns of heredity, and other 
data manipulations. See your sales representative and visit Applied Biosystems on 
the Applied Biosystems web site at www.appliedbiosystems.com/techsupport

System
Requirements

The ABI PRISM® 310 Genetic Analyzer is shipped with a Power Macintosh® computer. 
An optional color printer is also available. 

Note Contact technical support for the latest specifications for the Macintosh computer and 
the operating system (see “Technical Support” on page xvii).

If you need to replace the computer or printer, the following table lists the minimum 
specifications:

RAM Requirements To check your available RAM, choose About this Macintosh... from the Apple () 
menu. RAM requirements for software applications are:

Item Specification

Macintosh® Model Power Macintosh® 6100/66 or better.

Monitor Color monitor 14-inch display or larger.

Disk Drive Hard disk with a minimum of 250 MB storage, 
preferably IG.

Memory Minimum 16 MB random access memory, 
preferably 64 MB.

Printer Color PostScript printer.

Operating system software Macintosh system software v 7.5.3 or higher.

Software RAM Required

ABI PRISM® 310 Data Collection 
Software

4.7 MB

ABI PRISM® DNA Sequencing Analysis 
Software and Basecallers

6 MB

GeneScan® Analysis Software 6 MB
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Principles of Operation

Sample Labeling The samples are labeled using a dye set—four dyes that fluoresce at different 
wavelengths. The four dyes might label different bases in the DNA sequence or 
different fragments in an experiment that will be analyzed with GeneScan® Analysis 
Software.

Automated Sample
Handling

Fluorescently labeled samples are placed in the autosampler.

The cathode electrode and one end of a polymer-filled capillary are located near the 
autosampler. The autosampler successively brings samples in the sample tray into 
contact with them. A short period of electrophoresis injects the sample into the 
capillary. The autosampler then moves the cathode buffer reservoir to the capillary 
and electrode to continue electrophoresis.

The cathode buffer reservoir, a waste vial, and a water reservoir (used to wash the 
cathode electrode and capillary tip between samples) are vials located on the 
autosampler.

Electrokinetic
Sample Injection

The short period of electrophoresis conducted while the capillary and cathode are 
immersed in the sample is called electrokinetic injection.

A portion of the sample forms a tight band in the capillary during this injection.

Electrophoresis Samples are electrophoretically separated as they travel through polymer in the 
capillary. 

! WARNING ! HIGH VOLTAGE HAZARD. Exposure to high voltage can cause serious 
injury and death. Do not touch the electrodes or capillary when the electrophoresis 
power supply is on. 

An interlock switch shuts off the electrophoresis power supply if the front doors of the 
instrument are open.

Since the capillary is fastened along most of its length to a heat plate, temperature is 
controlled during electrophoresis.

Sample Fluorescence As the DNA fragments pass through the window of the capillary, an argon-ion laser 
excites the attached dye labels and they fluoresce.

! WARNING ! LASER HAZARD. Exposure to direct or reflected laser light at 10 mW 
for 0.1 seconds can burn the retina and leave a permanent blind spot. Never look directly 
into the laser beam or allow a reflection of the beam to enter your eyes.

The laser is located behind the detector door and the front door of the instrument. An 
interlock switch protects you from the laser when the front door of the instrument is 
open.

continued on next page
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Detection A series of lenses direct and focus the fluorescent light into a spectrograph. 

A diffraction grating in the spectrograph disperses the light by wavelength and focuses 
the resulting light spectrum onto a CCD array.

Virtual Filters,
Matrix Files and Dye

Sets

The ABI PRISM 310 Data Collection software defines certain areas on the CCD array 
for the collection of the fluorescent emissions from the dye labels in the dye set. These 
areas are called virtual filters. There can be any number of virtual filters, since the filter 
is simply a software-designated site on the CCD array. Virtual filters are grouped into 
sets and referred to by a letter, such as Virtual Filter Set A, B, C, etc.

Fluorescent dye labels come in sets of four. There are several different dye sets, for 
use in different types of experiments. The fluorescence from each dye set must be 
collected using the correct virtual filter set.

You select the virtual filter set that corresponds to the experiment’s dye set by 
choosing a module file when setting up the run. The virtual filter set’s letter is in the 
module file name. For example, data is collected from BigDye™ Terminator DNA 
sequencing samples using Virtual Filter E. To run BigDye™ Terminator samples, 
choose a module file such as Seq POP6 (1.0-mL) E. 

Some portion of a dye’s emission profile may fall on a virtual filter other than the one 
intended to collect its emission maximum. The dyes in each dye set are selected to 
have widely spaced emission maximums to minimize overlap of the emission profiles 
on the CCD array. However, overlap still occurs to some extent.

The “crosstalk” between colors on the CCD array, known as spectral overlap, is 
corrected by a matrix file in the software. The matrix file is generated from a separate 
matrix run, and contains information about how much of the collected light falling on a 
filter is due to the intended light emission and how much is contaminating light. 

When setting up the run, you select a matrix file to interpret the data and correct for 
spectral overlap.

One matrix file can be used for all runs sharing the same conditions. If run conditions 
are changed, a new matrix file must be generated using the new run conditions. 
Changes in run conditions affect dye fluorescence and the amount of spectral overlap.

Compatibility of
Dyes and Virtual

Filters

5-FAM and 6-FAM cannot be used in the same sample because there is no virtual 
filter that distinguishes one from the other.

HEX and JOE cannot be used in the same sample because there is no virtual filter 
that distinguishes one from the other.

TAMRA and NED cannot be used in the same sample because there is no virtual filter 
that distinguishes one from the other.

continued on next page
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Color Display of
Data

The Data Collection software creates a real-time display of the light intensities 
collected on the virtual filters. The wavelengths of the dyes in the set are color-coded 
from shortest to longest: blue, green, yellow, and red.The colors on the real-time 
display do not represent actual wavelengths. They represent the color-coded relative 
wavelengths of the four dyes in each dye set.

Each of the sequencing chemistries is associated with one of the dye sets. Each 
chemistry associates the four bases with dyes of different relative wavelengths. 
Therefore, the color associated with each base in the Data Collection software 
changes with the chemistry used to label it.

In DNA sequencing applications, Virtual Filter A uses the four colors to represent 
wavelengths within the dye set used with primer sequencing and the dye set used with 
terminator sequencing. Virtual Filter B uses the four colors to represent wavelengths 
within the dye set used for primer sequencing with T7 primers, an application that is no 
longer common. Virtual Filter E represents wavelengths within the dye set used for 
sequencing with dichlororhodamine-labeled terminators or BigDye™-labeled primers.

Virtual Filters C, D, and F are used only with the GeneScan® Analysis Software.

Color Guide for
Sequencing Raw

Data

The following are color guides for sequencing raw data displays.

The ABI PRISM® Sequencing Data Analysis program converts the information 
collected by the Data Collection program to a color code in which blue represents C, 
green represents A, yellow represents G, and red represents T. When G is printed, 
black replaces yellow, because black is easier to read.

Virtual Filter A

Color

Taq Primer
Taq

Terminator

Base Dye Base Dye

Blue C 5-FAM G R110

Green A JOE A R6G

Yellow G TAMRA T TAMRA

Red T ROX C ROX

Virtual Filter E

Color

dRhodamine 
Terminator BigDye™ Terminator BigDye™ Primer

Base Dye Base Dye Base Dye

Blue G dR110 G dR110 C dR110

Green A dR6G A dR6G A dR6G

Yellow C dTAMRA T dTAMRA G dTAMRA

Red T dROX C dROX T dROX
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Color Guide for
GeneScan

Applications

In GeneScan® applications, the dyes corresponding to the colors for virtual filters are:

Color guide for GeneScan® Analysis Software raw data displays.

Corresponding Dye

Color
Virtual Filter A

(Fluorescent dNTPs)
Virtual Filter 

C
Virtual Filter 

D
Virtual Filter 

F

Blue R110 6-FAM 6-FAM 5-FAM

Green R6G TET HEX JOE

Yellow TAMRA HEX NED NED

Red ROX TAMRA ROX ROX
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Software for Data Collection and Analysis

Overview The ABI PRISM 310 Genetic Analyzer comes with software programs that perform:

� Raw data collection

� Data analysis

These programs run on theMacintosh® computer.

Software Used with
the Genetic Analyzer

Data Collection
Software

ABI PRISM® 310 Data Collection Software collects the raw data from either DNA 
sequencing or GeneScan® Analysis Software runs. It contains information about the 
dyes’ emission (fluorescence) spectra and processes the raw data as base sequence, 
fragment size, or relative concentration for use by one of the analysis software 
applications.

The program is discussed thoroughly in Chapter 5, “Using Data Collection Software.”

Data Analysis
Software

Two software programs are available to analyze the raw data: 

� ABI PRISM® DNA Sequencing Analysis Software

� GeneScan® Analysis Software

DNA Sequencing Analysis

The DNA Sequencing Analysis software analyzes the raw sequencing data collected 
by the Data Collection software. This program comes bundled with the Data Utility 
program. The Data Utility program enables you to make and copy matrices to correct 
for the spectral overlap of the fluorescent dye labels.

GeneScan Analysis

The GeneScan® Analysis Software enables you to use ABI PRISM® 310 Genetic 
Analyzer automated fluorescence detection to size and quantify DNA fragments. The 
program automates the sizing of DNA fragments. It also provides flexibility to 
interactively confirm and fine-tune the data analysis, and allows you to display the 
results of an experiment in several different ways.

Each analysis program is described in detail in separate manuals: the ABI PRISM DNA 
Sequencing Analysis Software User’s Manual and the ABI PRISM GeneScan Analysis 
Software User’s Manual.

Software Application Purpose

ABI PRISM® 310 Data Collection 
Software

Controls, monitors, and collects data from the 310.

ABI PRISM® DNA Sequencing 
Analysis Software

Analyzes raw sequencing data and calls bases.

GeneScan® Analysis Software Sizes and quantifies DNA fragments.
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Other Software Provided with Your Computer

Overview If other software programs have been provided on the hard disk of your computer, 
send in the registration cards to receive future updates from their manufacturers. 

Do not install other programs on the Macintosh® computer yourself unless directed to 
do so by a Applied Biosystems representative. Other programs may have features that 
interfere with correct operation of the ABI PRISM® 310 Genetic Analyzer software.

The Macintosh® operating system is described in manuals provided by Apple 
Computer, Inc. and shipped with your computer.

Consumables

Overview There are specific consumables for use by the ABI PRISM® DNA Sequencing Analysis 
Software and the GeneScan® Analysis Software, as well as shared consumables. 

Part numbers for many consumables are noted in this chapter. Refer to these part 
numbers when ordering from Applied Biosystems.

More information about Applied Biosystems kits and consumables is available from 
your sales representative or on the Applied Biosystems pages of the Applied 
Biosystems web site, at www.appliedbiosystems.com/techsupport
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Shared Consumables

About Capillaries A capillary is a glass tube with a small internal diameter. Filled with polymer, it carries 
the sample past the laser and detector to the pump block. The capillary has an 
opaque polyimide coating except in the window area. The laser and detector read 
samples during electrophoresis through the window in the coating. Capillaries are 
fragile, especially at the detection window.

Removing
Capillaries from the

Packaging

The capillaries are shipped in a curved plastic tube. Remove the capillaries by 
grasping one capillary between your thumb and forefinger, and then pulling and 
turning the capillary simultaneously.

Capillary Life Capillaries can be used for up to a minimum of 100 runs.

Capillary Types,
Labels and Part

Numbers

The following table lists the capillary types, labels, and part numbers.

About Septa Strips
for the 96-Well Tray

Septa strips seal 0.2-mL tubes in the 96-well tray. They require septa clips.

CAUTION The septa strip will melt at high temperatures. Do not autoclave or reuse the 
septa strips.

CAUTION Do not close the lid when denaturing samples using the GeneAmp® 9600 or 
9700. The septa strip may adhere to the lid.

The retainer clip interferes with the insertion guides in the GeneAmp® 9600 and 9700 
Thermal Cycler. Therefore, you cannot place the retainer clip on the sample tray while 
you are using the 9600 or the 9700 to heat denature your samples.

You can process fewer by leaving the unused wells in the sample tray empty. The 
reaction tube eight-strip and septa strip can be cut to accommodate the number of 
samples you want to process.

continued on next page

Capillary 
Type Label Polymer

Length 
(cm)

Length to 
Detector 

(cm)
Coated/ 
Uncoated

Internal 
Diameter 

(µ)
Part 
Number

47 cm x 50-µm 
i.d.

green POP-6 47 36 internally 
uncoated

50 402839

61 cm x 50-µm 
i.d.

pink POP-6 61 50 internally 
uncoated

50 402840

Sequencing silver DNA Sequencing 
Polymer

47 36 internally 
coated

75 401821

47 cm x 50-µm 
i.d.

green POP-4

GeneScan 
Polymer

47 36 internally 
uncoated

50 402839
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Using Septa Strips Using the Right Trays with the Thermocycler

Note At the time of printing of this manual, the 96 sample trays were in the process of being 
changed, so the use of two types of trays is described below. The old beige tray and retainer is 
P/N 4303864, and the new red one is P/N 403081.

Preparing the Sample Tray

For this 
thermocycler... Use this Tray/Retainer...

2400 and 9600 P/N 4303864

9700 P/N 43081

Note This tray/retainer is not compatible with the 9700 unless 
used with an adaptor (P/N 4305051).

Step Action

1 Place the MicroAmp® Base on a flat surface (do not put the base in the instrument).

2 Place the MicroAmp® Tray onto the base so that the well numbered A1 is located at 
the upper left corner of the tray. The cutout in the outside rim of the tray will then be 
located on the left side of the tray. This orients the tray for proper fit into the sample 
block.

Genetic Analyzer Retainer Clip 
(P/N 402866)

Genetic Analyzer Septa Strip 
(P/N 402059)

MicroAmp® Retainer
(new number P/N 403081 old 
number P/N 4303864) sold 
with trays

MicroAmp® Reaction Tubes 
(P/N N801-0580)

MicroAmp® Tray (see retainer)

MicroAmp® Base (P/N 
N801-0531)
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Inserting the Tray into the ABI PRISM® 310 Genetic Analyzer

continued on next page

3 Place the MicroAmp® Reaction Tubes in the tray. 

Note The wells in the tray are labeled left to right from 1 through 12 and A 
through H from back to front.

4 Place the MicroAmp® Retainer over the sample tray and tubes. 

The retainer and tray are keyed so that the retainer can fit only one way. 

5 Pipette the solution into the sample tubes.

6 Sit the septa strip on top of the sample tubes, with each of the 24 septum placed 
into the opening of a sample tube. 

Gently and evenly press the septa strip down until the strip is seated securely 
against the tubes.

7 Place the retainer clip over the 24 openings on the septa strip and press down until 
the clip clicks into place over the rim on each side of the sample tray.

Step Action

1 Remove the tray assembly from the base for insertion into the ABI PRISM® 310 
Genetic Analyzer.

2 With the tray cutout pointed toward the instrument, take the following actions:

� Place the tray assembly on the autosampler platform.

� Press it flat against the rectangular, raised guide until the tray is flush with the 
platform.

Note The newer red tray requires an adaptor (P/N 4305051) for use on the 
ABI PRISM® 310.

A sensor in the platform recognizes which tray is present (the 96-well tray or the 
48-well tray) so that the tube positions are correctly identified during the run. 

Step Action

Clip over Tray Rim

Tray Cutout
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Other Shared
Consumables

These are the consumables for both GeneScan® Analysis Software and ABI PRISM® 
DNA Sequencing Analysis Software experiments:

Consumable Purpose Part Number

48-well tray Holds a maximum of 48 0.5-mL tubes in a 6 x 8 
format.

005572

4-mL glass buffer 
vial with cap 
adapter

Holds buffer and water on the autosampler. 401955

0.2-mL tubes Holds samples on the 96-well tray. N801-0580

0.5-mL tubes Holds samples on the 48-well tray, as well as for 
consumables on the autosampler.

401957

1.5-mL Eppendorf Holds water on the autosampler and acts as the 
waste vial.

—

Septa for 0.5-mL 
tubes

Prevents evaporation of samples and 
consumables. The capillary and electrode can 
pass through a slit in the septum.

401956

Septa strips for 
0.2-mL tubes

Prevents evaporation of samples and 
consumables. The capillary and electrode can 
pass through a slit in the septum.

402059

Septa clip for 
96-well tray

Secures septa strips on 0.2-mL tubes. 402866

Cathode electrode Provides the negative pole for electrophoresis. 005914

Capillary cutters Shortens the length of the capillary. 401958

Thermal tape Hold the capillary in position on the heat plate. 310021

1.0-mL glass 
syringe

Delivers the polymer to the capillary. 604418

Syringe o-rings O-rings for the glass syringe and ferrule. Two 
o-rings are required. See “How to Inspect the 
Syringe” on page 418.

221102

Syringe ferrule Ferrule inside the glass syringe. 005401

Capillary fitting Holds the capillary in the pump block. 005404

Waste vial Collects waste from the waste valve on the pump 
block.

603796

Waste valve Attaches the waste vial to the pump block, and 
controls the flow from the waste vial.

604076

Plastic syringe luer 
valve

Attaches the plastic syringe to the pump block, 
and controls the flow from the plastic syringe.

604075

Anode buffer jar Holds anode buffer. 005402

MicroAmp Tray and 
Retainer

Holds 0.2-mL tubes for the 96-well tray. Old: 4303864

New: 403081

MicroAmp Base Holds 0.2-mL tubes for the 96-well tray. N801-0531

96 well tray adaptor Allows thermocycler trays to be used on the 
ABI PRISM® 310.

4305051
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Sequencing Consumables

Sequencing Polymer Two polymers are available for DNA sequencing:

� Performance Optimized Polymer, 6% (POP-6™)

� DNA Sequencing Polymer for specific applications

Sequencing
Application Kits

Applied Biosystems sells Ready Reaction and Core Kits for the various sequencing 
chemistries. Please contact your sales representative or see the Applied Biosystems 
pages on the World Wide Web at www.appliedbiosystems.com/techsupport

Sequencing
Consumables Part

Numbers

Use these part numbers to order sequencing consumables:

Kit Purpose

Ready Reaction Ready Reaction kits contain all necessary reagents in stable premixes.

Core Kit Core Kits separately package each reagent.

Consumable Purpose
Part 
Number

Performance Optimized Polymer, 6 
(POP-6), with 2 vials of TSR

Polymer for electrophoresing DNA 
fragments in the capillary.

402844

Performance Optimized Polymer, 6 
(POP-6), with 8 vials of TSR

Polymer for electrophoresing DNA 
fragments in the capillary.

403076

Performance Optimized Polymer, 
6% without TSR (POP-6)

Polymer for electrophoresing DNA 
fragments in the capillary.

402837

10X Genetic Analyzer Buffer with 
EDTA (for use with POP-6)

Running buffer for electrophoresis. 402824

DNA Sequencing Polymer with TSRa 
(DSP)

Polymer for electrophoresing DNA 
fragments in the capillary.

402091

10X Genetic Analyzer Buffer (for use 
with DSP)

Running buffer for electrophoresis. 401884
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GeneScan Consumables

GeneScan Polymer Two polymers are available for GeneScan®:

� Performance Optimized Polymer, 4% (POP-4).

� GeneScan Polymer for SSCP and native runs.

GeneScan
Application Kits

A number of kits are available for specialized applications of GeneScan® Analysis 
Software with the ABI PRISM® 310. Please consult your sales representative or see the 
Applied Biosystems pages on the World Wide Web at 
www.appliedbiosystems.com/techsupport

GeneScan Size
Standard Kits

Applied Biosystems offers several size standard kits for a variety of applications.

GeneScan
Consumables Part

Numbers

Use these part numbers to order GeneScan consumables:

Kit For Fragments Between…
Part 
Number

GeneScan® 350 TAMRA 35 bp to 350 bp 401736

GeneScan® 350 ROX 35 bp to 350 bp 401735

GeneScan® 400 HD ROX 50 bp to 400 bp 402985

GeneScan® 500 TAMRA 35 bp to 500 bp 401733

GeneScan® 500 ROX 35 bp to 500 bp 401734

GeneScan® 1000 ROX 100 bp to 900 bp 401098

GeneScan® 2500 ROX 100 bp to 2500 bp 401100

GeneScan® 2500 TAMRA 100 bp to 2500 bp 401545

Consumable Purpose
Part 
Number

Performance Optimized 
Polymer, 4% (POP-4)

Polymer for electrophoresing DNA under 
denaturing conditions.

402838

10X Genetic Analyzer Buffer 
with EDTA (for use with 
POP-4)

Running buffer for electrophoresis. 402824

GeneScan Polymer Polymer for electrophoresing DNA under 
non-denaturing conditions.

401885
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About Running Sequencing Experiments

About this Chapter This chapter summarizes the steps for a DNA sequencing experiment, and, as an 
example, explains in detail the steps for cycle sequencing a single-stranded (M13) 
template using BigDye™ terminators and Performance Optimized Polymer, 6%.

This chapter explains the steps for making a matrix file from:

� Four separate matrix standards (one for each color)

� A single four-color sample

To quickly start a sequencing run, see the Quick Reference Card at the front of the 
manual.

For more detail about specific procedures, see Chapter 4, “Procedures for Operation.”

About Cycle
Sequencing

Although the reaction mixes and temperature cycling are similar, it is important to 
understand the difference between PCR and cycle sequencing.

PCR uses two primers and a double-stranded template to exponentially amplify a 
sequence of interest. Template is denatured, primers are allowed to anneal to the 
template, and the primers are extended. The purpose is to amplify the unknown 
sequence for further experimentation, such as sequencing.

Cycle sequencing can use one or two primers and a single-stranded or 
double-stranded template. The purpose is to determine the base sequence of a DNA 
template. 

In cycle sequencing, the temperature cycles from a denaturation temperature of about 
95 °C to an annealing temperature of about 56 °C. The primers sit down on the 
denatured template. The temperature is raised to 72 °C, and Taq polymerase extends 
the primer, incorporating ddNTPs that stop the extension reactions to randomly 
generate fragments that differ in length by one base. This temperature cycling can 
continue without the addition of enzyme because AmpliTaq® DNA Polymerase, FS 
tolerates high temperatures. 

In primer sequencing, the primers are fluorescently labeled; in terminator sequencing, 
the ddNTPs are fluorescently labeled. 

continued on next page
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About DNA
Sequencing

There are currently five DNA sequencing chemistries:

Dye primer labeling matches a specific dye-labeled primer to each of the four bases in 
four different dideoxynucleotide extension reactions. The reaction products are pooled 
and electrophoresed.

Dye terminator labeling covalently attaches a specific fluorescent dye to each dideoxy 
nucleotide base. Extension product termination and labeling occur simultaneously for 
all bases in one tube.

All methods use AmpliTaq DNA Polymerase, FS. The required polymer and reagents 
used vary. Consult the protocol that comes with the Ready Reaction kit.

Description of
Chemistry Table

Levels

There are four levels of recommendations in the chemistry tables.

continued on next page

Chemistry Protocol Part Number

Dye-labeled terminator 402078

Dye-labeled primer 402113

Dichlororhodamine 
(dRhodamine) dye-labeled 
terminator

403041

BigDye™-labeled primer 403057

BigDye™-labeled terminators 4303237

Level Description

Recommended This chemistry is the best choice for most customers most of the 
time.

Satisfactory This chemistry will work. 

Customers will get good results but there is a better choice of 
chemistry of the given application or platform.

Not Recommended This chemistry might work. 

Some customers will get good results but others will not. In most 
cases the results will be suboptimal in terms of readlength and or 
accuracy

Not Possible This chemistry will not work and is not sold/specified for the given 
application or platform.
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310 Chemistry
Options Table

The following table describe the chemistry options for DNA sequencing applications.

continued on next page

310 Chemistry Options

DNA Sequencing Application

BigDye™

Terminators
dRhodamine 
Terminators

BigDye™ 
Primers

Standard 
Primers

Standard 
Terminators

de novo Sequencing High 
Throughput

Recommended Satisfactory Recommended Satisfactory Recommended

de novo Sequencing 
Mid-Low Throughput

Recommended Satisfactory Satisfactory Satisfactory Recommended

Comparative Sequencing 
(Germline Mutations 
50:50)

Recommended Satisfactory Recommended Recommended Not 
Recommended

Comparative Sequencing 
(Somatic Mutations 
30:70)

Recommended Not 
Recommended

Recommended Recommended Not 
Recommended

Comparative Sequencing 
(Somatic Mutations 
10:90)

Not 
Recommended

Not 
Recommended

Recommended Recommended Not 
Recommended

DNA Sequence Context

G-C rich > 65% Recommended Satisfactory Recommended Recommended Recommended

A-T rich > 65% Recommended Recommended Recommended Recommended Recommended

G-T rich (regions) Not 
Recommended

Satisfactory Recommended Recommended Recommended

Homopolymer A or T > 25 
bp

Not 
Recommended

Recommended Recommended Recommended Recommended

GA Motifs Recommended Satisfactory Recommended Recommended Recommended

Template

Plasmid (<15 bp) Recommended Recommended Recommended Recommended Recommended

M13 Recommended Recommended Recommended Recommended Recommended

BAC, Cosmid, Lambda, 
XL PCR

Recommended Satisfactory Satisfactory Not 
Recommended

Not 
Recommended

Bacterial genomic DNA Recommended Not 
Recommended

Not 
Recommended

Not 
Recommended

Not 
Recommended

PCR Amplicon Recommended Recommended Recommended Recommended Recommended

PCR Amplicon 
(Heterozyous 50:50)

Recommended Satisfactory Recommended Recommended Not 
Recommended

PCR Amplicon 
(Heterozyous 30:70)

Recommended Not 
Recommended

Recommended Recommended Not 
Recommended

PCR Amplicon 
(Heterozyous 10:90)

Not 
Recommended

Not 
Recommended

Recommended Recommended Not 
Recommended
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About Cycle
Sequencing Using

Terminators

This chapter uses BigDye™ terminator cycle sequencing chemistry as an example for 
DNA sequencing on the ABI PRISM® 310 Genetic Analyzer. This method for 
performing enzymatic extension reactions is quick, convenient and commonly used.

The benefits of this method include the following:

� Single-tube reactions.

� Less hands-on time required than with dye-labeled primer chemistry.

� Same protocol for both single- and double-stranded templates.

� Less starting template needed than with non-cycling protocols.

� Easier sequencing of large constructs compared to non-cycling protocols.

� More reproducible results.

Summary of
Procedures

To perform a sequencing experiment on your samples using the ABI PRISM® 310 
Genetic Analyzer, do the following:

� Prepare the ABI PRISM® 310 by:

– Preparing the reagents.

– Cleaning the pump block.

– Installing the capillary.

– Cleaning and installing the syringe.

– Cleaning the electrode.

– Recalibrating the autosampler if:

– The electrode is removed, replaced or cleaned

– The capillary is replaced

– Priming the pump block.

– Loading buffers.

– Preheating the instrument.

� Prepare matrix standards (if necessary).

� Prepare the samples.

� Start the run by:

– Selecting or creating a Sample Sheet.

– Filling out an Injection List.

continued on next page
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Materials Required The following table lists what materials are required to work through the example 
provided in this chapter.

! WARNING ! CHEMICAL HAZARD. Before handling the chemical reagents needed 
for BigDye™ terminator cycle sequencing, read the safety warnings on the reagent 
bottles and in the manufacturers’ Material Safety Data Sheets (MSDS). Always wear 
protective equipment (lab coat, safety glasses, and chemical-resistant gloves) when 
handling chemicals. Dispose of waste in accordance with all local, state, and federal 
health and environmental regulations and laws.

Materials required for this example. 

Item Source

ABI PRISM® BigDye™ Terminator Cycle 
Sequencing Ready Reaction Kit with 
AmpliTaq FS

Applied Biosystems:

� P/N 4303149 for 100 reactions

� P/N 4303150 for 1000 reactions

� P/N 4303151 for 5000 reactions

ABI PRISM® dRhodamine Matrix Standards Kit Applied Biosystems P/N 403047

Deionized formamide Major laboratory suppliers (MLS)

Deionized water MLS

25 mM EDTA (ethylenediaminetetraacetate)
with 50 mg/mL blue dextran, pH 8.0

Applied Biosystems P/N 402055

Ethanol (EtOH), non-denatured, 95% or 70% MLS

Magnesium chloride (MgCl2), 0.5 M or 2 mM MLS

Mineral oil, for the DNA Thermal Cycler (TC1) 
and the DNA Thermal Cycler 480

Applied Biosystems P/N 0186-2302

Shrimp alkaline phosphatase (SAP), 1 U/µL, 
and 10X SAP buffer (200 mM Tris-HCl, 
100 mM MgCl2, pH 8.0)

Amersham Life Science P/N E 70092 Z

Sodium acetate (NaOAc), 3 M, pH 4.6 Applied Biosystems P/N 400320

ABI PRISM Plasmid Miniprep Kit

� 100 purifications

� 500 purifications

Applied Biosystems:

� P/N 402790

� P/N 402791

Adhesive-backed aluminum foil tape 3M (Scotch Tape P/N 425-3)

Centricon-100 Micro-Concentrator columns Applied Biosystems P/N N930-2119

Microcentrifuge, variable speed, capable of 
reaching 14,000 × g

MLS

Spin column, Centri-Sep, 1-mL in North 
America

Princeton Separations P/N CS-901

Spin column, Centri-Sep, 1–mL outside North 
America

� 32 columns

� 100 columns

Applied Biosystems

� P/N 401763

� P/N 401762

Table top centrifuge, with 96-tube tray adaptor MLS

Vacuum centrifuge Savant Speedvac (P/N  DNA100) or 
equivalent

Vortexer MLS
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You will also need a 48-well or a 96-well sample tray and accessories.

Note If you are using a 9700 Thermocycler, and you do not have the 96 sample tray adaptor 
(P/N 4305051), then you will have to transfer the samples from the tray compatible with the 
9700 after denaturation to the ABI PRISM® 310 96 sample tray before placing on the 
autosampler.

continued on next page

Disposable, non-powdered, 
chemical-resistant gloves

MLS

A small-volume, calibrated pipette and tips 
(the Gilson Pipetman is recommended) 

Rainin Instruments P/N  P10

ABI PRISM® 310 10X Genetic Analyzer Buffer 
with EDTA

Applied Biosystems P/N 402824

One 1.0-mL glass syringe Applied Biosystems P/N 604418

Performance Optimized Polymer 6 with TSR Applied Biosystems P/N 402844

Two 4.0-mL Genetic Analyzer Buffer Vials Applied Biosystems P/N 401955

Two septa for the 4.0-mL buffer vials Applied Biosystems P/N 401956

For rapid sequencing:

ABI PRISM® 310 Genetic Analyzer Capillary, 
47-cm, 50-µm i.d., labeled with a green marka

Applied Biosystems P/N 402839

For long-read sequencing:

ABI PRISM® 310 Genetic Analyzer Capillary, 
61-cm, 50-µm i.d., labeled with a pink mark

Applied Biosystems P/N 402840

ABI PRISM® DNA Sequencing Analysis 
Software User’s Manual

Applied Biosystems P/N 904436

One of the following thermal cyclers from Applied Biosystems:

� GeneAmp® PCR System 9600

� GeneAmp® PCR System 9700

� GeneAmp® PCR System 2400

� DNA Thermal Cycler 480

Note If the GeneAmp® PCR System 2400 or DNA Thermal Cycler 480 will be used to 
denature your samples, you will need the appropriate materials (i.e., tubes, tray, etc.) for 
these thermal cyclers. You will also be required to transfer the samples to either the 96- 
or 48-well sample tray to load the samples on the ABI PRISM® 310.

a. Do not use sequencing capillaries labeled with a silver mark (P/N 401821) with POP-6™ polymer. 
Resolution will be unsatisfactory if these capillaries are used with POP-6 polymer.

Materials required for this example. (continued)

Item Source
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96-Well Sample Tray
Accessories

The following table lists the 96-well sample tray and accessories.

48-Well Sample Tray
and Accessories

The following table lists the 48-well sample tray and accessories.

Software Required � ABI PRISM® 310 Firmware, v 1.0.2 or higher

� ABI PRISM® 310 Data Collection Software, v 1.0.2 or higher

� ABI-CE1 Basecaller file

� DT POP-6 {BD Set-any primer} terminator mobility file

� POP-6 module file

– For rapid sequencing: ABI PRISM® 310 module SEQ POP6 RAPID (1.0-mL) E 

– For long read sequencing: ABI PRISM® 310 module SEQ POP6 (1.0-mL) E

� ABI PRISM® DNA Sequencing Analysis Software, v 2.1.1 or higher

Part Quantity
Old Part 
Number

New Part 
Number

310 Genetic Analyzer Tray/Retainer Set 1 4303864 403081

0.2-mL MicroAmp Reaction Tubes 1 box N801-0580 N801-0580

MicroAmp® Base 1 N801-0531 N801-0531

MicroAmp® Full Plate Cover 1 N801-0550 N801-0550

Genetic Analyzer Septa Strips 1 402059 402059

310 Genetic Analyzer Retainer Clips 1 402866 402866

310 Genetic Analyzer 96 Well Sample Tray 
Adaptor

1 NA/ 4305051

Part Quantity
Part 

Number

48-well Sample Tray 1 005572

0.5-mL Samples Tubes 1 box 401957

Septa for 0.5-mL Sample Tubes 1 box 401956

1.5-mL Eppendorf tube 1 —
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How to Switch Between DNA Sequencing and the GeneScan Analysis Software

Switching Between
Applications

If the ABI PRISM® 310 was set up for experiments to be analyzed with the GeneScan® 
Analysis Software, then before following the instructions in this chapter to prepare an 
experiment that will be analyzed with the ABI PRISM® DNA Sequencing Analysis 
Software, it will be necessary to do the following.

Take this action See page

Remove the 2.5-mL glass syringe (if present) or clean out the 1.0-mL syringe. 4-18

Remove the capillary and store it. 4-15

Clean the pump block. 4-8
Running Sequencing Experiments 2-9



How to Set Up the Reagents

Preparing Reagents ! WARNING ! CHEMICAL HAZARD. Urea is a potential mutagen. Dangers cited in 
toxicity studies show reproductive and tumorigenic effects. Urea can cause irritation to 
the skin, eyes, and respiratory tract. Avoid inhalation and contact with skin, eyes and 
clothing. Always work in a fume hood. Obtain a copy of the MSDS from the manufacturer. 
Wear appropriate protective eyewear, clothing, and gloves. 

CHEMICAL HAZARD. Some chemicals used with this instrument are potentially 
hazardous. Warnings are prominently displayed on the bottle labels of all hazardous 
chemicals. Material Safety Data Sheets (MSDSs) are provided by the manufacturer and 
contain information about physical characteristics, hazards, precautions, first aid, spill 
cleanup, and disposal procedures. Please familiarize yourself with the information 
contained in these documents before attempting to operate the instrument or using 
hazardous reagents. Additional copies of the MSDSs for Applied Biosystems chemicals 
are available from Applied Biosystems at no cost.

For experiments that require DNA Sequencing Polymer (DSP), see “Setting Up the 
Reagents for Runs with DSP” on page 2-75 for instructions.

Prepare the polymer and buffer:

Storing the Buffer Store electrophoresis buffer at 2–8 °C. The 1X buffer can be stored for 2 weeks.

When to Replace
Reagents

Use the following table.

Step Action

1 Equilibrate polymer to room temperature, then mix thoroughly by inversion.

2 Allow the polymer to sit for at least 5 minutes after mixing.

3 Dilute 5-mL of 10X Genetic Analyzer Buffer with EDTA to a 1X concentration 
(50-mL) with filter-sterilized, deionized water and bring to room temperature.

Reagent Replace

Cathode and Anode buffers Every week or every 200 runs.

Polymer Every week.

Water in the water vial and waste vial Before every set of runs.
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Preparing the 310 Genetic Analyzer for a DNA Sequencing Run With POP-6

About These
Procedures

To work through the example in this chapter using BigDye™ Terminators and POP-6 
polymer, or for any experiment requiring POP-6 polymer, set up the instrument as 
detailed below.

For experiments that require DNA Sequencing Polymer (DSP), see “Preparing the 
Syringes for a DNA Sequencing Run with DNA Sequencing Polymer (DSP)” on 
page 2-66 for additional instructions.

These procedures can also be found in Chapter 4, “Procedures for Operation.” Some 
are explained there with more detail and with illustrations. If you have a question about 
a procedure, see Chapter 4.

Cleaning the Pump
Block

IMPORTANT Do not expose the pump block to any organic solvents.

continued on next page

To clean the pump block:

Step Action

1 Remove the pump block from the instrument.

2 Open all valves and ports on the pump block.

3 Hold the pump block under warm running water to thoroughly rinse it.

4 Force warm water through the channels with the 5-cc plastic syringe provided in the 
Basic Installation Kit. 

Direct the flow of water through each channel in turn by sealing channel openings 
with plugs provided in the Basic Installation Kit. 

Rinse each channel five times.

Note If a 30-cc syringe is available, rinse each channel with it once. This can be 
more convenient than rinsing five times with a 5-cc syringe.

5 Rinse the valves with warm water.

Soak valves that are coated with dried polymer.

6 Visually inspect the channels for dried polymer, which looks like white residue. 
Wash the channels until the polymer is gone.

7 Rinse the block and its channels with distilled, deionized water.

8 Remove residual water from the pump block and fittings to ensure that the running 
polymer is not diluted. 

Force air through the channels, using the plastic syringe or canned compressed air, 
until the channels are dry.

9 Replace the pump block and buffer reservoir.
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Cleaning and
Preparing the

Syringe for Use

Use the 1.0-mL syringe with Performance Optimized Polymers.

CAUTION The teflon plunger is very susceptible to wear caused by friction. Therefore 
the pulling up and pushing down of the plunger within the barrel of the syringe should be 
minimized.

To clean the syringe:

continued on next page

Step Action

1 Rinse the syringe with distilled water. Remove excess water, but do not dry 
completely.

IMPORTANT Excessive wear occurs to the Teflon fitting of the plunger if it is 
completely dry.

2 Allow the polymer to equilibrate to room temperature before loading it into the 
syringe.

IMPORTANT Precipitate present when the bottle is removed from cold storage 
should go back into solution at room temperature. Do not use the polymer until the 
precipitate dissolves.

3 Mix the polymer thoroughly by inversion before use. Let it settle for at least 5 
minutes before use.

4 Inspect the syringe for the ferrule and two o-rings.

5 Draw a small amount of polymer solution (0.20-mL maximum) into the syringe. Pull 
plunger up to the 0.60-mL marker after the polymer solution is added.

! WARNING ! Gloves and eye protection should be worn when handling 
polymer.

6 Invert the syringe gently five or six times to coat the walls with polymer and discard 
this polymer solution.

This ensures that the running polymer is not diluted when added to the syringe.

7 For new, never-before-used syringes, perform this entire procedure twice to prevent 
air bubbles from sticking to the syringe walls.
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Loading Polymer To load polymer:

Setting Syringe Max
Travel

Set the Syringe Max Travel once for each size of syringe. Record the value for each 
syringe (the calibration sticker on the door is a good place for this record) and input it 
in the Manual Control window when you install the syringe again.

Step Action

1 Allow the polymer to equilibrate to room temperature before loading it into the 
syringe.

IMPORTANT Precipitate present when the bottle is removed from cold storage 
should go back into solution at room temperature. Do not use the polymer until the 
precipitate dissolves.

2 Mix the polymer thoroughly by inversion before use. Let it settle for at least 
5 minutes before use.

3 Fill the syringe manually with a maximum of 0.5-mL of polymer.

Note Do not use polymer that has been on the instrument for more than one 
week. Do not return unused polymer to the original bottle.

4 Remove all air bubbles by inverting syringe and pushing air bubbles out.

IMPORTANT To avoid loss of polymer, any bubbles near the plunger head 
must be removed.

5 Rinse the outside of the syringe with distilled water to remove any polymer on the 
outside of the syringe. 

Dry the outside of the syringe with a lint-free paper.

6 Move the syringe drive toggle to the left to attach the syringe to the pump block.

7 Place the syringe through the right-hand port of the plastic syringe guide plate, and 
screw the syringe into the pump block finger-tight.

8 Manually close and tighten the waste valve below the syringe and the luer valve to 
the left of the syringe.

To set the Syringe Max Travel: 

Step Action

1 Determine which version of Collection software is installed on your Macintosh® 
computer by clicking the Apple menu and selecting “About Collection Software”.

2 Use the following table to determine the next step:

3 Open the Manual Control window, select Syringe Home from the Function pop-up 
menu, and click Execute.

If you have... Then...

v. 1.04 or later Collection software go to step 3.

v. 1.0.2 Collection software a. Open the Window menu. 

b. Under Preferences, select 
Sequence Injection List Defaults 
or GeneScan Injection List 
Defaults. 

c. Type 139115 in the Operator entry 
window and click OK. 

d. Re-launch the Collection software.
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Filling the Pump
Block

To fill the pump block channels with polymer:

continued on next page

4 Select Syringe Max Travel in the Function pop-up menu. 

Note You will enter the displayed value in the next step.

5 Select Syringe DOWN and enter the current Syringe Max Travel value and click 
Execute.

6 After the syringe drive reaches the syringe plunger and stops moving, select Status 
from the Window menu.

7 Under the Injection pop-up window, read the number in the Gel Pump At window.

Subtract 15 from that number 

8 Select Syringe Max Travel in the Function pop-up menu of Manual Control and type 
the number you just calculated in step 7 and click Execute.

9 Record this value on the Calibration sticker on the left side door.

Note If you install a syringe of a different size, you must input the max travel 
value for that syringe size.

10 Select Syringe Up in the Function pop-up menu of Manual Control, enter 250 in the 
Value window, and click Execute.

To set the Syringe Max Travel: (continued)

Step Action

Step Action

1 Open the Manual Control window. Select Buffer Valve Close in the Function pop-up 
menu to close the pin valve at the anode buffer reservoir on the pump block.

2 Manually open the waste valve below the syringe.

3 Press the syringe plunger until a drop of polymer forms on the bottom of the waste 
valve. 

This removes the air bubbles at this valve site, and uses about 0.1-mL of polymer.

4 Manually close the waste valve.

5 Open the Manual Control menu and select Buffer Valve Open in the Function 
pop-up menu to open the pin valve at the anode buffer reservoir on the pump block.

6 Press the syringe plunger until polymer fills the polymer channel in the block.

This removes all of the air bubbles from the polymer channels, and should use 
about 0.1-mL of polymer.

IMPORTANT There should be no air bubbles in the pump block channels.

7 Select Buffer Valve Close in the Function pop-up menu.

8 Move the syringe drive toggle to the right to position it over the syringe plunger.

9 Select Syringe Down in the Function pop-up menu.

10 Select 50-step intervals and click Execute until the toggle makes contact with the 
syringe plunger.
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Cleaning the
Electrode

To clean the electrode:

Installing the
Capillary

Connecting the Capillary to the Pump Block 

Step Action

1 Open the ABI PRISM® 310 Data Collection Software.

2 Press the Tray button on the 310 Genetic Analyzer to lower the autosampler and 
present the tray.

3 Wipe the electrode with lint-free paper that has been dampened with distilled, 
deionized water.

4 Dry the electrode with fresh lint-free paper.

5 Press the Tray button to return the autosampler to its original position and immerse 
the capillary in buffer.

6 Recalibrate the autosampler after cleaning, trimming or replacing the electrode.

Step Action

1 Remove the new capillary from the storage tube.

Note When removing capillaries, rotate and pull on the capillary simultaneously. 
Be careful not to bend the capillary at the capillary window.

2 Clean the capillary window.

3 Open the door covering the heat plate.

4 Remove the plastic capillary fitting on the right side of the pump block.

5 Partially screw the capillary fitting back into the pump block.

IMPORTANT Do not tighten the fitting at this point in the procedure, or the 
opening on its tip will be crushed. The capillary must be properly inserted through 
the fitting before you tighten it.

6 Thread one end of the capillary through the capillary fitting.

7 Adjust the end of the capillary so that it is positioned directly below the opening to 
the glass syringe.

The end of the capillary must protrude well beyond the opening at the tip of the 
capillary fitting. 

To avoid crushing the opening, be certain that you see the capillary in the pump 
block channel before proceeding to the next step.

8 Tighten the capillary fitting finger-tight to secure the capillary.

IMPORTANT The capillary will twist as the fitting is tightened. Leave the other 
end of the capillary free to twist, or the capillary will break.
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Positioning the Capillary in the Detector

Positioning the Capillary Near the Electrode

Resetting the Injection Counter

Calibrating the
Autosampler

Calibrate the autosampler as follows:

continued on next page

Step Action

1 Open the laser detector door, and position the capillary in the vertical track of the 
detector. 

Align the colored labelling mark on the capillary with the top edge of the detector 
plate and laser detector door.

2 Tape the capillary to the heat plate with thermal tape to secure the position of the 
capillary labelling mark relative to the detector plate.

3 Close the laser detector door to secure the position of the capillary window.

Step Action

1 Thread the capillary through the capillary hole in the electrode thumbscrew until it 
protrudes past the tip of the electrode by about 0.5 mm. 

2 Tape the capillary to the heat plate just above the electrode thumbscrew and just 
above the detector door using thermal tape.

This secures the position of the capillary tip relative to the electrode. 

3 Close the door over the heat plate.

4 With the heat plate door closed, check that the capillary has not moved relative to 
the electrode.

Step Action

1 Open the Instrument window and choose Change Capillary.

2 Click OK in the Reset window to set the injection counter to zero.

Step Action

1 Choose Autosampler Calibration from the Instrument menu of the Collection 
software. 

The Autosampler Calibration window appears.

2 Click Start and follow the directions that appear on the screen.

3  Move the autosampler using the arrow keys in the Autosampler Calibration window 
or the arrow keys on the Macintosh® computer keyboard.

Note Hold down the arrow keys to move the autosampler with larger steps. This 
is often useful for z calibration.

4 Align the calibration dot on the front of the tray platform with the capillary. 

Center the end of the capillary on the x,y-calibration point. 

Almost touch the z-calibration point with the end of the capillary.

5 Click Set to save the calibration value.

6 Repeat for the rear calibration point and click Set.
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Loading Buffers Load the buffer as follows:

Preheating the Heat
Plate

This is optional. Preheating the heat plate can take up to 20 minutes. You can 
denature the samples while the instrument preheats.

Step Action

1 Fill the anode buffer reservoir to the red line with 1X Genetic Analyzer Buffer with 
EDTA, and install it on the pump block.

2 Label one of the buffer vials as Buffer, and fill it to the line with 1X Genetic Analyzer 
buffer with EDTA.

3 Cap the vial, insert the septum, and place it in position one on the autosampler. 

4 Label the other glass buffer vial as H2O, and fill it to the line with filter-sterilized, 
deionized water. 

5 Cap the vial, insert the septum, and place it in position two on the autosampler.

6 If the 1.5-mL Eppendorf tube has a lid attached, cut the lid off. 

Completely fill the tube with filter-sterilized, deionized water, and place it in position 
three on the autosampler.

Step Action

1 Open the Window pull-down menu, and choose Manual Control. 

The Manual Control window is displayed.

2 Choose Temperature Set from the Function menu, and set the temperature to 50 °C 
in the Value window.

3 Click Execute. 

The instrument will preheat to 50 °C. 

While the instrument is preheating, you can denature your samples.

The instrument doors must be closed. The safety interlock will prevent operation 
when the doors are open.
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DNA Template Preparation

Overview The DNA purification method used can affect the quality of the template preparation. 
Some recommendations for purifying DNA templates are given below.

Prepare adequate template to check purity (see “Determining DNA Quality” on 
page 2-21), to quantitate the DNA accurately (see “Quantitation” on page 2-22), and 
to perform the sequencing reactions. The recommended quantities for sequencing 
reactions are shown in Table 2-1 on page 2-22.

Refer to the Automated DNA Sequencing Chemistry Guide (P/N 4305080) for more 
information on DNA template preparation and specific protocols.

Single-stranded
DNA Templates

You can use the following methods to prepare single-stranded templates such as M13:

� QIAGEN (http://www.qiagen.com) QIAprep Spin M13 Kit (P/N 27704, 
50 reactions)

� Thermomax procedure

� PEG precipitation followed by phenol extraction

Plasmid DNA
Templates

The optimal procedure for preparing a particular plasmid depends on the particular 
bacterial strain and the yield of each construct. Good sequencing data has been 
obtained from the following methods:

� ABI PRISM Plasmid Miniprep Kit (P/N 402790 or 402791)

� Cesium chloride (CsCl) banding

� Modified alkaline lysis/PEG precipitation method

� PureGene DNA Isolation Kit (Gentra Systems, Inc., P/N D-5500A)

� QIAGEN Plasmid Kits (http://www.qiagen.com):

– Mini (P/N 12123, 25 reactions; 12125, 100 reactions)

– Midi (P/N 12143, 25 reactions; 12144, 50 reactions; 12145, 100 reactions)

– Maxi (P/N 12162, 10 reactions; 12163, 25 reactions; 12165, 100 reactions)

BAC DNA Templates With larger DNA targets such as bacterial artificial chromosomes (BACs), the quality 
of DNA template is crucial to the success of the sequencing reaction. Three methods 
have given good sequencing results:

� Alkaline lysis,1 with extra phenol extraction and isopropanol precipitation if very 
clean DNA is desired\

� Cesium chloride (CsCl) banding

� Modified AutoGen prep2

1. Marra, M., Weinstock, L.A., and Mardis, E.R. 1996. End sequence determination from large insert 
cloning using energy transfer fluorescent primers. Genomic Methods 6: 1118–1122.

2. “Bacterial Artificial Chromosome DNA Preparation” in ISS AutoGen 740 Operator’s Guide, version 3.0.
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PCR Templates This section provides information regarding PCR template preparation, but it is not 
meant to be a detailed guide to PCR amplification. General information on PCR 
amplification can be found in the Guide to PCR Enzymes (Stock No. 700905) and in 
the product inserts included with GeneAmp® PCR reagents. For PCR amplification, 
use GeneAmp PCR Instrument Systems and GeneAmp PCR Core Reagents.

Cycle sequencing has been found to provide the most reproducible results when 
sequencing PCR templates. Although PCR fragments can be difficult to denature with 
traditional sequencing methods, cycle sequencing provides several chances to 
denature and extend the template, which ensures adequate signal in the sequencing 
reaction.

For more detailed information about PCR sequencing, refer to the Automated DNA 
Sequencing Chemistry Guide (P/N 4305080) and Comparative PCR Sequencing, A 
Guide to Sequencing-Based Mutation Detection (Stock No. 770901-001).

Purifying PCR Products

� Commercially available products

We recommend Centricon-100 columns (P/N N930-2119). These columns 
contain an ultrafiltration membrane that separates primers and dNTPs from larger 
PCR products. However, they may not work as well for short PCR products 
(<125 bases).

QIAquick PCR Purification Kits (QIAGEN: P/N 28104, 50 reactions; 28106, 
250 reactions) also work well for PCR products ranging from 100 bp–10 kbp.

� Shrimp alkaline phosphatase and exonuclease I treatment

The removal of PCR primers is more critical for dye terminator sequencing, as 
both PCR primers can act as sequencing primers, creating two sets of extension 
products.

An alternative to purification is treatment of PCR products with shrimp alkaline 
phosphatase (SAP) and exonuclease I (Exo I) before sequencing. The SAP/Exo I 
procedure degrades nucleotides and single-stranded DNA (primers) remaining 
after PCR (Werle et al., 1994). This procedure is particularly useful in cases 
where limiting concentrations of primers and nucleotides cannot be used in PCR.
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DNA Template Quality

Using Control DNA Always use a control DNA template when preparing your sequencing reactions. This 
can help determine whether failed reactions are the result of poor template quality or 
sequencing reaction failure.

We recommend M13mp18 as a single-stranded control and pGEM-3Zf(+) as a 
double-stranded control. All Applied Biosystems DNA sequencing kits provide pGEM 
control DNA and a –21 M13 primer.

Sequencing Standards

The Long Read Cycle Sequencing Standards provide an additional control to help in 
troubleshooting electrophoresis runs. There are four standards available:

� Dye Primer Cycle Sequencing Standard (P/N 401920)

� Dye Terminator Cycle Sequencing Standard (P/N 402830)

� dRhodamine Terminator Cycle Sequencing Standard (P/N 4303120)

� BigDye Terminator Cycle Sequencing Standard (P/N 4304154)

Poor Template
Preparation

Inadequate template preparation is the most common cause of sequencing problems. 
Always follow recommended procedures to prepare templates.

The following are characteristics of badly prepared templates:

� Noisy data or peaks under peaks

� Failed reactions

� Weak signal

Contamination Potential contaminants include:

� proteins

� RNA or chromosomal DNA

� residual salts

� residual organic chemicals, e.g., phenol, chloroform, and ethanol
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Determining DNA
Quality

The following methods can be used to examine DNA quality:

� Agarose gel electophoresis

Purified DNA should run as a single band on an agarose gel.

� Spectrophotometry

The A260/A280 ratio should be 1.7–1.9. Smaller ratios usually indicate 
contamination by protein or organic chemicals.

Agarose gels reveal the presence of contaminating DNAs and RNAs, but not proteins. 
Spectrophotometry can indicate the presence of protein contamination, but not DNA 
and RNA contamination. These methods should be used together to get the most 
information about your DNA template before sequencing.

Note Neither of these methods shows the presence of contaminating salts that can cause 
noisy data. If you suspect that your DNA is contaminated with salt, remove the salt before 
sequencing (see “Purifying PCR Products” on page 2-19).

Cleaning Up Dirty
Templates

A “dirty” template preparation sometimes can be cleaned up with one of the following 
methods:

� Purify the DNA by ultrafiltration. Use Centricon-100 Micro-Concentrator columns 
(see “Purifying PCR Products” on page 2-19).

� Extract the DNA twice with 1 volume of chloroform or chloroform:isoamyl alcohol 
in a 24:1 (vol:vol) ratio.

� Precipitate the aqueous layer with PEG to remove all traces of chloroform. Add 
0.16 volumes of 5M NaCl and 1 total volume of 13% PEG. Incubate on ice for 20 
minutes, then centrifuge at 4 °C for 20 minutes. Rinse the pellet with 70% ethanol.
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DNA Template Quantity

Quantitation DNA template quantitation is critical for successful sequencing reactions. The most 
common way to determine DNA quantity is to measure the absorbance (optical 
density or O.D.) of a sample at 260 nm in a spectrophotometer.

One O.D. unit is the amount of a substance dissolved in 1.0 mL that gives an 
absorbance reading of 1.00 in a spectrophotometer with a 1-cm path length. The 
wavelength is assumed to be 260 nm unless stated otherwise. A260 values can be 
converted into ng/µL using Beer´s Law:

The following formulas, which are derived from Beer’s Law, convert A260 readings into 
ng/µL concentrations:

� One A
260

 unit of single-stranded DNA contains 33 ng/µL.

� One A
260

 unit of double-stranded DNA contains 50 ng/µL.

Amount to Use The amount of DNA template used in a sequencing reaction can affect the quality of 
the data. Too much template makes data appear top heavy with strong peaks at the 
beginning of the run that fade rapidly. Too little template or primer reduces the signal 
strength and peak height. In the worst case, the noise level increases so that bases 
cannot be called. Table 2-1 shows the recommended quantities for each method.

Absorbance (260 nm) = sum of extinction coefficient contributions × cuvette pathlength × 
oligonucleotide concentration

Table 2-1 Recommended DNA Template Quantity for Each Chemistry

Template

Cycle Sequencing Chemistry

Dye Primer
Dye 

Terminator
dRhodamine 
Terminator BigDye Primer

BigDye 
Terminator

PCR product:

100–200 bp 2–5 ng 1–3 ng 1–3 ng 2–5 ng 1–3 ng

200–500 bp 5–10 ng 3–10 ng 3–10 ng 5–10 ng 3–10 ng

500–1000 bp 10–20 ng 5–20 ng 5–20 ng 10–20 ng 5–20 ng

1000–2000 bp 20–50 ng 10–40 ng 10–40 ng 20–50 ng 10–40 ng

>2000 bp 50–150 ng 40–100 ng 40–100 ng 50–150 ng 40–100 ng

single-stranded 150–300 ng 100–250 ng 50–100 ng 200–400 ng 50–100 ng

double-stranded 300–600 ng 200–500 ng 200–500 ng 200–800 ng 200–500 ng

cosmid, BAC 0.5–1.0 µg 0.5–2.0 µg not 
recommended

300–600 ng 300–600 ng

genomic DNA not recommended 2–3 µg
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Primer Design and Quantitation

Overview The choice of primer sequence, method of primer synthesis, and approach to primer 
purification can have a significant effect on the quality of the sequencing data obtained 
in dye terminator cycle sequencing reactions with this kit. Dye primer cycle 
sequencing kits include dye-labeled primers that are already optimized and 
quantitated.

Some of the recommendations given here are based on information that is general 
knowledge, while others are based on practical experience gained by Applied 
Biosystems scientists.

Primer Design The following recommendations are provided to help optimize primer selection:

� The primer should be as pure as possible, preferably HPLC grade.

� Primers should be at least 18 bases long to ensure good hybridization.

� Avoid runs of an identical nucleotide, especially runs of four or more Gs.

� Keep the G-C content in the range 30–80%.

� For cycle sequencing, primers with melting temperatures (Tm) above 45 °C 
produce better results than primers with lower Tm using our recommended 
thermal cycling parameters.

� For primers with a G-C content less than 50%, it may be necessary to extend the 
primer sequence beyond 18 bases to keep the Tm>45 °C.

� Use of primers longer than 18 bases also minimizes the chance of having a 
secondary hybridization site on the target DNA.

� Avoid primers that can hybridize to form dimers.

� Avoid palindromes because they can form secondary structures.

� Several computer programs for primer selection are available. They can be useful 
in identifying potential secondary structure problems and determining if a 
secondary hybridization site exists on the target DNA.

Quantitation The following formula, which is derived from Beer’s Law, converts A260 readings into 
pmol/µL concentrations:

C (pmol/µL or µM) = (A260 × 100)/(1.54nA + 0.75nC + 1.17nG + 0.92nT),

where nx = number of residues of base x in the oligonucleotide
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Primer Problems
and Possible Causes Table 2-2 Primer Problems and Possible Causes

Problems Possible Causes

Poor priming resulting in 
weak signal

Melting temperature is too low due to low GC content and/or 
short primer length

Secondary structure of the primer, particularly at the 3' end

Secondary structure of the template in the region of 
hybridization

Adequate signal 
strength with noisy data

Secondary hybridization site, which results in many extra 
peaks

Impure primer. You may see a shadow sequence of N-1
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Preparing Sequencing Reactions

Reagent Age and
Reaction Storage

The freshest reagents are likely to perform the best. The following methods are 
recommended for guaranteeing reagent freshness.

� Store reagents at –15 to –25 °C when not in use, and thaw completely at room 
temperature or in an ice bath (do not heat) before use.

Note Do not use a frost-free freezer. The automatic cycling of the temperature for defrosting 
can damage reagents.

� Avoid excess (more than ten) freeze-thaw cycles. Aliquot reagents in smaller 
amounts if necessary.

� Shield reagents and sequencing reactions from light. Fluorescent dyes are 
susceptible to bleaching.

� If you would like to store sequencing reactions for future use, purify and dry them. 
Store at –15 to –25 °C in a non-frost-free freezer.

Reaction Tubes The type of tube required depends on the type of thermal cycler used. For the DNA 
Thermal Cycler (TC1) and DNA Thermal Cycler 480, use 0.5-mL GeneAmp 
Thin-Walled PCR tubes. For the GeneAmp PCR Systems 9700, 9600, and 2400, use 
0.2-mL MicroAmp® PCR tubes. If using the CATALYST 800 or ABI PRISM® 877 
instrument, refer to your instrument user’s manual for reaction setup.

Thermal Cyclers The type and performance of the thermal cycler used to prepare sequencing reactions 
can affect the quality of the reactions. Ensure that the thermal cycler is calibrated 
regularly by the manufacturer and that ramping rates are 1 °C/second.

BigDye Terminators The procedures given here are for the ABI PRISM® BigDye Terminator Cycle 
Sequencing Ready Reaction Kits. Refer to the Automated DNA Sequencing 
Chemistry Guide (P/N 4305080) for information about other chemistries.

The flexibility of the BigDye terminators allows three options for cycle sequencing:

Reaction Type Template Cycle

1X � PCR product

� plasmid

� M13

standard

0.5X � PCR product

� plasmid

� M13

standard

High-sensitivity (2X) � BACs, PACs, YACs, 
cosmids

� extra long PCR products

� genomic DNA

modified
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1X Reactions

0.5X Reactions

Dilute 5X Sequencing Buffer (400 mM Tris-HCl, 10 mM MgCl2, pH 9.0—P/N 4305605, 
600 reactions; 4305603, 5400 reactions) with an equal volume of deionized water to 
2.5X for use in this procedure.

Step Action

1 For each reaction, add the following reagents to a separate tube:

Reagent Quantity 

Terminator Ready Reaction Mix 8.0 µL

Template –

single-stranded DNA 50–100 ng

double-stranded DNA 200–500 ng

PCR product DNA 2–100 ng
(depending on size)

Primer 3.2 pmol

Deionized water q.s.

Total Volume 20 µL

2 Mix well and spin briefly.

3 If using the DNA Thermal Cycler (TC1) or DNA Thermal Cycler 480:

Overlay the reaction mixture with 40 µL of light mineral oil.

Step Action

1 For each reaction, add the following reagents to a separate tube:

Reagent Quantity 

Terminator Ready Reaction Mix 4.0 µL

2.5X Sequencing Buffer 4.0 µL

Template –

single-stranded DNA 50–100 ng

double-stranded DNA 200–500 ng

PCR product DNA 2–100 ng
(depending on size)

Primer 3.2 pmol

Deionized water q.s.

Total Volume 20 µL

2 Mix well and spin briefly.

3 If using the DNA Thermal Cycler (TC1) or DNA Thermal Cycler 480:

Overlay the reaction mixture with 40 µL of light mineral oil.
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High-sensitivity (2X) Reactions for BACs, PACs, YACs, Cosmids, and Extra Long PCR 
Fragments

The cycle sequencing procedure is on page 2-29.

High-sensitivity (2X) Reactions for Genomic DNA

The cycle sequencing procedure is on page 2-29.

Step Action

1 For each reaction, add the following reagents to a separate tube:

Reagent Quantity 

Terminator Ready Reaction Mixa (keep or delete 
note?)

a. Some laboratories have found that increasing the magnesium ion concentration gives better results.

16 µL

DNA Template 400–600 ng

Primer 5–10 pmolb

b. Some laboratories use larger quantities of primer.

Deionized water q.s.

Total Volume 40 µL

2 Mix well and spin briefly.

Step Action

1 For each reaction, add the following reagents to a separate tube:

Reagent Quantity 

Terminator Ready Reaction Mix 16 µL

DNA Templatea

a. Shearing the DNA by passing it seven times through a 21-gauge, 1-inch long needle can improve signals.

2–3 µg (genomic DNA)

Primer 6–13 pmol

ThermoFidelase (optional)b

b. Fidelity Systems (http://www.fidelitysystems.com): P/N A016 (100 µL), A056 (500 µL), A106 (1 mL)

1.0 µL

Deionized water q.s.

Total Volume 40 µL

2 Mix well and spin briefly.
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Cycle Sequencing

Overview These protocols have been optimized for all Applied Biosystems thermal cyclers, 
including the DNA Thermal Cycler (TC1), the DNA Thermal Cycler 480, the CATALYST 
800 Molecular Biology LabStation, the ABI PRISM® 877 Integrated Thermal Cycler, 
and the GeneAmp PCR Systems 9700, 9600, and 2400. The protocols contained in 
this section should work for all seven instruments.

If you use a thermal cycler not manufactured by Applied Biosystems, you may need to 
optimize thermal cycling conditions. Ramping time is very important. If the thermal 
ramping time is too fast (>1°/sec), poor (noisy) data may result.

BigDye Terminators These protocols are used for the BigDye terminator chemistry. These conditions work 
for a variety of templates and primers. However, if necessary, these parameters can 
be changed to suit particular situations, including the following:

� For short PCR products, you can use reduced numbers of cycles (e.g., 20 cycles 
for a 300-bp fragment).

� If the Tm of a primer is >60 °C, the annealing step can be eliminated.

� If the Tm of a primer is <50 °C, increase the annealing time to 30 seconds or 
decrease the annealing temperature to 48 °C.

� For templates with high GC content (>70%), heat the tubes at 98 °C for 5 minutes 
before cycling to help denature the template.

GeneAmp 9700, 9600, or 2400

Step Action

1 Place the tubes in a thermal cycler and set the volume to 20 µL.

2 Repeat the following for 25 cycles:

� Rapid thermal ramp to 96 °C

� 96 °C for 10 sec.

� Rapid thermal ramp to 50 °C

� 50 °C for 5 sec.

� Rapid thermal ramp to 60 °C

� 60 °C for 4 min.

3 Rapid thermal ramp to 4 °C and hold until ready to purify.

4 Spin down the contents of the tubes in a microcentrifuge.
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DNA Thermal Cycler (TC1) or DNA Thermal Cycler 480

BACs, PACs, YACs, Cosmids, and Extra Long PCR Fragments on the GeneAmp 9700 or 
9600

Note This protocol is for use only with the BigDye terminator kits.

Step Action

1 Place the tubes in a thermal cycler and set the volume to 20 µL.

2 Repeat the following for 25 cycles:

� Rapid thermal ramp to 96 °C

� 96 °C for 30 sec.

� Rapid thermal ramp to 50 °C

� 50 °C for 15 sec.

� Rapid thermal ramp to 60 °C

� 60 °C for 4 min.

3 Rapid thermal ramp to 4 °C and hold until ready to purify.

4 Spin down the contents of the tubes in a microcentrifuge.

Step Action

1 Place the tubes in a thermal cycler and set the volume to 40 µL.

2 Heat the tubes at 95 °C for 5 minutes.

3 Repeat the following for 30 cycles:a

� Rapid thermal ramp to 95 °C

� 95 °C for 30 sec.

� Rapid thermal ramp to 50–55 °C (depending on template)

� 50–55 °C for 10 sec.

� Rapid thermal ramp to 60 °C

� 60 °C for 4 min.

a. Some laboratories have found that increasing the number of cycles gives better results.

4 Rapid thermal ramp to 4 °C and hold until ready to purify.

5 Spin down the contents of the tubes in a microcentrifuge.
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Genomic DNA on the GeneAmp 9700 or 9600

Note This protocol is for use only with the BigDye terminator kits.

Cycle Sequencing on
the CATALYST 800

Templates that have been prepared as described in this chapter should be suitable for 
use on the CATALYST 800 Molecular Biology LabStation using LabStation 3.0 
protocols. Follow the protocols in the Turbo Appendix of the CATALYST 800 Molecular 
Biology LabStation User’s Manual to set up your reactions.

Terminator Sequencing has two options:

� Using a reaction premix containing the sequencing primer or premixing template 
with primer in the sample tube

� Combining reaction cocktail (lacking primers), water, and primer from one tube 
and template from another tube

This eliminates the requirement for premixing samples and primers.

Cycle Sequencing on
the ABI PRISM® 877

ITC

Predefined temperature profiles are provided for the following on the ABI PRISM® 877 
Integrated Thermal Cycler:

� Terminator Sequencing uses a reaction premix containing the sequencing primer, 
or else requires premixing template with primer in the sample tube.

� Terminator Automix Sequencing combines reaction cocktail (lacking primers), 
water, primer from one tube, and template from another tube. This eliminates the 
requirement for premixing of samples and primers.

The profile is chosen on the Chemistry page of the Sequencing Notebook and can be 
edited to make custom profiles. Refer to Chapter 4, “Using the ABI PRISM® 877 
Software,” in the ABI PRISM® 877 Integrated Thermal Cycler User’s Manual.

Step Action

1 Place the tubes in a thermal cycler and set the volume to 40 µL.

2 Heat the tubes at 95 °C for 5 minutes.

3 Repeat the following for 45 cycles:

� Rapid thermal ramp to 95 °C

� 95 °C for 30 sec.

� Rapid thermal ramp to 55 °C (depending on template)

� 55 °C for 20 sec.

� Rapid thermal ramp to 60 °C

� 60 °C for 4 min.

4 Rapid thermal ramp to 4 °C and hold until ready to purify.

5 Spin down the contents of the tubes in a microcentrifuge.
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Preparing Extension Products for Electrophoresis

Overview Unincorporated dye terminators must be removed before the samples can be 
analyzed by electrophoresis. Excess dye terminators in sequencing reactions obscure 
bases in the early part of the sequence and can interfere with basecalling.

� Precipitation methods are cheaper and faster, but they remove less of the 
unincorporated dye-labeled terminators that can obscure data at the beginning of 
the sequence.

� The spin column procedure removes more terminators, but is more costly than 
precipitation methods.

Spin Column
Purification

We recommend Centri-Sep™ spin columns from Princeton Separations (P/N CS-901).

Tips for optimizing spin column purification:

� Use one column for each sample.

� Do not process more columns than you can handle conveniently at one time.

� Hydrate the spin columns for at least 2 hours.

� Load the sample in the center of the column bed. Make sure that the sample does 
not touch the sides of the column. If samples are not properly loaded, peaks from 
unincorporated dye terminators can result.

� Spin the column at 325–730 × g for best results. Use the following formula to 
calculate the best speed for your centrifuge:

g = 11.18 × r × (rpm/1000)2

where:

g = relative centrifugal force

rpm = revolutions per minute

r = radius of the rotor in cm

� Do not spin for more than 2 minutes.

� Perform the entire procedure without interruption to ensure optimal results. Do not 
allow the column to dry out.

To perform spin column purification: 

Step Action

1 Gently tap the column to cause the gel material to settle to the bottom of the 
column.

2 Remove the upper end cap and add 0.8 mL of deionized water.

3 Replace the upper end cap and vortex or invert the column a few times to mix the 
water and gel material.

4 Allow the gel to hydrate at room temperature for 30 minutes (at least 2 hours for 
BigDye terminators).

Note Hydrated columns can be stored for a few days at 2–6 °C. Longer storage 
in water is not recommended. Allow columns that have been stored at 2–6 °C to 
warm to room temperature before use.

5 Remove any air bubbles by inverting or tapping the column and allowing the gel to 
settle.
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6 Remove the upper end cap first, then remove the bottom cap. Allow the column to 
drain completely by gravity.

Note If flow does not begin immediately, apply gentle pressure to the column 
with a pipette bulb.

7 Insert the column into the wash tube provided.

8 Spin the column in a microcentrifuge at 730 × g for 2 minutes to remove the 
interstitial fluid.

9 Remove the column from the wash tube and insert it into a sample collection tube 
(e.g., a 1.5-mL microcentrifuge tube).

10 Remove the extension reaction mixture from its tube and load it carefully onto the 
center of the gel material.

Note If the TC1 or DNA Thermal Cycler 480 was used for thermal cycling, 
remove the reactions from the tubes as shown in step 2 of the EtOH/NaOAc 
procedure on page 2-37.

11 Spin the column in a microcentrifuge at 730 × g for 2 minutes.

Note If using a centrifuge with a fixed-angle rotor, place the column in the same 
orientation as it was in for the first spin. This is important because the surface of the 
gel will be at an angle in the column after the first spin.

12 Discard the column. The sample is in the sample collection tube.

13 Dry the sample in a vacuum centrifuge for 10–15 minutes, or until dry. Do not 
over-dry. (check time w/R&D or tech support)

To perform spin column purification: (continued)

Step Action
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Isopropanol
Precipitation

Precipitation in 96-Well MicroAmp Trays

Reagents and equipment required:

� Variable speed table-top centrifuge with microtiter plate tray, capable of reaching 
at least 1400 × g

� Strip caps or adhesive-backed aluminum foil tape (3M Scotch Tape 425-3)3

� 75% Isopropanol (2-propanol) or 100% isopropanol (anhydrous) at room 
temperature

Note This procedure does not use salt.

3. Contact 3M in the USA at (800) 364-3577 for your local 3M representative. Use of other tapes may result 
in leakage or contamination of the sample.

To precipitate extension products in MicroAmp Trays: 

Step Action

1 Remove the MicroAmp Tray from the thermal cycler. Remove the caps from each 
tube.

2 Add one of the following:

� 80 µL of 75% isopropanol

or

� 20 µL of deionized water and 60 µL of 100% isopropanol

The final isopropanol concentration should be 60 ± 5%.

3 Seal the tubes with strip caps or by applying a piece of 3M Scotch Tape 425-3 
adhesive-backed aluminum foil tape. Press the foil onto the tubes to prevent any 
leakage.

4 Invert the tray a few times to mix.

5 Leave the tray at room temperature for 15 minutes to precipitate the extension 
products.

Note Precipitation times <15 minutes will result in the loss of very short 
extension products. Precipitation times >24 hours will increase the precipitation of 
unincorporated dye terminators.

6 Place the tray in a table-top centrifuge with tube-tray adaptor and spin it at the 
maximum speed, which must be ≥1400 × g but <3000 × g:

� 1400–2000 × g: 45 minutes

� 2000–3000 × g: 30 minutes

Note A MicroAmp tube in a MicroAmp Tray can withstand 3000 × g for 
30 minutes.

IMPORTANT Proceed to the next step immediately. If not possible, then spin 
the tubes for 2 minutes more immediately before performing the next step.

7 Without disturbing the precipitates, remove the adhesive tape and discard the 
supernatant by inverting the tray onto a paper towel folded to the size of the tray.

8 Place the inverted tray with the towel into the table-top centrifuge and spin at 
700 × g for 1 minute.
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Precipitation in Microcentrifuge Tubes

Reagents and equipment required for this method:

� 1.5-mL microcentrifuge tubes

� Benchtop microcentrifuge, capable of reaching at least 14000 × g

� Vacuum centrifuge

� 75% Isopropanol (2-propanol) or 100% isopropanol (anhydrous) at room 
temperature

Note This procedure does not use salt.

9 Remove the tray and discard the paper towel.

Note Pellets may or may not be visible. Vacuum drying of the samples is not 
necessary.

To precipitate extension products in microcentrifuge tubes: 

Step Action

1 Pipet the entire contents of each extension reaction into a 1.5-mL microcentrifuge 
tube.

IMPORTANT Transfer as little oil as possible.

2 Add one of the following:

� 80 µL of 75% isopropanol

or

� 20 µL of deionized water and 60 µL of 100% isopropanol

The final isopropanol concentration should be 60 ± 5%.

3 Close the tubes and vortex briefly.

4 Leave the tubes at room temperature for 15 minutes to precipitate the extension 
products.

Note Precipitation times <15 minutes will result in the loss of very short 
extension products. Precipitation times >24 hours will increase the precipitation of 
unincorporated dye terminators.

5 Place the tubes in a microcentrifuge and mark their orientations. Spin the tubes for 
20 minutes at maximum speed.

IMPORTANT Proceed to the next step immediately. If not possible, then spin 
the tubes for 2 minutes more immediately before performing the next step.

To precipitate extension products in MicroAmp Trays: (continued)

Step Action

To remove reactions run on the 
TC1 or DNA Thermal Cycler 480:
Place the pipette tip into the bottom 
of the reaction and carefully remove 
the reaction from the oil.

Oil

Reaction
2-34 Running Sequencing Experiments



Ethanol
Precipitation

With ethanol precipitation, traces of unincorporated terminators may be seen at the 
beginning of the sequence data (up to base 40), but this is usually minimal. Some loss 
in the recovery of the smallest fragments may also be observed.

Precipitation in 96-Well MicroAmp Trays

Reagents and equipment required:

� Variable speed table-top centrifuge with microtiter plate tray, capable of reaching 
at least 1400 × g

� Strip caps or adhesive-backed aluminum foil tape (3M Scotch Tape 425-3)4

� 95% Ethanol (ACS reagent grade), non-denatured

Note This procedure does not use salt.

6 Carefully aspirate the supernatants with a separate pipette for each sample and 
discard. Pellets may or may not be visible.

IMPORTANT The supernatants must be removed completely, as 
unincorporated dye terminators are dissolved in them. The more residual 
supernatant left in the tubes, the more unincorporated dye terminators will remain 
in the samples.

7 Add 250 µL of 75% isopropanol to the tubes and vortex them briefly. 

8 Place the tubes in the microcentrifuge in the same orientation as in step 5 and spin 
for 5 minutes at maximum speed.

9 Aspirate the supernatants carefully as in step 6.

10 Dry the samples in a vacuum centrifuge for 10–15 minutes or to dryness. 
(Alternatively, place the tubes with the lids open in a heat block or thermal cycler at 
90 °C for 1 minute.)

To precipitate extension products in microcentrifuge tubes: (continued)

Step Action

4. Contact 3M in the USA at (800) 364-3577 for your local 3M representative. Use of other tapes may result 
in leakage or contamination of the sample.

To precipitate extension products in MicroAmp Trays: 

Step Action

1 Remove the MicroAmp Tray from the thermal cycler. Remove the caps from each 
tube.

2 Add the following:

� 16 µL of deionized water

� 64 µL of non-denatured 95% ethanol

The final ethanol concentration should be 60 ± 3%.

3 Seal the tubes with strip caps or by applying a piece of 3M Scotch Tape 425-3 
adhesive-backed aluminum foil tape. Press the foil onto the tubes to prevent any 
leakage.

4 Invert the tray a few times to mix.
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Precipitation in Microcentrifuge Tubes

Reagents and equipment required for this method:

� 1.5-mL microcentrifuge tubes

� Benchtop microcentrifuge, capable of reaching at least 14000 × g

� Vacuum centrifuge

� 95% Ethanol (ACS reagent grade)

Note This procedure does not use salt.

5 Leave the tray at room temperature for 15 minutes to precipitate the extension 
products.

Note Precipitation times <15 minutes will result in the loss of very short 
extension products. Precipitation times >24 hours will increase the precipitation of 
unincorporated dye terminators.

6 Place the tray in a table-top centrifuge with tube-tray adaptor and spin it at the 
maximum speed, which must be ≥1400 × g but <3000 × g:

� 1400–2000 × g: 45 minutes

� 2000–3000 × g: 30 minutes

Note A MicroAmp tube in a MicroAmp Tray can withstand 3000 × g for 
30 minutes.

IMPORTANT Proceed to the next step immediately. If not possible, then spin 
the tubes for 2 minutes more immediately before performing the next step.

7 Without disturbing the precipitates, remove the adhesive tape and discard the 
supernatant by inverting the tray onto a paper towel folded to the size of the tray.

8 Place the inverted tray with the towel into the table-top centrifuge and spin at 
700 × g for 1 minute.

9 Remove the tray and discard the paper towel.

Note Pellets may or may not be visible. Vacuum drying of the samples is not 
necessary.

To precipitate extension products in microcentrifuge tubes: 

Step Action

1 Pipet the entire contents of each extension reaction into a 1.5-mL microcentrifuge 
tube.

Note If the TC1 or DNA Thermal Cycler 480 was used for thermal cycling, 
remove the reactions from the tubes as shown in step 1 on page 2-34.

2 Add the following:

� 16 µL of deionized water

� 64 µL of non-denatured 95% ethanol

The final ethanol concentration should be 60 ± 3%.

3 Close the tubes and vortex briefly.

To precipitate extension products in MicroAmp Trays: (continued)

Step Action
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Ethanol/Sodium
Acetate Precipitation

Precipitation in 96-Well MicroAmp Trays

Reagents and equipment required:

� Variable speed table-top centrifuge with microtiter plate tray, capable of reaching 
at least 1400 × g

� Strip caps or adhesive-backed aluminum foil tape (3M Scotch Tape 425-3)5

� Sodium acetate (NaOAc), 3 M, pH 4.6 (P/N 400320)

� 95% Ethanol (ACS reagent grade)

4 Leave the tubes at room temperature for 15 minutes to precipitate the extension 
products.

Note Precipitation times <15 minutes will result in the loss of very short 
extension products. Precipitation times >24 hours will increase the precipitation of 
unincorporated dye terminators.

5 Place the tubes in a microcentrifuge and mark their orientations. Spin the tubes for 
20 minutes at maximum speed.

IMPORTANT Proceed to the next step immediately. If not possible, then spin 
the tubes for 2 minutes more immediately before performing the next step.

6 Carefully aspirate the supernatants with a separate pipette for each sample and 
discard. Pellets may or may not be visible.

IMPORTANT The supernatants must be removed completely, as 
unincorporated dye terminators are dissolved in them. The more residual 
supernatant left in the tubes, the more unincorporated dye terminators will remain 
in the samples.

7 Add 250 µL of 70% ethanol to the tubes and vortex them briefly. 

8 Place the tubes in the microcentrifuge in the same orientation as in step 5 and spin 
for 10 minutes at maximum speed.

9 Aspirate the supernatants carefully as in step 6.

10 Dry the samples in a vacuum centrifuge for 10–15 minutes or to dryness. 
(Alternatively, place the tubes with the lids open in a heat block or thermal cycler at 
90 °C for 1 minute.)

To precipitate extension products in microcentrifuge tubes: (continued)

Step Action

5. Contact 3M in the USA at (800) 364-3577 for your local 3M representative. Use of other tapes may result 
in leakage or contamination of the sample.

To precipitate extension products in MicroAmp Trays: 

Step Action

1 Remove the MicroAmp Tray from the thermal cycler. Remove the caps from each 
tube.

2 Add the following:

� 2.0 µL of 3 M sodium acetate (NaOAc), pH 4.6

� 50 µL of 95% ethanol (EtOH)

The final ethanol concentration should be 65%.
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Precipitation in Microcentrifuge Tubes

� 1.5-mL microcentrifuge tubes

� Benchtop microcentrifuge, capable of reaching at least 14000 × g

� Vacuum centrifuge

� Sodium acetate (NaOAc), 3 M, pH 4.6 (P/N 400320)

� 95% Ethanol (ACS reagent grade)

3 Seal the tubes with strip caps or by applying a piece of 3M Scotch Tape 425-3 
adhesive-backed aluminum foil tape. Press the foil onto the tubes to prevent any 
leakage.

4 Invert the tray a few times to mix.

5 Leave the tray at room temperature for 15 minutes to precipitate the extension 
products.

Note Precipitation times <15 minutes will result in the loss of very short 
extension products. Precipitation times >24 hours will increase the precipitation of 
unincorporated dye terminators.

6 Place the tray in a table-top centrifuge with tube-tray adaptor and spin it at the 
maximum speed, which must be ≥1400 × g but <3000 × g:

� 1400–2000 × g: 45 minutes

� 2000–3000 × g: 30 minutes

Note A MicroAmp tube in a MicroAmp Tray can withstand 3000 × g for 
30 minutes.

IMPORTANT Proceed to the next step immediately. If not possible, then spin 
the tubes for 2 minutes more immediately before performing the next step.

7 Without disturbing the precipitates, remove the adhesive tape and discard the 
supernatant by inverting the tray onto a paper towel folded to the size of the tray.

8 Place the inverted tray with the towel into the table-top centrifuge and spin at 
700 × g for 1 minute.

9 Add 150 µL of 70% ethanol to each pellet.

10 Cap or seal the tubes, then invert the tray a few times to mix.

11 Spin the tray for 10 minutes at maximum speed.

12 Repeat steps 7 and 8.

13 Remove the tray and discard the paper towel.

Note Pellets may or may not be visible. Vacuum drying of the samples is not 
necessary.

Step Action

1 For each sequencing reaction, prepare a 1.5-mL microcentrifuge tube containing 
the following:

� 2.0 µL of 3 M sodium acetate (NaOAc), pH 4.6

� 50 µL of 95% ethanol (EtOH)

Note If the TC1 or DNA Thermal Cycler 480 was used for thermal cycling, 
remove the reactions from the tubes as shown in step 1 on page 2-34.

To precipitate extension products in MicroAmp Trays: (continued)

Step Action
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2 Pipet the entire contents of each extension reaction into a tube of 
sodium acetate/ethanol mixture. Mix thoroughly.

3 Vortex the tubes and leave at room temperature for 15 minutes to precipitate the 
extension products.

Precipitation times <15 minutes will result in the loss of very short extension 
products. Precipitation times >24 hours will increase the precipitation of 
unincorporated dye terminators.

4 Spin the tubes in a microcentrifuge for 20 minutes at maximum speed.

5 Carefully aspirate the supernatant with a pipette and discard.

IMPORTANT The supernatants must be removed completely, as 
unincorporated dye terminators are dissolved in them. The more residual 
supernatant left in the tubes, the more unincorporated dye terminators will remain 
in the samples.

6 Rinse the pellet with 250 µL of 70% ethanol.

7 Vortex briefly.

8 Spin for 5 minutes in a microcentrifuge at maximum speed. Again, carefully aspirate 
or decant the supernatant and discard.

9 Dry the pellet in a vacuum centrifuge for 10–15 minutes, or until dry. Do not 
over-dry. (Alternatively, place the tubes with the lids open in a heat block or thermal 
cycler at 90 °C for 1 minute.)

Step Action
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Denaturing and Loading Samples

About TSR and
Samples in TSR

The protocol uses a sample preparation reagent designated the Template 
Suppression Reagent (TSR).

Store TSR at 2–8 °C.

At room temperature, samples in TSR are stable for a maximum of 48 hours. 

Although not recommended on a routine basis, you can keep samples prepared in 
TSR frozen for several weeks before running on the ABI PRISM 310 Genetic Analyzer 
with no detectable loss in resolution or base calling. 

Preparing the
TSR-Sample Mix

Prepare the TSR-sample mix as follows:

Minimum Sample
Volume

The minimum sample volume per tube is 10-µL.

IMPORTANT If using 10-µL sample volumes, it is extremely important that the autosampler 
tray be calibrated (see “How to Calibrate the Autosampler” on page 4-27).

You can use a single sample for more than one analysis. Either inject out of one 
sample tube repeatedly, or split the sample into several tubes. 

continued on next page

Step Action

1 Add 25-µL of TSR to each sample pellet.

2 Vortex thoroughly and heat for 2 minutes at 95 °C.

3 If you are using the 96-well tray assembly, you can denature samples directly in the 
tray. See “Using Septa Strips” on page 1-21.

4 Chill samples on ice, vortex thoroughly, then spin briefly in a microcentrifuge.

5 Hold samples on ice or keep frozen until ready to load on the instrument. 

6 Transfer the samples to 0.5- or 0.2-mL sample tubes and cover with a tube septum. 

Note You must use tube septa to prevent evaporation of samples, especially if 
samples are put in the autosampler more than 6 hours before analysis.
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Preparing a Portion
of a Reaction

Mixture for Analysis

Occasionally, you may want to prepare only a portion of a sequencing reaction mixture 
for analysis on the 310 Genetic Analyzer and reserve the rest of the sample for 
analysis later or elsewhere.

To prepare a portion of a sequencing reaction mixture:

Loading the Samples Move the samples into the autosampler as follows:

Step Action

1 Add 6-µL of TSR to the dried DNA sequencing reaction.

2 Vortex to dissolve the extension products. 

3 Heat the sample for 1 minute at 95 °C to ensure denaturation. 

4 Transfer 2-µL of the sample to 10-µL of TSR in a sample tube. 

5 Cover the tube with a septum and vortex well. 

6 Heat the TSR mixture for 2 minutes at 95 °C and place it on ice until ready to place 
in the instrument. 

Step Action

1 If necessary, transfer the denatured samples to a 48- or 96-well tray.

IMPORTANT The tube arrangement and order of the samples in the tray and 
on the Sample Sheet must be the same. Make note of the tube arrangement you 
use, so that you can prepare the Sample Sheet correctly.

2 Seal each tube with a septum, and place the tray into the autosampler.
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About Run Modules, Dye Set/Primer, and Matrix Files

Overview DNA sequencing on the 310 Genetic Analyzer requires you to have these types of 
files:

� Module

� Basecaller

� Dye set/Primer (also known as mobility)

� Matrix

You select the particular files appropriate to your experiment on the Sample Sheet and 
Injection List.

The module, Basecaller, and Dye Set/Primer files are supplied with the Data 
Collection Software. Updated files can be obtained from the Applied Biosystems site 
on the World Wide Web (www.appliedbiosystems.com/techsupport), from Applied 
Biosystems Technical Support, or from your local field applications specialist (call your 
local sales office for more information). For new applications, a disk containing the 
files is often included with the reagent kit. 

Matrix files are all created using ABI PRISM® DNA Sequencing Analysis Software. See 
the ABI PRISM DNA Sequencing Analysis Software User’s Manual.

Run Modules Run modules are software files. The 310 Genetic Analyzer executes the steps in a run 
module to process a sample. Run time, temperature and voltage, prerun time, 
injection time and voltage are some of the run parameters controlled by the run 
module. 

Run modules are selected through the Injection List. The reference table on page 2-43 
will help you select the appropriate run module.

If a custom module is necessary, see “Editing Modules Using Manual Control” on 
page 5-17.

Dye Set/Primer Files Also known as mobility files, these contain information that adjusts the sample data 
collected during electrophoresis for:

� The dye set

� Mobility of the primers or terminators

Dye Set/Primer files are selected through the Sample Sheet. The reference table 
below will help you select the appropriate run module.

Dye Set/Primer files cannot be edited.

continued on next page
2-42 Running Sequencing Experiments



\\

Reference Table for
Run Modules and

Dye Set/Primer Files

The following table lists the Run modules and the Dye/Set Primer files.

continued on next page

Chemistry Syringe Polymer
Run 
Module Mobility File

Base 
Caller

Capillary 
Size

Capillary 
Mark

 Terminator 250-µL DSP Seq Run 
(250 uL) A

DP5%CEHV{A Set– 
any primer}

CE-1 47 cm x 
75 µ

silver

Terminator, long- 
read sequencing

1.0-mL POP-6 Seq POP6 
(1.0\-mL) A

DT POP 6 CE-2 61 cm x 
50 µ

pink

Terminator, 
RAPID sequencing

1.0-mL POP-6 Seq POP6 
(1.0 -mL) 
RAPID A

DT POP 6 CE-2 47 cm x 
50 µ

green

Primer 250-µL DSP Seq Run 
(250 uL) A

DP5%CEHV{-21M13
} or 
DP5%CEHV{M13rev
}

CE-1 47cm x 
75 µ

silver

Dichlororhodamine
(dRhodamine) 
Terminator

250-µL DSP Seq Run 
(250 uL) E

DP5%CEHV{dR 
Set– any primer}

CE-1 47cm x 
75 µ

silver

dRhodamine 
Terminator, long- 
read sequencing

1.0-mL POP-6 Seq POP6 
(1.0-mL) E

DT POP6 {dR Set– 
any primer}

CE-1 61 cm x 
50 µ

pink

dRhodamine 
Terminator, 
RAPID sequencing

1.0-mL POP-6 Seq POP6 
(1.0-mL) 
RAPIDa E

a. Rapid sequencing

DT POP6 {dR Set– 
any primer}

CE-1 47 cm x 
50 µ

green

BigDye™ Primerb, 
long-read 
sequencing

b. There are no BigDye™ Primer mobility files for the DNA Sequencing Polymer on the ABI PRISM® 310 instrument.

1.0-mL POP-6 Seq POP6 
(1.0 -mL) E

DP POP6 {BD 
Set-21M13} or 
DP POP6 {BD 
Set-M13rev}

CE-1 61 cm x 
50 µ

pink

BigDye™ Primer, 
RAPID sequencing

1.0-mL POP-6 Seq POP6 
(1.0–mL) 
RAPID E

DP POP6 {BD 
Set-21M13} or 
DP POP6 {BD 
Set-M13rev}

CE-1 47 cm x 
50 µ

green

BigDye™ 
Terminatorc, 
long-read 
sequencing

c. There are no BigDye™ Terminator mobility files for the DNA Sequencing Polymer on the ABI PRISM® 310 instrument.

1.0-mL POP-6 Seq POP6 
(1.0–mL) E

DT POP6 {BD 
Set-any primer}

CE-1 61 cm x 
50 µ

pink

BigDye™ 
Terminator, 
RAPID sequencing

1.0-mL POP-6 Seq POP6 
(1.0–mL) 
RAPID E

DT POP6 {BD 
Set-any primer}

CE-1 47 cm x 
50 µ

green
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Matrix Files Matrix files contain information that corrects for “spectral overlap”. Spectral overlap 
occurs when part of one dye’s emission spectrum falls onto a portion of the detection 
hardware that is collecting the fluorescent peak of another dye. Dye sets are created 
to minimize spectral overlap, but it occurs to some extent.

When choosing matrix files in the Sample Sheet, match the matrix file to the samples 
by dye set and sequencing chemistry. For example, BigDye™ terminator samples run 
with a module file for Virtual Filter E should be analyzed with a matrix file that was also 
run with Virtual Filter E.

The dye set used to create the matrix file must be the same as the dye set used to run 
the sample. If you analyze data with a matrix file that does not reflect the conditions of 
your run, the run will appear to fail. Re-analyze with the correct matrix file if you have 
made this error.
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Preparing the Matrix Standards

Preparing Matrix
Standard Samples

You must create a matrix file the first time you use any sequencing method (i.e., dye 
terminators, BigDye™ terminators, dye primers, etc.).

Preparing matrix standards is optional. The matrix file also can be made directly from 
a sample or a Sample Standard.

For each of the four matrix standards:

About dRhodamine
Matrix Standards

The dRhodamine matrix standards are used for BigDye™ primer and BigDye™ 
terminator matrix files as well as dRhodamine matrix files. The dRhodamine matrix 
standards are:

Matrix standards are stable for six months at 2–6 °C. Avoid freeze-thaw cycles.

The dRhodamine matrix standards are provided in a ready-to-use format and are 
premixed with a blue dye for use on slab gels. The blue dye is not necessary nor is it 
detrimental to use with the 310 Genetic Analyzer.

The matrix is consistent with current base-calling conventions, i.e., C is blue, A is 
green, G is black, and T is red in analyzed files. See “Color Display of Data” on 
page 1-16 for more information about color display in raw and analyzed data.

Denaturing the
Matrix Standard

Samples

You can denature the matrix standard samples in the thermal cycler with your samples 
or follow this procedure:

Step Action

1 Mix in a sample vial:

a. 12-µL of TSR

b. 1-µL of matrix standard

2 Label each vial with the base and dye.

3 Gently vortex the mixture for 3–5 seconds.

4 Store the mix at 2–6 °C until ready to use.

Tube Label Color of Raw Data Base

dR110 Matrix Standard blue G

dR6G Matrix Standard green A

dTAMRA Matrix Standard black C

dROX Matrix Standard red T

Step Action

1 Heat the sample for 2 minutes at 95 °C.

2 Chill the sample on ice.

3 Hold on ice until ready to load in the autosampler.
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Preparing the Sample Standard

About Sample
Standards

A Sample Standard verifies operation of the instrument’s hardware, just as the control 
template verifies the correct preparation of the sample template. Running a Sample 
Standard is optional.

Applied Biosystems sells sequencing standards for dye terminator and dye primer 
sequencing. Contact your sales representative for more information.

Preparing a
TSR-Sample

Standard Mix

To prepare a TSR-Sample Standard mix:

Step Action

1 Add 25-µL of TSR to a tube containing a dried DNA sequencing Sample Standard.

2 Mix thoroughly on a vortex mixer and heat for 2 min at 95 °C.

3 Chill on ice, vortex thoroughly, then spin briefly in a microfuge.

4 Hold on ice or keep frozen until ready to load on the instrument.

5 Just before loading in the autosampler, transfer the samples to small sample tubes. 
Cover with a tube septum. 

IMPORTANT You must use tube septa to prevent evaporation of 
samples—especially samples that sit in the autosampler for more than 6 hours 
before being analyzed.
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Preparing the Sample Sheet and Injection List

Purpose The Sample Sheet associates sample information (name and type of analysis) with a 
sample tube position in the autosampler.

The Injection List specifies the order for running samples, how many injections are 
made from each sample, and the module and running conditions for each injection.

Preparing the
Sample Sheet

The first time you use any group of samples, you must create a Sample Sheet.

Note This chapter takes BigDye™ terminator sequencing as a detailed example, and the 
illustrations in the procedure below are from a BigDye™ terminator sequencing Sample Sheet. If 
you use rhodamine or dichlororhodamine dye terminator sequencing, or rhodamine or BigDye™ 
primer sequencing, choose mobility files and matrix files appropriately. See the Quick 
Reference Card (P/N 904579 rev A) at the front of this manual or “About Run Modules, Dye 
Set/Primer, and Matrix Files” on page 2-42, for help when filling out the Sample Sheet and 
Injection List.

The Sample Sheet will be saved in the Sample Sheet folder on the Macintosh® 
computer’s hard drive, and if you need to sequence the same group of samples again, 
you can simply select the previously created Sample Sheet. If there is already a 
Sample Sheet prepared, go to“Using a Previously Created Sample Sheet” on 
page 2-48.

Creating a New Sample Sheet

To create a new Sample Sheet: 

Step Action

1 In the ABI PRISM® 310 Data Collection Software, select New from the File menu.

2 Click Sequence Smpl Sheet 48 or 96 Tube (match the type of tray used in the 
autosampler).

3 The Sample Sheet window appears.

Figure 2-1 Sample Sheet window for a 48-well sample tray
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Using a Previously
Created Sample

Sheet

If you are running the same group of samples for a second or third time, you can use 
the original Sample Sheet. Simply select the previously created Sample Sheet when 
filling out the Injection List.

If you want to modify an existing Sample Sheet:

continued on next page

4 The number in the first column corresponds to the location of the sample in the 
autosampler tray.

Put Sample Names in the second column.

5 Select Dye Set/Primer and Matrix files through the pop-up menus.

See “About Run Modules, Dye Set/Primer, and Matrix Files” on page 2-42 if you 
need help selecting the correct file.

Note The first time you run sequencing reactions under new conditions, any 
matrix file can be used for the run. After the run, you must make a matrix file for the 
new conditions.

Figure 2-2 Dye Set/Primer pop-up menu

6 Enter any additional comments that you want to link to the samples.

7 Open the File pull-down menu, and select Save As. Name the Sample Sheet, and 
press Return to save it in the Sample Sheets folder.

To create a new Sample Sheet: (continued)

Step Action

Step Action

1 Open the Sample Sheet. It is stored in the Sample Sheet folder on the Macintosh 
hard drive.

2 Make changes and save the Sample Sheet.

Give it a new name if you want to keep the original. Choosing Save without 
renaming the Sample Sheet will overwrite the original.

3 Select the modified Sample Sheet when filling out the Injection List.
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Preparing an
Injection List

Fill out an Injection List to start a run.

Note This chapter takes BigDye™ terminator sequencing as a detailed example, and the 
illustrations in the procedure below are from a BigDye™ terminator sequencing Injection List. If 
you use rhodamine or dichlororhodamine dye terminator sequencing, or rhodamine or BigDye™ 
primer sequencing, choose run modules appropriately. See the Quick Reference Card at the 
front of this manual or “About Run Modules, Dye Set/Primer, and Matrix Files” on page 2-42, for 
help when filling out the Sample Sheet and Injection List.

Creating an Injection List

To create an Injection List: 

Step Action

1 In the ABI PRISM® 310 Data Collection Software, select New from the File menu. 
The following box of icons is displayed.

2 Select Sequence Injection List.

3 Click the arrow in the Sample Sheet field to display a pop-up menu of Sample 
Sheets stored in the Sample Sheet folder and select a Sample Sheet.

4 The Injection List is automatically filled in with information from the selected Sample 
Sheet. 
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Making Multiple
Injections from One

Sample Tube

The default setting for the Injection List assumes that each sample will be injected 
once. If you prefer multiple injections, modify the Sample Name column so that the 
sample appears multiple times.

5 Select a module from the Module pop-up menu.

See “About Run Modules, Dye Set/Primer, and Matrix Files” on page 2-42 if you 
need help selecting the correct file.

6 You can turn on automatic analysis and automatic printing by checking the boxes.

To create an Injection List: (continued)

Step Action

To make multiple injections from 1 sample tube: 

Step Action

1 In the example used here, the original Sample Sheet has been modified to inject 
the sample standard twice.

2 For the injection you are modifying, click the arrow next to the Tube & Sample 
Name. 
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Modifying an
Injection List

Adding Rows

The Injection List has the same number of rows as the Sample Sheet. To add rows, 
highlight a row, press Command-I, and a new row will be inserted above the 
highlighted row.

Changing Run Parameters

As you select a module file for each injection, the run parameters are filled in 
according to the values in the module. You can edit any parameter by clicking in the 
field and typing in the new value. Click another field or press Enter to save the change.

continued on next page

3 When a pop-up menu of the original sample list appears, select the sample you 
want to inject.

Figure 2-3 and Figure 2-4 show the sequence for editing the injection. Instead of 
injecting a sample in position A5 of the autosampler as the third injection, sample 
standard in position A3 will be the third injection.

Figure 2-3 Select Sample

Figure 2-4 Change Sample for Third Injection

To make multiple injections from 1 sample tube: (continued)

Step Action
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Changing the Order
of the Samples in a

Run

The default setting for the Injection List assumes that each sample will be injected in 
the order listed in the Sample Sheet. If you prefer a different injection order, modify the 
Sample Name column.
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Running and Monitoring Samples

Testing the Capillary
Window

Run a test to ensure that the capillary window is clean and positioned correctly before 
running your samples:

Starting the Run Click the Run button in the Injection List to start the run. 

Note If you did not preheat the instrument as suggested under “Preheating the Heat Plate” 
on page 2-17, it can take up to 25 minutes for the instrument to heat to 50 °C.

Monitoring the Run During the run, you can monitor the run and your samples four ways. From the 
Window menu, select one of the following:

Figure 2-5 Status

Step Action

1 Insert a line into the Injection List before the first sample.

See “Modifying an Injection List” on page 2-51 for instructions, if necessary.

2 Set the module to Test CCD 4-Color.

3 Change the collection time from 5 minutes to 1 minute.

4 When the module runs, check the raw data for excessive noise. The ideal baseline 
falls at or below about 2068.

Use the following table to help determine whether the capillary is positioned 
correctly.

If... Then...

the baseline is too high remove the capillary and clean the 
capillary window with a lab wipe and 
dampened ethanol.

there is a single blue line at 8000 or at 
the bottom of the window

the capillary window is not positioned 
in the detector.
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Figure 2-6 Log

Figure 2-7 Raw Data

Figure 2-8 Electrophoresis History
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Creating the DNA Sequencing Matrix File from the Matrix Standards

Overview The matrix file contains the information necessary for software to correct the overlap 
of the dyes emission spectra on the virtual filter. Once a matrix file has been created, 
it can be used for subsequent runs performed:

� With the same kit

� On the same instrument

� Using the same:

– Run modules

– Set of dyes

– Polymer 

After running the matrix standards, use their sample files to generate a matrix file 
using ABI PRISM® DNA Sequencing Analysis Software.

Verifying the Raw
Data for the Matrix

Standards Run

Raw data of the matrix standards run can be viewed using the Data Utility program 
that accompanies the ABI PRISM® DNA Sequencing Analysis Software.

Generating a Matrix
File from Matrix

Standards

About Matrix Files

The matrix is made using ABI PRISM® DNA Sequencing Analysis Software. For more 
information on the steps provided here, see the ABI PRISM DNA Sequencing Analysis 
Software User’s Manual.

When you create matrix files, you will be asked for the name of the file containing data 
for C, data for G, etc. 

Put the correct data file for each matrix standard into the correct “box” in the Data 
Utility application. The example used here is for BigDye™ terminators, which use 
Virtual Filter E. The dyes for Virtual Filter E are entered in the Dye Primer Matrix 
boxes. If you make matrices for other filter sets, you will need to enter the appropriate 
dyes.

Step Action

1 Open the Data Utility program.

2 Under File, choose Open.

3 Search for the Run Folder containing the four sample files.

4 Click on the first sample. The corresponding windows open are Raw data, 
Analyzed, EPT, and Information.

Note The Analyzed window in Data Utilities and ABI PRISM® DNA Sequencing 
Analysis Software are not identical.

5 Check the current for the run. Typically, the range is 4–8 µA.

6 Check the location of the peaks. Peaks typically first appear about 1000 scans into 
the run. Verify that the baseline is stable.

7 Check the peak height. Peak height should be greater than 200.
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Filter Dyes

IMPORTANT You need to make all three matrices, even if you are only using one chemistry. 
T7 algorithms are used for analysis of Taq reactions, so T7 cannot be left blank.

Making a Dye Primer Matrix

Box
Dye Primer

Matrix Taq Terminator Matrix
T7 Terminator

Matrix

C… dR110 dROX dR6G

A… dR6G dR6G dTAMRA

G… dTAMRA dR110 dROX

T… dROX dTAMRA dR110

To make a dye primer matrix: 

Step Action

1 Set the analysis start point and the number of data points to analyze.

a. In the SABI PRISM® DNA Sequencing Analysis Software, examine the raw data 
for one of the matrix standard samples as shown below.

b. Select a starting point where there are no peaks and the baseline is flat.

c. Select a number of data points to analyze such that no peaks in the range are 
off-scale, i.e., above 4000 relative fluorescence units (RFU) and where the 
baseline at the end of the range is flat.

A typical number of data points is 1500.

2 Repeat step 1 for each matrix standard sample. Record the results for later use.

IMPORTANT The number of data points analyzed is the same for each matrix 
standard. Choose starting points for each sample such that all peaks are less than 
4000 RFU and where both the starting and ending points have flat baselines and no 
peaks.

3 Launch the Data Utility software.
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4 From the Utilities menu, choose Make Matrix…

The Make Matrix dialog box appears as shown below. Verify that the Dye Primer 
Matrix button at the lower left is selected.

5 Click on the box for each nucleotide base and enter the data file that corresponds to 
the matrix standard.

6 Enter the analysis start point for each matrix standard sample as determined in 
step 1 on page 2-56.

7 Click New File…

A dialog window appears as shown below. Name the file dRhod and save it in the 
ABI folder within the System folder.

To make a dye primer matrix: (continued)

Step Action
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Making the Taq Terminator Matrix

8 The Make Matrix dialog box should look like that shown below.

Note The numbers in the Start at… and Points… boxes below are typical 
values. Your numbers may vary.

9 a. Click OK.

The computer makes the matrix. When finished, a dialog window appears with the 
message “Make matrix successfully completed.”

b. Click OK.

10 If the computer is unable to make a matrix, examine the raw data again in the 
Sequencing Analysis software. If many peaks are off-scale, dilute the matrix 
standards and rerun them.

To make the Taq Terminator matrix: 

Step Action

1 In the Data Utility application, choose Make Matrix… from the Utilities menu.

The Make Matrix dialog box appears.

2 In the Make Matrix dialog box, click the Taq Terminator Matrix button at the lower 
left.

3 Click on the box for each nucleotide base and enter the data file that corresponds 
to the matrix standard.

4 Enter the same numbers for each matrix standard sample in the Start at… and 
Points… boxes as for the Dye Primer Matrix.

5 Click Update File…

A dialog window appears.

To make a dye primer matrix: (continued)

Step Action
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Making the T7 Terminator Matrix

6 Choose dRhod from the ABI folder within the System folder and click Save.

The Make Matrix dialog box should look like that shown below.

7 a. Click OK.

The computer makes the matrix. When finished, a dialog window appears with the 
message “Make matrix successfully completed.”

b. Click OK.

To make the T7 Terminator matrix: 

Step Action

1 In the Data Utility application, choose Make Matrix… from the Utilities menu.

The Make Matrix dialog box appears.

2 In the Make Matrix dialog box, click the T7 Terminator Matrix button at the lower 
left.

3 Click on the box for each nucleotide base and enter the data file that corresponds 
to the matrix standard.

4 Enter the same numbers for each matrix standard sample in the Start at… and 
Points… boxes as for the Dye Primer Matrix and Taq Terminator Matrix.

5 Click Update File…

A dialog window appears.

To make the Taq Terminator matrix: (continued)

Step Action
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Checking Matrix
Quality

What to Review in the Matrix

Check the quality of the matrix by reviewing the:

� Raw data

� Values in the Copy Matrix window

� Analyzed data of the matrix run

To check the raw data, examine the electropherogram of the raw data. 

The matrix standards should display the following colors:,

6 Choose dRhod from the ABI folder within the System folder and click Save.

The Make Matrix dialog box should look like that shown below.

7 a. Click OK.

The computer makes the matrix. When finished, a dialog window appears with the 
message “Make matrix successfully completed.”

b. Click OK.

To make the T7 Terminator matrix: (continued)

Step Action

Matrix Standard Color in Raw Data

dR110 blue

dR6G green

dTAMRA black

dROX red
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Checking the Copy Matrix Window

Checking Matrix Quality

To check the Copy Matrix window: 

Step Action

1 From the Utilities menu in ABI PRISM® DNA Sequencing Analysis Software, choose 
Copy Matrix…

2 Under Source, select Instrument file and choose the matrix file from the ABI folder 
within the System folder.

3 Make sure that all three boxes have numbers in them. The numbers on the diagonal 
(Blue against Blue, Green against Green, etc.) must all be 1.00. The numbers off 
the diagonal are less than 1.00. 

An exception is Virtual Filter C, where Green under Blue is sometimes more than 
1.00. This is acceptable.

If the file is not correct, then repeat the matrix-making procedure starting with 
“Making a Dye Primer Matrix” on page 2-56.

Note The corresponding numbers in the boxes for all three matrices will be the 
same.

4 Click Cancel.

5 Restart the Sequencing Analysis software and use the matrix file, also known as 
the Instrument file, to analyze your sequencing data.

To check matrix quality:

Step Action

1 Open the Sample Manager window in the ABI PRISM® DNA Sequencing Analysis 
Software.

2 Click the Add Files button.

3 Select the sample files for each standard in the directory dialog box and choose 
Done.

4 The P and F checkboxes should not be checked. Bring the Instrument File column 
of the Sample Manager window into view by scrolling with the horizontal scrollbar.

5 Click Start.

6 To check the electropherograms, double-click on each file in the Electropherogram 
view.

7 If… Then…

each peak is one color with the other colors flat under it: the matrix is good.

The other colors are not flat under the peaks the matrix is poor.
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8 If the… Then…

matrix is good Save the matrix file to 
the ABI folder.

matrix is poor Re-analyze the matrix 
run. If this does not 
improve the matrix data, 
run new matrix 
standards.

To check matrix quality:

Step Action
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Creating a DNA Sequencing Matrix from a Sample 

Overview It is not necessary to use matrix standards to generate a sequencing matrix. Any 
sample that yields good raw data can be used to create a matrix file. 

The Sample Standard is used to make a matrix in the procedures below. The method 
can be used with other types of samples.

Making Copies of
the Sample File for

the Sample Standard

Make three copies of the sample file for the Sample Standard run:

Verifying Raw Data
for the Sample

Standard Matrix
Run

Raw data of the Sample Standard run can be viewed using the Data Utility program 
that accompanies the ABI PRISM® DNA Sequencing Analysis Software.

continued on next page

Step Action

1 Click on the sample folder for the Sample Standard run.

2 Choose Duplicate from the File menu. A duplicate file is created and named “File 
name copy”.

3 Repeat the above steps twice more to create “File name copy-2” “File name 
copy-3”.

Step Action

1 Open the Data Utilities program.

2 Under File, choose Open.

3 Search for the Run Folder containing the four sample files (one original and 3 
duplicates).

4 Click on the first sample. The corresponding windows open are Raw data, 
Analyzed, EPT, and Information.

Note The Analyzed window in Data Utilities and ABI PRISM® DNA Sequencing 
Analysis Software are not identical.

5 Verify that the baseline is stable, and peak heights are on scale in the raw data.

6 Choose a scan point (e.g., 2000) that occurs after the first peaks, though still in the 
beginning of the run.
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Generating the
Matrix File Using a

Sample

Create the matrix file by following this procedure:

Note If you get an error message, and the software will not make a matrix, you may have 
designated the wrong files, or used the terminator standards for a primer matrix, etc. It is 
possible also that the signal is too weak to make a matrix, but this happens rarely. If you don't 
get adequate signal to make a matrix, you will have to rerun the standard. 

continued on next page

Step Action

1 Under Data Utilities, select Make Matrix.

2 A dialog box appears.

a. Click the C button, then choose the “File Name” sample file (the original 
sample file for the Sample Standard run) in the Run Folder.

b. Click open.

c. Do the same for the A (File Name copy”), G (File Name copy-2”), and T (File 
Name copy-3”) buttons.

3 Enter the starting point for each file. The Start At point should be after the first 
peaks, though still in the beginning of the run. Modify the default setting of 2000 if 
necessary.

Modify the Points value if necessary. This is the number of points after the start 
point to be analyzed. Good data points include a single color with three clean peaks 
that do not have overlapping dyes. Set the Points value so that the end point falls 
after these three peaks.

4 Click the New File button and name the new matrix file. Choose a name that 
reflects the chemistry and run conditions.

5 Locate and open the ABI Folder in the System Folder and save the matrix file.

6 Enter the last three numbers of the instrument serial number. 

Comment: seq matrix created.

7 Click the button for the appropriate type of sequencing chemistry and click OK. The 
message “Make matrix successfully completed” appears.
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Checking Matrix
Quality

Check the quality of the matrix by:

� Reviewing the values in the Matrix Values window

� Reviewing the analyzed data of the matrix run

Review the matrix values in the Matrix Values window as follows:

Review the analyzed matrix data as follows:

Analyzing The Data

Overview ABI PRISM® DNA Sequencing Analysis Software automatically analyzes the samples 
when the run finishes if the automatic analyze checkbox on the Sample Sheet is 
checked.

See the ABI PRISM DNA Sequencing Analysis software User’s Manual for more 
information.

Step Action

1 Under Utilities, open the Copy Matrix dialog box.

2 Choose Instrument File.

3 From the ABI Folder, choose the matrix file that was just created.

4 Click Open to view the matrix file values. The numbers on the diagonal (Blue 
against Blue, Green against Green, etc.) must all be 1.00. The numbers off the 
diagonal are less than 1.00. 

5 Click Cancel to close the matrix file values without altering them.

Step Action

1 Open the matrix standard sample file in the Data Utility program.

2 Examine the electropherogram in the Analyzed window.

3 If… Then the matrix is…

each peak is one color with the other 
colors flat under it

good.

the other colors are not flat under the 
peaks

poor.

4 If the… Then…

matrix is good save the matrix file to the ABI folder.

matrix is poor re-analyze the matrix run. If this does 
not improve the matrix data, run new 
matrix standards.
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Preparing the Syringes for a DNA Sequencing Run with DNA Sequencing 
Polymer (DSP)

Overview To set up a run with DNA Sequencing Polymer (DSP), rather than POP-6 polymer, you 
will need to install both the 5-mL plastic syringe containing the DNA Sequencing 
Polymer and a 250-µL glass syringe. Then the DSP must be transferred from the 
plastic syringe to the glass syringe before beginning the run.

If your experiment requires DNA Sequencing Polymer, follow the procedures below to 
set up the syringes.

Cleaning and
Preparing the

Syringe for Use

DNA Sequencing Polymer requires a 250-µL syringe. Prepare it as follows:

Methods of Filling
the Glass Syringe

The DNA Sequencing Polymer is packaged in a 5-mL plastic syringe. The polymer 
must be transferred to the 250-µL glass syringe.

There are two methods for transferring DNA Sequencing Polymer from the plastic 
syringe to the glass syringe:

� Using the ABI PRISM® 310 Data Collection Software, which will prompt you to 
perform some manual steps

� Manually

Filling the Glass
Syringe Manually

Installing the Plastic Syringe

Homing the Glass Syringe

Step Action

1 Rinse the glass syringe with distilled water. Remove excess water but do not dry 
completely.

IMPORTANT Excessive wear occurs to the Teflon fitting of the plunger if it is 
completely dry.

2 Inspect the syringe for the ferrule and two o-rings.

3 Install the syringe.

Step Action

1 Remove DNA Sequencing Polymer from the refrigerator and equilibrate to room 
temperature. This takes about 1 hour.

2 Remove the cap from the room temperature DNA Sequencing Polymer.

3 Put the plastic syringe through the syringe guide. It goes in the plastic luer fitting in 
the hole to your left as you face the 310 Genetic Analyzer.

4 Partially screw it onto the luer fitting. Do not tighten it yet.

Step Action

1 Open the ABI PRISM® 310 Data Collection Software.

2 Open the Manual Control window.
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Priming the Pump Block

Always clean the pump block before filling it with fresh polymer.

Priming the Glass Syringe

If the glass syringe is new, it may be difficult to prime manually. The plunger of the 
glass syringe must be lubricated with water to minimize wear, and this will help the 
plunger move when priming the syringe. 

IMPORTANT Do not try to prime the glass syringe by pulling its plunger to draw sequencing 
polymer through the pump block. This creates air bubbles.

3 Select Syringe Home from the Function pop-up menu, and click Execute.

4 Install the glass syringe.

Step Action

1 Select Buffer Valve Open from the Function pop-up menu in Manual Control, then 
click Execute.

2 Turn the plastic syringe to tighten its connection to the luer fitting, and open the 
valve below the luer fitting 3/4 turn.

3 Push the plunger of the plastic syringe to fill the channel to the buffer reservoir with 
polymer solution. Stop when the channel is free of air bubbles.

4 Select Buffer Valve Close from the Function pop-up menu, then click Execute.

5 Open the valve to the waste vial.

6 Push the plunger of the plastic syringe until the channel to waste is filled.

7 Close the valve to the waste vial.

Step Action

1 Push the plunger of the plastic syringe until 50-µL of sequencing polymer enters the 
glass syringe.

If the glass syringe plunger resists moving, gently lift it while pressing the plastic 
syringe plunger.

2 Open the valve to the waste vial, then push the plunger of the glass syringe.

Note You may need to exert a small amount of pressure on the plastic syringe to 
prevent polymer from moving up the channel toward the plastic syringe.

3 Repeat steps 1 and 2 until the glass syringe is free of air bubbles.

Step Action
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Filling the Glass Syringe

Fill the glass syringe with only enough polymer to perform the planned sequencing 
analyses. Two hundred microliters is adequate for 40–50 runs.

Setting Up the Syringe Drive

Replacing the Plastic Syringe

Filling the Glass
Syringe Using the

310 Data Collection
Software

Installing the Plastic Syringe

Step Action

1 Push the plunger of the plastic syringe to fill the glass syringe.

2 Close the valve under the luer fitting to the plastic syringe.

Step Action

1 Move the syringe drive toggle to the right.

2 Select Syringe Down from the Function menu.

3 Enter the value 230 steps for a syringe filled with 200-µL of polymer (use a larger 
value for smaller volumes). Click Execute to move the syringe drive toggle close to 
the end of the plunger.

4 Enter smaller step values (for example, 20 steps) and click Execute until the syringe 
drive toggle is 1–2 mm from the top of the glass syringe.

Note If the syringe drive travels too far without encountering resistance, the 
instrument assumes that the cause is a polymer leak. An alert message about the 
leak will be posted to the Macintosh screen. Put the syringe drive as close as 
possible to the syringe plunger to avoid false warnings about leaks.

Step Action

1 Remove the plastic syringe containing polymer, cap it, and store it in the 
refrigerator.

2 Fill the 5-mL plastic syringe from the Basic Installation Kit with water. 

3 Put the plastic syringe filled with water through the syringe guide. 

It goes in the hole to your left as you face the 310 Genetic Analyzer.

4 Screw it onto the luer fitting.

Step Action

1 Remove DNA Sequencing Polymer from the refrigerator and equilibrate to room 
temperature. 

This takes about one hour.

2 Remove the cap from the room-temperature DNA Sequencing Polymer.

3 Put the plastic syringe through the syringe guide. 

It goes in the hole to your left as you face the 310 Genetic Analyzer.

4 Partially screw it onto the luer fitting. 

Do not tighten it yet.
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How to Use the Gel Pump Fill Window

Step Action

1 Open the 310 Data Collection software.

2 Open the Instrument menu and choose Gel Pump Fill. The Gel Pump Fill window 
appears. Click Run. The syringe homes and the Buffer Valve opens.

3 When the Gel Pump Fill window directs you to attach the plastic syringe, loosen the 
valve under the luer fitting, and tighten the plastic syringe on the luer fitting Do not 
click Done yet.

4 Manually push the syringe plunger to fill the loosened valve and luer fitting with 
polymer.

5 Close the valve under the luer fitting.

6 Move the syringe drive toggle to the left.

7 Click Done in the Gel Pump Fill window. The buffer reservoir valve closes and the 
syringe drive moves down.

Note Pressing the Gel Pump button is equivalent to clicking Done in the Gel 
Pump Fill window. Press and hold the button until the computer responds.
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Priming the Pump Block Using Gel Pump Fill

Step Action

1 Open the valve under the plastic syringe luer fitting 3/4 turn, then click Done in the 
Gel Pump Fill window (see Figure 2-9). 

The instrument pumps sequencing polymer into the block, filling the passage 
between the plastic syringe and the buffer reservoir.

Figure 2-9 Gel Pump Fill window–Open Valve

2 When this message appears, check the pump block channel.

3 If there is… Then click…

air in the pump block channel  Yes.

no air in the pump block channel No.

4 When No is selected, polymer is pumped to the glass syringe.
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Priming the Glass Syringe Using Gel Pump Fill

Step Action

1 Open the valve to the waste vial, push the polymer and air out of the glass syringe, 
close the valve to the waste vial, and click Done in the Gel Pump Fill window (see 
Figure 2-10).

The instrument pumps sequencing polymer into the block, filling the passage 
between the plastic and glass syringe.

Figure 2-10 Gel Pump Fill window–Prime the Glass Syringe

2 When this message appears, check the pump block channel.

 

3 If there is… Then click…

air in the pump block channel Yes.

no air in the pump block channel No.

4 When No is selected, about 200-µL of polymer is pumped into the glass syringe.
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Setting Up the Syringe Drive Using Gel Pump Fill

Step Action

1 Move the syringe drive toggle to the right, close the valve under the plastic syringe, 
and click Done. The syringe drive moves to the top of the plunger.

2 Make a final inspection for air bubbles, and click Done.
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Replacing the Plastic Syringe

The polymer in the pump block passageways must not dry out. Install a plastic syringe 
filled with water to prevent dried polymer from plugging the channel leading to the 
plastic syringe luer fitting.

Step Action

1 Remove the plastic syringe containing polymer, cap it, and store it in the 
refrigerator.

2 Fill the 5-mL plastic syringe from the Basic Installation Kit with water. 

3 Put the plastic syringe filled with through the syringe guide. It goes in the hole to 
your left as you face the 310 Genetic Analyzer.

4 Screw it onto the luer fitting.
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How to Fill the Capillary with DNA Sequencing Polymer (DSP)

Filling the Capillary The Seq Fill Capillary module is used to fill the capillary with polymer. When you start 
the module, the instrument pumps polymer to the capillary for 5 seconds, pauses for 
10 seconds, and then fills the capillary for 10 minutes.

If you note anomalies early in the pumping operation, pause or cancel the run during 
the programmed 10-second delay.

Initially, the glass syringe plunger should rapidly move 1–2 mm before stopping. If the 
plunger moves rapidly for a greater distance, there may be a leak.

During the 10-minute fill, pumping automatically stops if the instrument detects 
movement of the plunger corresponding to 25-µL or more of polymer. Check for leaks 
if the fill stops early.

To fill the capillary:

How to Store the DNA Sequencing Polymer (DSP)

Storing DSP Remove, cap and refrigerate the plastic syringe of sequencing polymer at 5–10 °C to 
extend the life of the polymer.

The sequencing polymer contains urea and will slowly increase in conductivity as the 
urea decomposes. Polymer left at room temperature is good for 1 week. Each 
sequencing analysis uses 4–5-µL of polymer, so fill the glass syringe appropriately.

Step Action

1 Open the 310 Data Collection software and the Manual Control window.

2 Press the Tray button. The autosampler tray moves forward.

3 Open the instrument doors, and place a small tube containing 0.5 mL water in tube 
position 6 in the front of the autosampler.

4 Press the Tray button again to move the autosampler back to its original position.

5 Select Seq Fill Capillary from the Module pop-up menu on the Manual Control 
screen.

6 Note the position of the end of the glass syringe plunger and write it down.

7 Click Start.

8 After the module has run, again note the position of the plunger, and subtract it from 
the initial value. The pump should consume 4—7-µL of polymer per 10-minute fill. 
Check for leaks if more than 7-µL of polymer was consumed.
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Setting Up the Reagents for Runs with DSP

Preparing Reagents ! WARNING ! CHEMICAL HAZARD. Urea is a potential mutagen. Dangers cited in 
toxicity studies show reproductive and tumorigenic effects. Urea can cause irritation to 
the skin, eyes, and respiratory tract. Avoid inhalation and contact with skin, eyes and 
clothing. Always work in a fume hood. Obtain a copy of the MSDS from the manufacturer. 
Wear appropriate protective eyewear, clothing, and gloves. 

CHEMICAL HAZARD. Some chemicals used with this instrument are potentially 
hazardous. Warnings are prominently displayed on the bottle labels of all hazardous 
chemicals. Material Safety Data Sheets (MSDSs) are provided by the manufacturer and 
contain information about physical characteristics, hazards, precautions, first aid, spill 
cleanup, and disposal procedures. Please familiarize yourself with the information 
contained in these documents before attempting to operate the instrument or using 
hazardous reagents. Additional copies of the MSDSs for Applied Biosystems chemicals 
are available from Applied Biosystems at no cost.

Prepare the polymer and buffer:

Storing the Buffer Store electrophoresis buffer at 2–8 °C.

When to Replace
Reagents

Use the following table.

Step Action

1 Equilibrate DSP polymer to room temperature.

2 Dilute 5-mL of 10X Genetic Analyzer Buffer (without EDTA) to a 1X 
concentration (50-mL) with filter-sterilized, deionized water and 
bring to room temperature.

Reagent Replace

Cathode and Anode buffers Every week or every 200 runs.

Polymer Every week.

Water in the water vial and waste vial Before every set of runs.
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3
GeneScan Analysis 
Software Experiments 3
Overview

About This Chapter This chapter summarizes the steps for an experiment that is analyzed with 
GeneScan® Analysis Software and, as an example, explains in detail the steps for 
using the ABI PRISM® Fluorescent Genotyping Demonstration Kits A and B. 

To quickly start a GeneScan® Analysis Software run, see the Quick Reference Card at 
the front of the manual. 

For more detail about specific procedures, see Chapter 4, “Procedures for Operation.”

In This Chapter Topics in this chapter include the following:

Topics See page

About GeneScan Analysis 3-2

How to Switch Between DNA Sequencing and GeneScan 3-6

How to Set Up the Reagents 3-6

Preparing the 310 Genetic Analyzer for a GeneScan Run With POP-4 3-7

Performing PCR 3-14

About Run Modules, Analysis Parameters, Size Standard and Matrix Files 3-25

Denaturing and Loading the Samples 3-28

How to Prepare the Sample Sheet and Injection List 3-34

Running and Monitoring Samples 3-40

How to Create the GeneScan Matrix File 3-42

Analyzing The Data 3-45
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About GeneScan Analysis 

Type of Experiments There are many types of experiments that are analyzed using the 310 Genetic 
Analyzer and the GeneScan® Analysis Software. They all attempt to determine the 
size or relative quantity of DNA fragments. Applied Biosystems sells a number of kits 
for applications that are analyzed with the GeneScan® Analysis Software. Contact 
your sales representative for information.

About Using the
Fluorescent

Demonstration Kits

The Fluorescent Genotyping Demonstration Kits are typically used to show that the 
310 Genetic Analyzer is properly sizing fluorescently labeled PCR fragments. Use the 
kits to become familiar with sizing DNA fragments on the 310 Genetic Analyzer or to 
troubleshoot the process.

For Kit A, you amplify the PCR products; Kit B provides pre-amplified products. 

continued on next page

Applications Experiments

Microsatellite Analysis � Fluorescent genotyping for genetic 
linkage studies

� Paternity identification

� Forensic identification of samples

� Determination of loss of heterozygosity

� Microsatellite instability

� Trisomy analysis

Amplified Fragment Length Polymorphism 
(AFLP™) Analysis

� Gene mapping using AFLP

Gene Expression Profiling � Differential display

� Quantitative expression of gene 
products 

� RNase protection assays

Mutation Detection � Single strand conformation 
polymorphisms (SSCP)

� Heteroduplex mobility assays (HMA)

� Mismatch cleavage

� Oligonucleotide ligation assays (OLA)

� Allele-specific PCR
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Summary of
Procedures

To perform a GeneScan® Analysis Software experiment with pooled DNA using the 
ABI PRISM® 310 Genetic Analyzer, you will need to:

� Prepare the 310 Genetic Analyzerr by:

– Preparing the reagents

– Cleaning the pump block

– Installing the capillary

– Cleaning and installing the syringe

– Cleaning the electrode

– Recalibrating the autosampler if:

– The electrode is removed, replaced or cleaned

– The capillary is replaced

– Priming the pump block

– Loading buffers

– Preheating the instrument

� Prepare matrix standards (if necessary)

� Amplify and denature (if necessary) the samples

� Load the samples

� Start the run by:

– Selecting or creating a Sample Sheet

– Filling out an Injection List

Materials Required To work through the example provided in this chapter, you will need:

! WARNING ! CHEMICAL HAZARD. Before handling the chemical reagents needed 
for the Fluorescent Genotyping Demonstration Kits, read the safety warnings on the 
reagent bottles and in the manufacturers’ Material Safety Data Sheets (MSDS). Always 
wear protective equipment (lab coat, safety glasses, and chemical-resistant gloves) 
when handling chemicals. Dispose of waste in accordance with all local, state, and 
federal health and environmental regulations and laws.

Item Source

Fluorescent Genotyping Demonstration Kits 
A or B

Applied Biosystems P/N 402246 or 
P/N 402247

Fluorescent Amidite Matrix Standards Applied Biosystems P/N 401546

Deionized formamide Major laboratory suppliers (MLS)

Filter-sterilized, deionized water MLS

Disposable, non-powdered, 
chemical-resistant gloves

MLS

GeneScan–350 [TAMRA] Size Standard 
(required only if using Kit B)

Applied Biosystems P/N 401736

A small-volume, calibrated pipette and tips. 
We recommend the Gilson Pipetman

Rainin Instruments P/N P10

ABI PRISM® 310 10X Genetic Analyzer 
Buffer with EDTA 

Applied Biosystems P/N 402824
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You will also need one sample tray and related accessories as listed in Table 3-1 or 
Table 3-2 on page 3-5:

One 1.0-mL glass syringe (or one 2.5-mL 
glass syringe)

Applied Biosystems P/N 604418

Performance Optimized Polymer, 4% 
(POP-4™)

Applied Biosystems P/N 402838

Two 4.0-mL Genetic Analyzer Buffer Vials 
with cap adapters

Applied Biosystems P/N 401955

Two septa for the 4.0-mL buffer vials Applied Biosystems P/N 401956

ABI PRISM® 310 Genetic Analyzer Capillary, 
47-cm, 50-µ i.d., labeled with a green marka

Applied Biosystems P/N 402839

ABI PRISM GeneScan Chemistry Guide and 
GeneScan Chemistry Guide Update

Applied Biosystems P/N 903560 and 
P/N 904580

Microcentrifuge or centrifuge adapted for 
spinning microtiter plates (96-well tray)

MLS

One of the following thermal cyclers from Applied Biosystems:

� GeneAmp® PCR System 9700

� GeneAmp® PCR System 9600

� GeneAmp® PCR System 2400

� DNA Thermal Cycler 480

Note If the GeneAmp® PCR System 2400 or DNA Thermal Cycler 480 will be used to 
denature your samples, you will need the appropriate materials (i.e., tubes, tray, etc.) for 
these thermal cyclers. You will also be required to transfer the samples to either the 96-or 
48-well sample tray to load the samples on the ABI PRISM® 310.

a. Do not use GeneScan capillaries labeled with a yellow mark (P/N 401823) with POP-4™ polymer. 
Resolution will be unsatisfactory if these capillaries are used with POP-4 polymer.

Table 3-1 96-well sample tray and accessories

Part Quantity Part Number

MicroAmp® Tray/Retainer Set 1 403081 

0.2-mL MicroAmp® Reaction Tubes 2—10* N801-0580

MicroAmp® Base 1 N801-0531

MicroAmp® Full Plate Cover 1 N801-0550

Genetic Analyzer Septa Strips 1 P/N 402059

Genetic Analyzer Retainer Clips 1 P/N 402866

* Two tubes for Kit A; four tubes for Kit B; four tubes for matrix standard samples

Item Source
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Materials Required
for PCR

With the GeneAmp® 9700, 9600 or 2400

� One MicroAmp® tray and retainer, 96-well or 24-well

� 14 MicroAmp reaction tubes and caps

� One MicroAmp base, 96-well, or 24-well

� Microcentrifuge adapted for spinning microtiter plates

With the 877

� Six 1.5-mL capless tubes (Sarstedt P/N 72.607)

� Two 96-well MicroAmp Tray/Retainer Sets filled with tubes

� Two microcentrifuge tubes

� ABI PRISM 877 Integrated Thermal Cycler User’s Manual (P/N 904414)

� Bleach, 30 mL sodium hypochlorite solution diluted to 2% in available chlorine (we 
recommend JT Baker sodium hypochlorite solution which may be 5–7% in 
available chlorine, P/N 9416-03)

� TrIS, 30-mL (0.01% Tween20 and 50 mM Tris [pH 8.0])

� TE buffer (10 mM Tris-HCl [pH 8.0], 0.1 mM EDTA)

With the GeneAmp 480

� 14 GeneAmp® Thin-Walled Reaction Tubes with flat caps, 0.5-mL 
(P/N N801-0737)

� Mineral oil, molecular biology grade

Software Required � ABI PRISM® 310 Firmware, version 1.0.2 or higher

� ABI PRISM® 310 Module GS STR POP4 (1.0-mL) C

� ABI PRISM® 310 Collection Software, v 1.0.2 or higher

� ABI PRISM® GeneScan® Analysis Software, v 2.0.2 or higher

Table 3-2 48-well sample tray and accessories

Part Quantity Part Number

48-well Sample Tray (4.0-mL) 1 401955

0.5-mL Samples Tubes 2—10* 401957

Septa for 0.5-mL Sample Tubes 2—10* 401956

1.5-mL Eppendorf tube 1 —

* Two tubes for Kit A; four tubes for Kit B; four tubes for matrix standard samples
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How to Switch Between DNA Sequencing and GeneScan

Switching Between
Applications

If the ABI PRISM® 310 was set up for experiments to be analyzed with the ABI PRISM® 
DNA Sequencing Analysis Software, then before following the instructions in this 
chapter to prepare an experiment that will be analyzed with the GeneScan® Analysis 
Software, it will be necessary to do the following.

How to Set Up the Reagents

Preparing Reagents ! WARNING ! CHEMICAL HAZARD. Urea is a potential mutagen. Dangers cited in 
toxicity studies show reproductive and tumorigenic effects. Urea can cause irritation to 
the skin, eyes, and respiratory tract. Avoid inhalation and contact with skin, eyes and 
clothing. Always work in a fume hood. Obtain a copy of the MSDS from the manufacturer. 
Wear appropriate protective eyewear, clothing, and gloves. 

CHEMICAL HAZARD. Some chemicals used with this instrument are potentially 
hazardous. Warnings are prominently displayed on the bottle labels of all hazardous 
chemicals. Material Safety Data Sheets (MSDSs) are provided by the manufacturer and 
contain information about physical characteristics, hazards, precautions, first aid, spill 
cleanup, and disposal procedures. Please familiarize yourself with the information 
contained in these documents before attempting to operate the instrument or using 
hazardous reagents. Additional copies of the MSDSs for Applied Biosystems chemicals 
are available from Applied Biosystems at no cost.

Preparing the Polymer and Buffer

Storing the Buffer Store electrophoresis buffer at 2–8°C. The 1X buffer can be stored for 2 weeks.

When to Replace
Reagents

Use the following table.

Take this action  See page

Remove the 2.5-mL glass syringe (if present) or clean out the 1.0-mL syringe. 4-18

Remove the capillary and store it. 4-15

Clean the pump block. 4-8

Step Action

1 Equilibrate polymer to room temperature, then mix thoroughly by inversion.

2 Allow the polymer to sit for at least 5 minutes after mixing.

3 Dilute 5-mL of 10X Genetic Analyzer Buffer with EDTA to a 1X concentration 
(50-mL) with filter-sterilized, deionized water and bring to room temperature.

Reagent Replace

Cathode and Anode buffers Every week or every 200 runs.

Polymer Every week.

Water in the water vial and waste vial Before every set of runs.
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Preparing the 310 Genetic Analyzer for a GeneScan Run With POP-4

About These
Procedures

To work through the example in this chapter using a Fluorescent Genotyping 
Demonstration Kit and POP-4 polymer, or for any experiment requiring POP-4 
polymer, set up your instrument as detailed below.

These procedures can also be found in Chapter 4, “Procedures for Operation.” Some 
are explained there with more detail and with illustrations. If you have a question about 
a procedure, see Chapter 4.

Cleaning the Pump
Block

IMPORTANT Do not expose the pump block to any organic solvents.

Cleaning and
Preparing the

Syringe for Use

Use the 1.0-mL syringe with Performance Optimized Polymers.

Cleaning the Syringe

Step Action

1 Remove the pump block from the instrument.

2 Open all valves and ports on the pump block.

3 Hold the pump block under warm running water to thoroughly rinse it.

4 Force warm water through the channels with the 5-cc plastic syringe provided in the 
Basic Installation Kit. Direct the flow of water through each channel in turn by 
sealing channel openings with plugs provided in the Basic Installation Kit. Rinse 
each channel five times.

Note If a 30-cc syringe is available, rinse each channel with it once. This can be 
more convenient than rinsing five times with a 5-cc syringe.

5 Rinse the valves with warm water. Soak valves that are coated with dried polymer.

6 Visually inspect the channels for dried polymer, which looks like white residue. 
Wash the channels until the polymer is gone.

7 Rinse the block and its channels with distilled, deionized water.

8 Remove residual water from the pump block and fittings to ensure that the running 
polymer is not diluted. Force air through the channels, using the plastic syringe or 
canned compressed air, until the channels are dry.

9 Replace the pump block and buffer reservoir.

To clean the syringe: 

Step Action

1 Rinse the syringe with distilled water. Remove excess water, but do not dry 
completely.

IMPORTANT Excessive wear occurs to the Teflon fitting of the plunger if it is 
completely dry.

2 Allow the polymer to equilibrate to room temperature before loading it into the 
syringe.

IMPORTANT Precipitate present when the bottle is removed from cold storage 
should go back into solution at room temperature. Do not use the polymer until the 
precipitate dissolves.

3 Mix the polymer thoroughly by inversion before use. Let it settle for at least 5 
minutes before use.
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Loading Polymer

4 Draw a small amount of polymer solution (0.20-mL maximum) into the syringe. Pull 
plunger up to the 0.60-mL marker after the polymer solution is added.

! WARNING ! Gloves and eye protection should be worn when handling 
polymer.

5 Invert the syringe gently five or six times to coat the walls with polymer and discard 
this polymer solution. This ensures that the running polymer is not diluted when 
added to the syringe.

6 For new, never-before-used syringes, perform this entire procedure twice to prevent 
air bubbles from sticking to the syringe walls.

Step Action

1 Allow the polymer to equilibrate to room temperature before loading it into the 
syringe.

2 Mix the polymer thoroughly by inversion before use. Let it settle for at least 
5 minutes before use.

3 Fill the syringe manually with a maximum of 0.5-mL of polymer.

Note Do not use polymer that has been on the instrument for more than one 
week. Do not return unused polymer to the original bottle.

4 Remove all air bubbles by inverting syringe and pushing air bubbles out.

IMPORTANT To avoid loss of polymer, any bubbles near the plunger head 
must be removed.

5 Rinse the outside of the syringe with distilled water to remove any polymer on the 
outside of the syringe. Dry the outside of the syringe with a lint-free paper.

6 Move the syringe drive toggle to the left to attach the syringe to the pump block.

7 Place the syringe through the right-hand port of the plastic syringe guide plate, and 
screw the syringe into the pump block finger-tight.

8 Manually close and tighten the waste valve below the syringe and the luer valve to 
the left of the syringe.

To clean the syringe: (continued)

Step Action
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Setting Syringe Max Travel

Set the Syringe Max Travel once for each syringe. Record the value for each syringe 
(the calibration sticker on the door is a good place for this record) and input it in the 
Manual Control window when you install the syringe again.

To set Syringe Max Travel:

continued on next page

Step Action

1 Determine which version of Collection software is installed on your Macintosh® 
computer by clicking the Apple menu and selecting “About Collection Software.”

2 Use the following table to determine the next step:

3 Open the Manual Control window, select Syringe Home from the Function pop-up 
menu, and click Execute.

4 Select Syringe Max Travel in the Function pop-up menu. Note the displayed value, 
as you will enter it in the next step.

5 Select Syringe DOWN and enter the current Syringe Max Travel value. Click 
Execute.

6 After the syringe drive reaches the syringe plunger and stops moving, select Status 
from the Window menu.

7 Under the Injection pop-up window, read the number in the Gel Pump At window.

Subtract 15 from that number 

8 Select Syringe Max Travel in the Function pop-up menu of Manual Control, type the 
number you just calculated in step 7, and click Execute.

9 Record this value on the Calibration sticker on the left side door.

Note If you install a syringe of a different size, you must input the max travel 
value for that syringe size.

10 Select Syringe Up in the Function pop-up menu of Manual Control, enter 250 in the 
Value window, and click Execute.

If you have... Then...

v. 1.04 or later Collection software go to step 3.

v. 1.0.2 Collection software a. Open the Window menu. 

b. Under Preferences, select 
Sequence Injection List Defaults 
or GeneScan Injection List 
Defaults. 

c. Type 139115 in the Operator entry 
window and click OK. 

d. Re-launch the Collection software.
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Filling the Pump
Block

To fill the pump block channels with polymer:

Cleaning the
Electrode

To clean the electrode:

continued on next page

Step Action

1 Open the Manual Control window. Select Buffer Valve Close in the Function pop-up 
menu to close the pin valve at the anode buffer reservoir on the pump block.

2 Manually open the waste valve below the syringe.

3 Press the syringe plunger until a drop of polymer forms on the bottom of the waste 
valve. 

This removes the air bubbles at this valve site, and uses about 0.1-mL of polymer.

4 Manually close the waste valve.

5 Open the Manual Control menu and select Buffer Valve Open in the Function 
pop-up menu to open the pin valve at the anode buffer reservoir on the pump block.

6 Press the syringe plunger until polymer fills the polymer channel in the block.

This removes all of the air bubbles from the polymer channels, and should use 
about 0.1-mL of polymer.

IMPORTANT There should be no air bubbles in the pump block channels.

7 Select Buffer Valve Close in the Function pop-up menu.

8 Move the syringe drive toggle to the right to position it over the syringe plunger.

9 Select Syringe Down in the Function pop-up menu.

10 Select 50 step intervals and click Execute until the toggle makes contact with the 
syringe plunger.

Step Action

1 Open the 310 Data Collection software.

2 Press the Tray button on the 310 Genetic Analyzer to lower the autosampler and 
present the tray.

3  Wipe the electrode with lint-free paper that has been dampened with distilled, 
deionized water

4 Dry the electrode with fresh lint-free paper.

5 Press the Tray button to return the autosampler to its original position and immerse 
the capillary in buffer.

6 Recalibrate the autosampler after cleaning, trimming or replacing the electrode.
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Installing the
Capillary

Connecting the Capillary to the Pump Block 

Positioning the Capillary in the Detector

Positioning the Capillary Near the Electrode

Step Action

1 Remove the new capillary from the storage tube.

2 Clean the capillary window.

3 Open the door covering the heat plate.

4 Partially unscrew the capillary fitting on the right side of the pump block.

5 Partially screw the capillary fitting back into the pump block.

IMPORTANT Do not tighten the fitting at this point in the procedure, or the 
opening on its tip will be crushed. The capillary must be properly inserted through 
the fitting before you tighten it.

6 Thread one end of the capillary through the capillary fitting.

7 Adjust the end of the capillary so that it is positioned directly below the opening to 
the glass syringe.

The end of the capillary must protrude well beyond the opening at the tip of the 
capillary fitting. 

To avoid crushing the opening, be certain that you see the capillary in the pump 
block channel before proceeding to the next step.

8 Tighten the capillary fitting finger-tight to secure the capillary.

IMPORTANT The capillary will twist as the fitting is tightened. Leave the other 
end of the capillary free to twist, or the capillary will break.

Step Action

1 Open the laser detector door, and position the capillary in the vertical track of the 
detector.

Align the colored labelling mark on the capillary with the top edge of the detector 
plate and laser detector door.

2 Tape the capillary to the heat plate with thermal tape to secure the position of the 
capillary labelling mark relative to the detector plate.

3 Close the laser detector door to secure the position of the capillary window.

Step Action

1 Thread the capillary through the capillary hole in the electrode thumbscrew until it 
protrudes past the tip of the electrode by about 0.5 mm (maximum). 

2 Tape the capillary to the heat plate with thermal tape to secure the position of the 
capillary tip relative to the electrode. 

Tape the capillary just above the electrode thumbscrew and just above the detector 
door.

3 Close the door over the heat plate.

4 With the heat plate door closed, check that the capillary has not moved relative to 
the electrode.
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Resetting the Injection Counter

Calibrating the
Autosampler

Calibrate the autosampler as follows:

Loading Buffers Load the buffer as follows:

continued on next page

Step Action

1 Open the Instrument window and choose Change Capillary.

2 Click OK in the Reset window to set the injection counter to zero.

Step Action

1 Choose Autosampler Calibration from the Instrument menu of the Collection 
software. The Autosampler Calibration window appears.

2 Click Start and follow the directions that appear on the screen.

3  Move the autosampler using the arrow keys in the Autosampler Calibration window 
or the arrow keys on the Macintosh® computer keyboard.

Note Hold down the arrow keys to move the autosampler with larger steps. This 
is often useful for z calibration.

4 Align the calibration dot on the front of the tray platform with the capillary. 

Center the end of the capillary on the x, y-calibration point. 

Almost touch the z-calibration point with the end of the capillary.

5 Click Set to save the calibration value.

6 Repeat for the rear calibration point and click Set.

Step Action

1 Fill the anode buffer reservoir to the red line with 1X Genetic Analyzer Buffer with 
EDTA, and install it on the pump block.

2 Label one of the buffer vials as Buffer, and fill it to the line with 1X Genetic Analyzer 
with EDTA buffer. 

3 Cap the vial, insert the septum, and place it in position one on the Genetic Analyzer 
autosampler.

4 Label the other glass buffer vial as H2O, and fill it to the line with filter-sterilized, 
deionized water.

5 Cap the vial, insert the septum, and place it in position two on the Genetic Analyzer 
autosampler.

6 If the 1.5-mL Eppendorf tube has a lid attached, cut the lid off. Completely fill the 
tube with filter-sterilized, deionized water, and place it in position three on the 
Genetic Analyzer autosampler.
3-12 GeneScan Analysis Software Experiments



Preheating the Heat
Plate

This is optional. Preheating the heat plate can take up to 30 minutes. You can prepare 
the samples while the instrument preheats.

Step Action

1 Open the Window pull-down menu, and choose Manual Control. The Manual 
Control window is displayed.

2 Choose Temperature Set from the Function menu, and set the temperature to 60 °C 
in the Value window.

3 Click Execute. 

The instrument will preheat to 60 °C. 

While the instrument is preheating, you can prepare your samples.

The instrument doors must be closed. The safety interlock will prevent operation 
when the doors are open.
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Performing PCR

Overview Fluorescent Genotyping Demonstration Kit A, used in this chapter as an example, 
requires a procedure typical of most experiments that will be analyzed with the 
GeneScan® Analysis Software: performing a PCR amplification of the samples. 

Optimized PCR protocols for Kit A on Applied Biosystems thermal cyclers, including 
the GeneAmp® PCR Systems 9700, 9600, and 2400, ABI PRISM® 877 Integrated 
Thermal Cycler, and the DNA Thermal Cycler 480 are described in this section. If you 
use a thermal cycler not manufactured by Applied Biosystems, you may need to 
optimize thermal cycling conditions.

You must optimize thermal cycling conditions for other types of samples. 

Performing PCR
with the GeneAmp
PCR System 9700,

9600, or 2400

! WARNING ! Always follow proper laboratory procedures when working with the 
chemicals in the kit. Wear protective eyewear, gloves and a laboratory coat at all times.

Preparing the Reaction Tray

You will need the MicroAmp® base, reaction tray, retainer and reaction tubes for this 
procedure.

Step Action

1 If the MicroAmp® tray is fully assembled, disassemble it now.

2 Place the base on a flat surface.

3 Place the reaction tray in the base, so that the well numbered A1 is located in the 
upper left corner of the tray.

4 Place 14 reaction tubes in the tray. 

We recommend using a 2 x (6 + 1) array such as the one shown in Figure 3-1, 
which illustrates this array in a 96-well MicroAmp reaction tray.

Each row will contain a single DNA sample; each column will contain a single 
primer pair.

The tube placed at the end of each row will be used later to pool the PCR products.

5 Secure the retainer onto the tray and base.
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Figure 3-1 Recommended tube configuration for a 96-well tray

Loading the Reaction Tray

IMPORTANT To prevent cross-contamination of samples, change the pipette tip each time 
you load a different solution.

Refer to Figure 3-2 as you load the reaction tray:

Step Action

1 Thaw all components of Kit A on ice.

2 Pipette 9-µL Reagent Mix into the first six tubes in each row. 

Remember, the tube at the end of each row remains empty.

3 Referring to Figure 3-2 for the next three steps, add 3-µL of Control DNA 1347-02 to 
the first six tubes in Row A.

4 Add 3-µL of Control DNA 1347-10 to the first six tubes in Row B.

5 Take the following action:

Add 3-µL of each Primer Mix as follows:

� D12S83-[FAM] to both tubes in column 1

� D7S517-[FAM] to both tubes in column 2

� D2S391-[TET] to both tubes in column 3

� D13S171-[TET] to both tubes in column 4

� D1S220-[HEX] to both tubes in column 5

� D3S1266-[HEX] to both tubes in column 6

6 Cap all the tubes, making sure they are tightly sealed.

7 Spin or shake down the tray to collect solutions at the bottom of each tube.
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Performing PCR

To program the thermal cycler and start PCR:

continued on next page

Step Action

1 Program the thermal cycler using the conditions listed in Table 3-3.

2 Place the loaded tray into the thermal cycler. Make sure the tray is properly 
oriented.

3 Close and tighten the cover.

4 Start PCR.

5 When PCR is finished, proceed to page 3-22, “About Pooling PCR Products”.

Table 3-3 PCR conditions for GeneAmp® PCR System 9700, 9600, or 2400 

Repetitions of 
Each Cycle Cycle Conditions

1 95 °C for 12 minutes

10 Melt at 94 °C for 15 seconds
Anneal at 55 °C for 15 seconds
Extend at 72 °C for 30 seconds

20 Melt at 89 °C for 15 seconds
Anneal at 55 °C for 15 seconds
Extend at 72 °C for 30 seconds

1 Final Extension at 72 °C for 30 minutes

HOLD 4 °C (forever)

Figure 3-2 Control DNA and primer mix loading diagram for Kit A
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Performing PCR
with the DNA

Thermal Cycler 480
by GeneAmp

! WARNING ! Always follow proper laboratory procedures when working with the 
chemicals in the kit. Wear protective eyewear, gloves and a laboratory coat at all times.

Preparing the GeneAmp Reaction Tubes

To prepare the GeneAmp® reaction tubes:

Figure 3-3 Control DNA and primer mix loading diagram for Kit A

Loading the GeneAmp Reaction Tubes

Note To prevent cross-contamination of samples, change the pipette tip each time you load 
a different solution.

To load the GeneAmp® Reaction Tubes:

Step Action

1 Label 12 of the 14 reaction tubes with the control DNA and Primer Mix each will 
contain. 

Use Figure 3-3 on page 3-17 as a guide. 

The remaining two tubes will be used later to pool the PCR products.

2 Place the tubes on ice or in a tube rack in a 6 x 2 array.

Step Action

1 Thaw all the components of Kit A on ice.

2 Pipette 9-µL Reagent Mix into each tube.

3 Add 3-µL of Control DNA 1347-02 to the six tubes marked for this DNA.

4 Add 3-µL of Control DNA 1347-10 to the remaining six tubes.

5 Add 3-µL of the appropriate Primer Mix to each tube as shown in Figure 3-3.

6 Add two drops of mineral oil to each tube.

7 Cap all the tubes, making sure they are tightly sealed.

8 Spin or shake down the tubes to collect solutions at the bottom of the tubes.
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Performing PCR

To program the thermal cycler and start PCR:

Performing PCR
with the ABI PRISM

877 Integrated
Thermal Cycler

The ABI PRISM® 877 Integrated Thermal Cycler performs PCR and pools the reaction 
products in a single run. The software supplied with the ABI PRISM® 877 includes two 
notebooks designed as tutorials to be used with Kit A of the Fluorescent Genotyping 
Demonstration Kit. These notebooks are located in a folder called Tutorial Files, and 
are:

� PCR demo—designed for a 64-sample run

� 32-sample PCR demo—designed for a 32-sample run

Instructions for performing PCR using Kit A are listed below, and are also located in 
Chapter 2, “Getting Started”, of the ABI PRISM 877 Integrated Thermal Cycler User’s 
Manual.

Preparing the ABI PRISM 877 Integrated Thermal Cycler

! WARNING ! Always follow proper laboratory procedures when working with this 
kit. Wear protective eyewear, gloves and a laboratory coat at all times.

To prepare the thermal cycler:

Step Action

1 Program the thermal cycler using the conditions listed in Table 3-4 on page 3-18.

2 Load the tubes into the thermal cycler.

3 Close the cover.

4 Start PCR.

5 When PCR is finished, proceed to page 3-22, “About Pooling PCR Products”.

Table 3-4 PCR conditions for the DNA Thermal Cycler 480 

Repetitions of 
Each Cycle Cycle Conditions 

1 95 °C for 12 minutes

10 Melt at 94 °C for 45 seconds
Anneal at 55 °C for 1 minute
Extend at 72 °C for 1 minute

20 Melt at 89 °C for 1 minute
Anneal at 55 °C for 1 minute
Extend at 72 °C for 1 minute

1 Final Extension at 72 °C for 30 minutes

HOLD 4 °C (forever)

Step Action

1 After turning on the power to the instrument and Macintosh® computer, inspect the 
syringes for leaks.

2 Tighten the syringes into the Luer fittings, and adjust the set screws to finger 
tightness.

3 Thoroughly rinse and refill the small buffer (Tris) and bleach bottles on the work 
surface.

4 Thoroughly rinse and refill the external water and ethanol bottles.
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Opening and Printing the Load Map

To open and print the Load Map:

5 Empty and clean the 1.5-mL microtube in position AC4–1.

6 Inspect the plastic tubing routed into the diluent bottles. 

If necessary, tighten the tubing where it enters each bottle, and adjust the tubing so 
the ends are well below the surface of the diluents.

7 Check the fluid level in the external waste bottle. 

Empty the bottle if necessary to ensure adequate space is available for the waste 
from the next run.

Step Action

1 Open the ABI PRISM 877 folder, and double click the ABI PRISM 877 icon to launch 
the instrument control software.

2 Open the folder labeled “Tutorial Files”.

3 Take the following action:

4 Open the Chemistry pull-down menu and choose Run to display the Load Map 
(Figure 3-5 on page 3-20).

The following windows are displayed automatically before the Load Map:

� Checking

� Verify

� Save File As (displayed only if the Notebook has not already been saved)

� Build

5 If desired, click Print Details to print the Load Map.

Step Action

To run PCR on... Then...

64 samples open the file called “PCR demo” to 
display the PCR demo notebook 
(Figure 3-4 on page 3-20).

32 samples open the file called “32-sample PCR 
demo”.
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Figure 3-4 PCR Demo tutorial notebook

Figure 3-5 Load Map for the PCR Demo tutorial

Preparing the Cocktails and Control DNA

Instructions for preparing the cocktails and control DNA are also included in 
Chapter 3, “Preparing Chemistries”, of the ABI PRISM 877 Integrated Thermal Cycler 
User’s Manual.

D12S83-[FAM]

D7S517-[FAM]

D1S220-[HEX]

D3S1266-[HEX]

D2S391-[TET]

D13S171-[TET]

Position of Cocktails by 
Primer Mix Content

To prepare the cocktails and control DNA: 

Step Action

1 Thaw all components of Kit A on ice.

2 Prepare six cocktails, one primer mix plus reagent mix per cocktail, as shown in 
Table 3-5 below. 

Prepare each cocktail in a 1.5-mL capless tube.

3 Place the tubes with cocktails into the large tube holders in Cold Left Storage in the 
order shown on the Load Map in Figure 3-5 on page 3-20.

4 Transfer 175-µL of control DNA 1347-02 to a clean microcentrifuge tube.
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Executing the PCR Run

To load the thermal cycler and start the run:

5 Dilute the DNA by adding 350-µL of filter-sterilized, deionized water or TE buffer. 

Vortex briefly.

6 Transfer 175-µL of control DNA 1347-10 to a clean tube, and dilute the DNA by 
adding 350-µL of filter-sterilized, deionized water or TE Buffer. 

Vortex briefly.

7 Pipette 16-µL of diluted control DNA 1347-02 into each of the first 32 tubes in the 
MicroAmp tray in Cold Left Storage (rows one through four; tubes A through H).

8 Pipette 16-µL of diluted control DNA 1347-10 into each of the remaining 32 tubes in 
Cold Left Storage (rows five through eight; tubes A through H).

9 Spin or shake down the tray to collect solutions at the bottom of each tube.

10 Place the MicroAmp® tray with samples in Cold Left Storage. 

Place the MicroAmp® tray with empty tubes in Cold Right Storage.

Step Action

1 Double check your instrument set up, and the placement of samples and reagents 
on work surface.

2 Check all liquids. 

Liquids should be at the bottom of the sample and reagent tubes, and there should 
be no bubbles in the tubes.

Centrifuge reagents and samples if necessary.

3 Check that the aluminum cold storage blocks and microtiter trays are properly 
seated.

4 Close the lids on both cold storage blocks. 

The lids should lie flat.

5 Close the instrument door, and click Run on the Load Map to start the PCR run. 

6 Watch for reagent delivery to begin. 

This should occur approximately 15 minutes after the run starts. The run will take 
approximately five hours.

To prepare the cocktails and control DNA: (continued)

Step Action
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Removing the Pooled PCR Products and Cleaning Up

To remove the pooled PCR products and clean up:

About Pooling PCR
Products

After performing PCR on a thermal cycler (other than the ABI PRISM® 877 Integrated 
Thermal Cycler), the PCR products must be combined (pooled). 

The ratio for pooling the products depends upon the relative intensity of the dye labels 
and the efficiency of PCR amplification of each product. 

When using Virtual Filter C, a ratio of 1:2:1 is the general rule for pooling products 
labeled with FAM, HEX, and TET. For Virtual Filter D, use a ratio of 1:2:2 for FAM, 
HEX, and NED. Refer to the protocol in the application kit for the specific pooling ratio. 
For some applications, it may be necessary to optimize the pooling ratio in your 
laboratory.

With Kit A, you will have two pools (one for each DNA sample).

continued on next page

1 Open Cold Right Storage and remove the pooled PCR products.

The following step is optional:

To pause the robot during the Purge cycle to remove the pooled PCR products:

a. Select HOLD from the Chemistry menu, or click the PAUSE/RESUME button 
on the Robot.

b. When the green light by the PAUSE/RESUME button goes out, open the lid 
and remove the pooled PCR products from Right Cold Storage.

c. Click the PAUSE/RESUME button, or choose RESUME from the Chemistry 
menu to complete the purge.

IMPORTANT Resume the purge. Do not select Stop; otherwise, the instrument 
will not be clean for the next run.

2 Check the residual volumes in the sample and reagent tubes, and the product 
volumes in the product tubes. 

Note Check any unusual volumes for later investigation.

3 If the Log File contains an error message, note the following:

� The exact wording of the message. 

� The statements immediately before and after the error message.

4 To reduce condensation, keep the cold storage lids and instrument door closed 
after you are finished.

Dye Relative Intensity

FAM High

NED or HEX Medium

TET Low
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Pooling PCR
Products from Kit A

How to Pool PCR Products from Kit A Produced on the GeneAmp PCR System 9700, 
9600, or 2400

The following procedure describes how to pool PCR products From Kit A produced on 
the GeneAmp® PCR System 9700, 9600, or 2400.

Pool as follows:

How To Pool PCR Products From Kit A Produced on the DNA Thermal Cycler 480

Pool as follows:

Step Action

1 Using the volumes listed in Table 3-5, transfer the appropriate volume of each 
reaction product in Row A to the empty reaction tube at the end of Row A.

2 Using the same table, transfer the appropriate volume of each reaction product in 
Row B to the empty reaction tube at the end of Row B.

3 Cap the reaction tubes.

4 Invert the tray to mix the samples.

5 Place the reaction tray in the MicroAmp base.

6 Spin down the tray to collect solutions at the bottom of each tube.

7 Store the pooled samples and remaining reaction products at –15 °C to –25 °C until 
you are ready to use them again.

Table 3-5 Kit A PCR Products Pooling Ratios: GeneAmp® 9700, 9600, or 2400 

Tube Position and Primer Mix Volume  Dilution Ratio

A1 or B1 with 
D12S83-[FAM]

7.5-µL 1:6.67

A2 or B2 with 
D7S517-[FAM]

7.5-µL 1:6.67

A3 or B3 with 
D2S391-[TET]

5.0-µL 1:10

A4 or B4 with 
D13S171-[TET]

10.0-µL 1:5

A5 or B5 with
D1S220-[HEX]

10.0-µL 1:5

A6 or B6 with 
D3S1266-[HEX]

10.0-µL 1:5

Total volume = 50.0-µL

Step Action

1 Pool each of the six reaction products for control DNA 1347-02 by pipetting the 
volumes listed below in Table 3-6 to a clean, empty GeneAmp® reaction tube.

2 Repeat this procedure for control DNA 1347-10.

3 Cap the tubes, and invert to mix the samples.

4 Spin down the tubes to collect solutions at the bottom of each tube.

5 Store the pooled samples and remaining reaction products at –15 °C to –25 °C until 
you are ready to use them again.
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Table 3-6 Kit A PCR Products Pooling Ratios: DNA Thermal Cycler 480 

Primer Mix Volume Dilution Ratio

D12S83-[FAM] 7.5-µL 1:6.67

D7S517-[FAM] 7.5-µL 1:6.67

D2S391-[TET] 5.0-µL 1:10

D13S171-[TET] 10.0-µL 1:5

D1S220-[HEX] 10.0-µL 1:5

D3S1266-[HEX] 10.0-µL 1:5

Total volume = 50.0-µL
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About Run Modules, Analysis Parameters, Size Standard and Matrix Files

Overview Runs on the 310 Genetic Analyzer that will be analyzed with GeneScan® Analysis 
Software require you to have these types of files:

� Module

� Size standard

� Analysis parameters

� Matrix

You select the particular files appropriate to your experiment on the Sample Sheet and 
Injection List.

Updated The module files are supplied with the Data Collection Software. Updated files can be 
obtained from the:

Applied Biosystems site on the World Wide Web 
(www.appliedbiosystems.com/techsupport), 

Applied Biosystems Technical Support, or from your local field applications specialist 
(call your local sales office for more information). 

For new applications, a disk containing the files is often included with the reagent kit. 

Size Standard, Analysis Parameters, and matrix files are all created using GeneScan® 
Analysis Software. See the ABI PRISM GeneScan Analysis Software User’s Manual.

Run Modules Run modules are software files. The 310 Genetic Analyzer executes the steps in a run 
module to process a sample. Run time, temperature and voltage, prerun time, 
injection time and voltage are some of the run parameters controlled by the run 
module. 

Run modules are selected through the Injection List. Select the run module based on 
the polymer, glass syringe size, dye set, and application you are using.

If a custom module is necessary, see “Editing Modules Using Manual Control” on 
page 5-17.

continued on next page
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Run Module
Reference Table

Use the following table as a guide when selecting a run module:

Size Standard Files About Size Standard Files

The Size Standard file holds the results of a run performed with fragments of known 
length. The file can be used to analyze other runs performed under the same 
conditions to determine the size of fragments of unknown length.

Applied Biosystems offers several size standard kits. Contact your sales 
representative for more information.

Generating New Size Standard Files

To generate new Size Standard files, set up the instrument and run the mixture of 
known-length fragments as a single sample. Create a new Size Standard file using 
GeneScan® Analysis Software (see the GeneScan Analysis Software User’s Manual). 

Analysis Parameters
Files

This file holds the default start and stop point for data analysis, the default peak height 
threshold, and the default size calling method.

New Analysis Parameters files are created using GeneScan® Analysis Software (see 
the GeneScan Analysis Software User’s Manual).

continued on next page

Chemistry Syringe Polymer Run Module Capillary Size Capillary Mark

AFLP Plant Mapping 
Kits I and II

1.0-mL POP-4 GS STR POP4 (1.0mL) A 47 cm x 50µ i.d. green

Linkage Mapping Set 
version 1

1.0-mL POP-4 GS STR POP4 (1.0mL) C 47 cm x 50µ i.d. green

StockMarks Kits 1.0-mL POP-4 GS STR POP4 (1.0mL) C 47 cm x 50µ i.d. green

Linkage Mapping Set 
version 1

1.0-mL POP-4 GS STR POP4 (1.0mL) C 47 cm x 50µ i.d. green

StockMarks Kits 1.0-mL POP-4 GS STR POP4 (1.0mL) C 47 cm x 50µ i.d. green

Linkage Mapping Set 
version 2

1.0-mL POP-4 GS STR POP4 (1.0mL) D 47 cm x 50µ i.d. green

Custom Primers for 
fragment analysis

1.0-mL POP-4 GS STR POP4 (1.0mL) D 47 cm x 50µ i.d. green

AFLP Microbial 
Identification Kit

1.0-mL POP-4 GS STR POP4 (1.0mL) F 47 cm x 50µ i.d. green

Human Identification 
Profiler Kits

1.0-mL POP-4 GS STR POP4 (1.0mL) F 47 cm x 50µ i.d. green
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Matrix Files Matrix files contain information that corrects for “spectral overlap”. Spectral overlap 
occurs when part of one dye’s emission spectrum falls onto a portion of the detection 
hardware that is collecting the fluorescent peak of another dye. Dye sets are created 
to minimize spectral overlap, but it occurs to some extent.

When choosing matrix files in the Sample Sheet, match the matrix file to the samples 
by dye set and chemistry. For example, samples run with a module file for Virtual Filter 
D should be analyzed with a matrix file that was also run with Virtual Filter D.

The dye set used to create the matrix file must be the same as the dye set used to run 
the sample. If you analyze data with a matrix file that does not reflect the conditions of 
your run, the run will appear to fail. Re-analyze with the correct matrix file if you have 
made this error.
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Denaturing and Loading the Samples

About Formamide
and Samples in

Formamide

! WARNING ! CHEMICAL HAZARD. Formamide is a known teratogen. It can cause 
birth defects. Wash thoroughly after handling formamide. Wear appropriate protective 
eyewear, clothing, and gloves. Obtain a copy of the MSDS from the manufacturer. Wash 
thoroughly after handling formamide.

The protocol uses formamide as a sample preparation reagent. Fresh formamide must 
be deionized and aliquotted into smaller volumes for storage. Each aliquot should be 
adequate for about one week’s work.

Store aliquots of formamide at -20°C for up to three months. Formamide stored at 4°C 
is good for about one week.

At room temperature, samples in formamide are stable for a maximum of 48 hours. 

Although not recommended on a routine basis, you can keep samples prepared in 
formamide frozen for no more than three days before running on the ABI PRISM® 310 
Genetic Analyzer with no detectable loss in resolution. 

Deionizing
Formamide

To deionize formamide:

continued on next page

Step Action

1 Mix 50-mL of formamide and 5 g of ion-exchange resin (AG501 X8 from BioRad is 
recommended).

2 Stir the mixture at room temperature for 30 minutes.

3 Check the pH. It must be 7.0–9.0.

4 If the pH… Then…

is in the proper range filter the mixture through a 2-micron filter.

is not in the proper range a. Decant the formamide into a beaker with 
5g of resin.

b. Stir at room temperature for 30 minutes.

c. Check the pH; it must be 7.0–9.0.

5 Make 500-µL aliquots and store them at minus 20°C for up to 3 months.
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Preparing the
Formamide-Size

Standard Mix

To ensure reproducibility of results for all samples, prepare the formamide-size 
standard mix using the 12:1 ratio of reagents stated in the procedure below.

IMPORTANT The formamide-size standard mix for the ABI PRISM® 310 differs from the mix 
prepared for the ABI® 373 and ABI PRISM 377, and do not use on other instruments.

! WARNING ! CHEMICAL HAZARD. Formamide is a known teratogen. It can cause 
birth defects. Wash thoroughly after handling formamide. Wear appropriate protective 
eyewear, clothing, and gloves. Obtain a copy of the MSDS from the manufacturer. Wash 
thoroughly after handling formamide.

Prepare the formamide-size standard mix as follows:

Preparing Matrix
Standard Samples

About Matrix Standards

You must run matrix standards and create a matrix file the first time you use a new 
chemistry or change the run conditions.

Do not prepare matrix standards more than two hours in advance.

To ensure reproducibility of results for all samples, prepare the matrix standard mix 
using the 12:1 ratio of reagents stated in the procedure below.

IMPORTANT Do not add size standard mix to the matrix standard samples.

IMPORTANT The matrix standard mix for the ABI PRISM® 310 differs from the mix prepared 
for the ABI® 373 and ABI PRISM 377, and should not be used on other instruments.

When using the Fluorescent Genotyping Demonstration Kit, prepare Fluorescent 
Amidite Matrix Standards (P/N 401546). For fluorescent dNTPs, prepare Fluorescent 
dNTP Matrix Standards (P/N 402792). Remember that the matrix standards run must 
always match the sample run chemistry and conditions.

Step Action

1 Mix in a sample vial:

a. 0.5-µL GeneScan–350 [TAMRA] Size Standard (for example)

b. 12.0-µL deionized formamide

2 Label the vial.

3 Gently vortex the mixture for 3–5 seconds.

4 Spin down the mixture.

5 Store the mix at 2–6 °C until ready to use.
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Preparing Matrix Standard Samples

For each matrix standard:

Denaturing the
Matrix Standard

Samples

You can denature the matrix standard samples in the thermal cycler with your samples 
(See “Denaturing the Samples” below), or follow this procedure:

Denaturing the
Samples

IMPORTANT To prevent PCR carry-over contamination, we recommend working with 
amplified PCR products in an area separate from where reaction trays are loaded prior to PCR.

Step Action

1 Mix in a sample vial:

a. 1.0-µL of matrix standard

b. 12.0-µL of de-ionized formamide

2 Label each vial according to the dye.

3 Gently vortex the mixture for 3–5 seconds.

4 Spin down the mixture.

5 Store at 2–6 °C until ready to use.

Step Action

1 Heat the sample for five minutes at 95°C.

2 Chill the sample on ice.

3 Hold on ice until ready to load in the autosampler.

To denature your samples: 

Step Action

1 If the GeneAmp® PCR System 9600 or 9700 will be used to denature your samples, 
determine the order in which you will place the samples in the 96-well tray. 

Suggested configurations are shown in Figure 3-8 on page 3-32 and Figure 3-9 on 
page 3-33.

Note The 96-well tray adaptor (P/N 4305051) is required to use the same tray 
on the ABI PRISM® 310.

If the GeneAmp® PCR System 2400 or DNA Thermal Cycler 480 will be used to 
denature your samples, you will be required to transfer the samples to either a 96 or 
48-well sample tray to load the samples onto the ABI PRISM® 310.

2 Load the pooled PCR products. For example:

� For Kit A, pipette 1.0-µL of each pooled PCR product into a MicroAmp or 
0.5-mL reaction tube, one pooled product per tube. 

� For Kit B, pipette 2.0-µL of each pooled PCR product into a MicroAmp or 
0.5-mL reaction tube, one pooled product per tube.

3 Add 12-µL formamide-size standard mix to each tube.

IMPORTANT Do not add size standard mix to matrix standard samples.

4 Place matrix samples in the 96-well tray.
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Loading the Samples Load the samples into the autosampler as follows:

Figure 3-6 Kit A pooled PCR products in positions A1 and A3. Matrix standard samples in 
positions A5, A7, A9 and A11.

5 Cap each tube, or seal the tubes with a MicroAmp full plate cover (available for the 
GeneAmp® PCR System 9700, 9600, and 2400 only).

IMPORTANT Do not seal the tubes with the septa because the septa will melt 
inside the thermal cycler.

6 Spin down the contents of each tube.

7 Place the tubes into the thermal cycler. 

8 Denature the samples as follows:

a. 95 °C for 5 minutes

b. Hold at 2–6 °C

Note You can denature matrix standard samples using these conditions even 
though they differ from the conditions listed on the matrix standard samples product 
insert. Product performance will not be affected.

9 Remove your samples from the thermal cycler, and cool them in an ice water bath 
before loading them onto the Genetic Analyzer.

To denature your samples: (continued)

Step Action

Step Action

1 If necessary, transfer the denatured samples to a 48-or 96-well tray.

Suggested tube arrangements for the example using the 48-well tray are shown in 
Figure 3-6 and Figure 3-7 on page 3-32. 

Suggested tube arrangements for the example using the 96-well tray are on 
pages 3-32 and 3-33.

IMPORTANT The tube arrangement and order of the samples in the tray and 
on the Sample Sheet must be the same. Make note of the tube arrangement you 
use, so that you can prepare the Sample Sheet correctly.

2 Seal each tube with a septum, and place the tray into the autosampler. 
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Figure 3-7 Kit B pooled PCR products in positions A1, A3, A5 and A7. Matrix standard 
samples in positions A9, A11, B2 and B4.

Figure 3-8 Kit A pooled PCR products in positions A1 and A2. Matrix standard samples in 
positions A3 through A6.
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Figure 3-9 Kit B pooled PCR products in positions A1 through A4. Matrix standard samples in 
positions A5 through A8.

Minimum Sample
Volume

The minimum sample volume per tube is 10-µL. If you choose to use 10-µL samples, 
routine autosampler calibration is necessary (see “How to Calibrate the Autosampler” 
on page 4-27).

You can use a single sample for more than one analysis. Either inject out of one 
sample tube repeatedly, or split the sample into several tubes. 

About Quantitating
and Diluting the

PCR Mixture

Unlike DNA sequencing samples, samples requiring GeneScan® Analysis Software 
are not typically quantitated on a spectrophotometer prior to loading on the 310 
Genetic Analyzer.

The 12:1 ratio of formamide-size standard:PCR sample mix is usually an adequate 
dilution. If the peaks go off-scale at this dilution, further dilute the mixture.

How to dilute the PCR mixture

Step Action

1 Transfer 1-µL of the 12:1 formamide-size standard:PCR sample mix to 9-µL of 
formamide in a sample tube. 

2 Cover the tube with a septum and vortex well. 

3 Heat the mixture for 2 minutes at 95°C and place it on ice until ready to place in the 
instrument. 
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How to Prepare the Sample Sheet and Injection List

Purpose The Sample Sheet associates sample information (name and type of analysis) with a 
sample tube position in the autosampler.

The Injection List specifies the order for running samples, how many injections are 
made from each sample, and the module and running conditions for each injection.

Preparing the
Sample Sheet

About Preparing the Sample Sheet

The first time you use Kit A or B of the Fluorescent Genotyping Demonstration Kit, or 
any group of samples, you must create a Sample Sheet.

Note This chapter takes the Fluorescent Genotyping Demonstration Kit as a detailed 
example, and the illustrations for the procedure below are from a Fluorescent Genotyping 
Demonstration Kit Sample Sheet. When you fill out Sample Sheets for other types of 
experiments to be analyzed with the GeneScan® Analysis Software, choose the colors present 
and color of the standard that reflect the set up of your samples.

Save the Sample Sheet in the Sample Sheet folder on the Macintosh® computer’s 
hard drive. If you use the same type of kit or group of samples again, select the 
previously created Sample Sheet. If there is already a Sample Sheet for the kit in the 
Sample Sheet folder, see “Preparing an Injection List” on page 3-37.

Creating a New Sample Sheet

To prepare a new Sample Sheet: 

Step Action

1 In the ABI PRISM® 310 Data Collection Software, select New from the File menu.

2 Click GeneScan Smpl Sheet 48 or 96 Tube as appropriate.

3 Refer to these examples to see how a Sample Sheet is filled out:

4 Check the Pres column when a sample is present for that color.

If you are using... Then...

Kit A � Prepare the Sample Sheet as shown in Figure 3-10 
on page 3-35. 

� Include the matrix standard samples if you need to 
create a matrix file.

Kit B � Prepare the Sample Sheet as shown in Figure 3-11 
on page 3-36. 

� Include the matrix standard samples if you need to 
create a matrix file.
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Figure 3-10 Sample Sheet for Kit A with matrix standard samples when using a 48-well tray. 
Note the size standard is specified for Kit A samples only, not for the matrix standard samples.

5 Put a diamond in the Std column next to the color for the standard.

IMPORTANT Do not specify a color in the standard (Std) column for the matrix 
samples.

Note Remember, the tube arrangement in the tray and the order of the samples 
on the Sample Sheet must be the same.

6 Open the File pull-down menu, and select Save As. Name the Sample Sheet, and 
press Return to save it in the Sample Sheets folder.

To prepare a new Sample Sheet: (continued)

Step Action
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Figure 3-11 Sample Sheet for Kit B without matrix standard samples when using a 96-well 
tray

Using a Previously
Created Sample

Sheet

If you are running the same group of samples for a second or third time, you can use 
the original Sample Sheet. Select the previously created Sample Sheet when filling 
out the Injection List.

To use a previously created Sample Sheet:

continued on next page

Step Action

1 Open the Sample Sheet. 

It is stored in the Sample Sheet folder on the Macintosh® hard drive.

2 Make changes and save the Sample Sheet.

You can take the following action:

3 Select the modified Sample Sheet when filling out the Injection List.

If you want to... Then...

keep the original Sample Sheet enter a new name.

overwrite the original choose Save without renaming the 
Sample Sheet.
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Preparing an
Injection List

Note This chapter takes the Fluorescent Genotyping Demonstration Kit as a detailed 
example, and the illustrations for the procedure below are from a Fluorescent Genotyping 
Demonstration Kit Injection List. When you fill out Injection Lists for other types of experiments 
to be analyzed with the GeneScan® Analysis Software, choose the module and matrix files 
appropriately.

To prepare an Injection List:

Figure 3-12 Injection List for Kit A with matrix standard samples when using a 48-well tray

Figure 3-13 Injection List for Kit B without matrix standard samples when using a 96-well 
MicroAmp tray

continued on next page

Step Action

1 In the ABI PRISM® 310 Data Collection Software, select New from the File menu. 
The following box of icons is displayed.

2 Select GeneScan Injection List.

3 Complete the Injection List as follows. Sample Injection Lists for Kits A and B are 
shown in Figure 3-12 and Figure 3-13 on page 3-37.

a. Open the Sample Sheet pop-up menu, and select the Sample Sheet prepared 
for the kit you are using.

b. Enter your name as the Operator.

c. Open the Module pop-up menu for each sample, and select GS STR POP4 
(2.5-mL) C, or GS STR POP4 (1.0-mL) C if using the 1.0-mL glass syringe.

d. Leave the remaining parameters at their default settings.
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Making Multiple
Injections from One

Sample Tube

The default setting for the Injection List assumes that each sample will be injected 
once. If you prefer multiple injections, modify the Sample Name column so that the 
sample appears multiple times.

continued on next page

Step Action

1 In the example used here, the original Sample Sheet has been modified to inject 
Sample 3 twice.

2 For the injection you are modifying, click the arrow next to the Tube & Sample 
Name. 

3 When a pop-up menu of the original sample list appears, select the sample you 
want to inject.

Figure 3-14 and Figure 3-15 show the sequence for editing the injection. Instead of 
injecting a sample in position A3 of the autosampler as the second injection, 
Sample 3 in position A5 will be the second injection.

Figure 3-14 Select Sample

Figure 3-15 Change Sample for Third Injection
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Modifying an
Injection List

Adding Rows

The Injection List has the same number of rows as the Sample Sheet. To add rows, 
highlight a row, press Command-I, and a new row will be inserted above the 
highlighted row.

Changing Run Parameters

As you select a module file for each injection, the run parameters are filled in 
according to the values in the module. You can edit any parameter by clicking in the 
field and typing in the new value. Click another field or press Enter to save the change.

Changing the Order
of the Samples in a

Run

The default setting for the Injection List assumes that each sample will be injected in 
the order listed in the Sample Sheet. If you prefer a different injection order, modify the 
Sample Name column.
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Running and Monitoring Samples

Testing the Capillary
Window

Run a test to ensure that the capillary window is clean and positioned correctly before 
running your samples:

Starting the Run Click the Run button in the Injection List to start the run. 

Note If you did not preheat the instrument as suggested under “Preheating the Heat Plate” 
on page 3-13, it can take up to 30 minutes for the instrument to heat to 60 °C and begin 
electrophoresis

Monitoring the Run During the run, you can monitor the run and your samples four ways. From the 
Window menu, select one of the following:

Figure 3-16 Status

Step Action

1 Insert a line into the Injection List before the first sample.

See “Modifying an Injection List” on page 3-39 for instructions, if necessary.

2 Set the module to Test CCD 4-Color.

3 Change the collection time from 5 minutes to 1 minute.

4 When the module runs, check the raw data for excessive noise. The ideal baseline 
falls at or below about 2068.

Use the following table to help determine whether the capillary is positioned 
correctly.

If... Then...

the baseline is too high remove the capillary and clean the 
capillary window with a lab wipe and 
dampened ethanol.

there is a single blue line at 8000 or at 
the bottom of the window

the capillary window is not positioned 
in the detector.
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Figure 3-17 Log

Figure 3-18 Raw Data

Figure 3-19 Electrophoresis History
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How to Create the GeneScan Matrix File

Overview The matrix file contains the information necessary for software to correct the overlap 
of the dyes emission spectra on the virtual filter. Once a matrix file has been created, 
it can be used for subsequent runs performed:

� With the same kit or chemistry

� On the same instrument

� Using the same:

– Run modules

– Set of dyes

– Polymer 

After running the matrix standards, use their sample files to generate a matrix file 
using GeneScan® Analysis Software.

Verifying the Raw
Data

Before creating the matrix file, verify that the raw data from the standards is good.

Viewing the Raw Data in the GeneScan® Analysis Software

Verifying the Raw Data

continued on next page

Step Action

1 Create a new project:

a. Choose New from the File menu.

b. Select the Project icon. An untitled Analysis Control window opens.

c. Choose Add Sample Files from the Project menu.

d. Find and open the Run Folder for the matrix standards run.

e. Select the four Sample files representing the blue, green, yellow, and red 
dye-labeled “runs,” and then click Add.

f. Click Done after the Sample files are transferred.

2 In the Analysis Control window, select the four matrix standard Sample files by 
clicking on the first Sample file, holding down the mouse button, and releasing on 
the last Sample file.

3 Choose Raw Data from the Project menu. Electropherograms displaying raw data 
from the four matrix standard Sample files appear.

Step Action

1 Verify data peaks are present in all four samples. 

Peak data should be on-scale and the dye of interest should have a value of at least 
200.

2 Check for any data anomalies, such as an unstable baseline.

Rerun samples that have an unstable baseline.

3 Select a starting point for the matrix data. 

The starting point for matrix data should be slightly beyond the point where the 
primer peak falls back to the baseline.
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Generating The
Matrix File

To generate the matrix files:

continued on next page

Step Action

1 Choose New from the File menu.

2 Click the Matrix icon. This opens the Make New Matrix dialog box.

3 Click the B, G, Y, and R buttons to choose the standard sample files. Choose the 
sample file representing blue dye for B, green dye for G, etc.

4 Enter the starting point for each file. 

The Start At point should be after the primer peak. 

If necessary:

� Modify the default setting of 2000.

� Modify the Points value. This is the number of points after the start point to be 
analyzed.

5 Click OK. 

A successful matrix opens an untitled Matrix Values window with a 4x4 matrix of 
numerical values.

6 Use the Save As command to name and save the matrix file. 

Choose a name that reflects the chemistry and run conditions.
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Checking Matrix
Quality

Check the quality of the matrix by reviewing the:

� Values in the Matrix Values window.

� Analyzed data of the matrix run.

Reviewing the Matrix Values in the Matrix Values Window

Checking the Matrix Quality

Step Action

1 View the Matrix Values window.

2 The numbers on the diagonal (Blue against Blue, Green against Green, etc.) must 
all be 1.00. 

The numbers off the diagonal are less than 1.00. 

In Virtual Filter C, Green under Blue is sometimes slightly above 1.00. This is 
acceptable.

To change matrix quality: 

Step Action

1 From the Project containing your matrix standard Sample files, open the Analysis 
Control window. 

In the Analysis Control window, select the colors for each sample.

2 Select the four matrix standard Sample files.

3 Choose Assign New Matrix in the Project menu and select the matrix file.

4 Select numbers 1, 2, 3, and 4 on the left side of the window to highlight the colors 
for each row.

5 Use the Set Analysis Parameters dialog box in the Settings menu to set the 
Analysis Range and click OK to return to the Analysis Control window.

A typical setting is 2000.

6 Click Analyze.
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Analyzing The Data

Automatically
Analyze Data

GeneScan® Analysis Software automatically analyzes the samples when the run 
finishes if the automatic analyze checkbox on the Sample Sheet is checked.

See the ABI PRISM GeneScan Analysis Software User’s Manual for more information.

7 Choose Results from the Windows menu and check each electropherogram by 
taking the following action:

8 If… Then the matrix is…

each peak is one color with the other 
colors flat under it

good.

the other colors are not flat under the 
peaks:

poor.

9 If the matrix is… Then…

good save the matrix file to the ABI folder.

poor re-analyze the matrix run. 

If this does not improve the matrix data, 
run new matrix standards.

To change matrix quality: (continued)

Step Action

Clicking In the

4 # of Panels pop-up menu.

1 Dye Samples.

#1 on the Sample Files side of the Results window.
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How to Turn the Genetic Analyzer On and Off

Turning On the
Instrument Without
a Capillary Installed

Follow these steps anytime you turn on the 310 Genetic Analyzer without a capillary 
installed:

Turning On the
Instrument With a
Capillary Installed

Follow these steps anytime you turn on the 310 Genetic Analyzer with a capillary 
installed:

Step Action

1 Turn the 310 Genetic Analyzer on.

2 Check the LEDs on the front. The green light should be illuminated.

3 Turn on the Macintosh® computer.

4 Open the Manual Control window, choose Syringe Home and click Execute.

5 In the Manual Control window, do the following:

� Choose Autosampler Home X,Y and click Execute. 

� Choose Autosampler Home Z and click Execute.

Step Action

1 The capillary is inserted in a buffer vial on the autosampler when it is stored on the 
instrument. Remove the capillary from the buffer tube.

2 Thread the capillary through the electrode thumbscrew. It should extend 0.5 mm 
beyond the electrode. See “Positioning the Capillary Near the Electrode” on 
page 4-14.

3 Turn on the 310 Genetic Analyzer. 

4 Check the LEDs on the front. The green light should be illuminated. 

5 Turn on the Macintosh® computer.

6 Open the Manual Control window, choose Syringe Home, and click Execute. 

7 In the Manual Control window, do the following:

� Choose Autosampler Home X,Y and click Execute.

� Choose Autosampler Home Z and click Execute.

8 Calibrate the autosampler. See “Calibrating the Autosampler” on page 4-28.
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Electrodes Overview

Anode and Cathode Both electrodes are platinum.

Electrode Description

Anode This electrode is on the left as you face the instrument, 
and is always immersed in the electrophoresis buffer.

Cathode

Note Always recalibrate 
the autosampler if the cathode 
electrode is removed, 
replaced, or cleaned.

This electrode is a U-shaped wire located above the 
autosampler. 

It is placed in the sample during electrophoresis. 

You can remove and replace the cathode electrode.
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How to Prepare the Cathode Electrode

Installing the
Electrode

To Install the electrode: 

Step Action

1 Remove the capillary if it is on the instrument.

2 Unscrew and remove the cathode electrode thumbscrew.

3 There are three holes in the electrode thumbscrew: the capillary hole, an inner 
electrode hole, and an outer electrode hole (See Figure 4-1).

Put the long arm of the cathode electrode in the inner electrode hole.

Figure 4-1 Electrode inserted in the electrode thumbscrew (top view)

Thumbscrew

Capillary hole

Inner electrode hole

Outer electrode hole

Electrode

Electrode thumbscrew
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Trimming the
Electrode

It may be necessary to trim a new electrode so that the end is flush with the stripper 
plate.

continued on next page

4 Put the short arm of the electrode in the outer hole.

5 Push the electrode down until it is flush with the top of the electrode thumbscrew.

6 Screw the electrode thumbscrew back onto the instrument.

7 Recalibrate the autosampler after cleaning, trimming or replacing the electrode.

To Install the electrode: (continued)

Step Action

To trim the electrode: 

Step Action

1 From the Manual Control window, select the Function pop-up menu and choose 
Home Z-Axis.

2 Use the wire cutter (P/N T-6157) provided in the instrument packing kit. Hold the 
cutters with the flat cutting face toward the top of the instrument.

Note The wire cutter provided in the instrument packing kit is a flush-cutting 
wire cutter. Do not use other types of wire cutter.

3 Cut the electrode flush with the lower surface of the stripper plate. Do not flex the 
stripper plate upwards while cutting. Do not cut the electrode too short.

4 Recalibrate the autosampler after cleaning, trimming or replacing the electrode.

Electrode

Stripper Plate

Thumb Screw
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Straightening the
Electrode

Note Recalibrate the autosampler after installing an electrode.

To straighten the electrode, if the cathode electrode is bent:

When to Clean the
Electrode

Clean the electrode if it has been touched, if it is new, when autosampler buffer 
solutions are replaced, or every 48 hours. Crystals formed on the electrode can fall 
into the sample and clog the capillary.

Since the capillary is removed from buffer while the electrode is cleaned, complete the 
procedure quickly, so that the capillary does not dry out.

Cleaning the
Electrode

To clean the electrode:

Step Action

1 Remove the electrode from the electrode thumbscrew.

2 Lay it on a flat surface.

3 Rub a flatblade screwdriver back and forth along the length of the electrode to 
straighten it.

Step Action

1 Open the ABI PRISM® 310 Data Collection Software.

2 Press the Tray button on the 310 Genetic Analyzer to lower the autosampler and 
present the tray.

3  Wipe the electrode with lint-free paper that has been dampened with distilled, 
deionized water

4 Dry the electrode with fresh lint-free paper.

5 Press the Tray button to return the autosampler to its original position and 
immerse the capillary in buffer.

6 Recalibrate the autosampler after cleaning, trimming or replacing the electrode.
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How to Remove the Pump Block

Removing the Pump
Block

The pump block rides on two steel shafts. It slides freely after a spring plunger in the 
block moves past an indentation on one of the steel shafts.

For a diagram of the inside of the instrument, see “Instrument Hardware: Behind the 
Doors” on page 1-8.

To remove the pump block:

Step Action

1 Disconnect the glass syringe plunger from the syringe drive.

2 Open the Manual Control window and move the syringe drive up.

3 Unscrew the glass syringe and plastic syringe.

4 Remove the capillary.

5 Remove the buffer reservoir by gently twisting and pulling it straight down.

6 Remove the pump block by pulling it straight toward you.
Procedures for Operation 4-7



How to Clean the Pump Block

When to Clean the
Pump Block

Clean the pump block when:

� Installing the syringe.

� Removing the capillary.

� Changing between the ABI PRISM® DNA Sequencing Analysis Software and the 
GeneScan® Analysis Software.

� Shutting down the instrument.

IMPORTANT The pump block can be irreversibly damaged if polymer dries in the channels.

It is especially important to clean the pump block if a syringe containing polymer was 
installed on the block for more than 1 week. At room temperature, sufficient urea 
decomposition occurs in 1 week to cause transient current increases during 
electrophoresis.

Cleaning the Pump
Block

IMPORTANT Do not expose the pump block to any organic solvents.

To clean the pump block: 

Step Action

1 Remove the pump block from the instrument.

2 Open all valves and ports on the pump block.

3 Hold the pump block under warm running water to thoroughly rinse it.

4 Take the following actions:

� Force warm water through the channels with the 5-cc plastic syringe provided 
in the Basic Installation Kit. 

� Direct the flow of water through each channel in turn by sealing channel 
openings with plugs provided in the Basic Installation Kit. 

� Rinse each channel five times.

Note If a 30-cc syringe is available, rinse each channel with it once. This can be 
more convenient than rinsing five times with a 5-cc syringe.

5 Rinse the valves with warm water. 

Soak valves that are coated with dried polymer.

6 Visually inspect the channels for dried polymer, which looks like white residue. 
Wash the channels until the polymer is gone.

7 Rinse the block and its channels with distilled, deionized water.

8 Take the following actions:

� Remove residual water from the pump block and fittings to ensure that the 
running polymer is not diluted. 

� Force air through the channels, using the plastic syringe or canned 
compressed air, until the channels are dry.

9 Replace the pump block and buffer reservoir.
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How to Replace the Pump Block

Replacing the Pump
Block

To replace the pump block:

How to Fill the Pump Block

Filling the Pump
Block

To fill the pump block channels with polymer:

Step Action

1 Verify that the gold electrode socket on the back of the block is dry.

2 Align the steel shafts with the two large holes of the block. 

3 Before sliding the pump block all the way to the back of the shafts, align the anode 
buffer reservoir valve with the activator arm.

4 Slide the U-shaped end of the activator arm into the collar at the top of the valve’s 
plunger.

5 Lift the plunger about 3 mm, if necessary, and slide the pump block until flush 
against the instrument.

Step Action

1 Open the Manual Control window and select Buffer Valve Close in the Function 
pop-up menu. 

This closes the pin valve at the anode buffer reservoir on the pump block.

2 Manually open the waste valve below the syringe.

3 Press the syringe plunger until a drop of polymer forms on the bottom of the 
waste valve.

This removes the air bubbles at this valve site, and uses about 0.1-mL of polymer.

4 Manually close the waste valve.

5 Open the Manual Control menu and select Buffer Valve Open in the Function 
pop-up menu 

This opens the pin valve at the anode buffer reservoir on the pump block.

6 Press the syringe plunger until polymer fills the polymer channel in the block.

This removes all of the air bubbles from the polymer channels, and should use 
about 0.1-mL of polymer.

IMPORTANT There should be no air bubbles in the pump block channels.

7 Select Buffer Valve Close in the Function pop-up menu.

Note If using the 250-µL syringe, you may have to refill the syringe now.

8 Move the syringe drive toggle to the right to position it over the syringe plunger.

9 Select Syringe Down in the Function pop-up menu.

10 Select 50-step intervals and click Execute until the toggle makes contact with the 
syringe plunger.
Procedures for Operation 4-9



Capillary Overview

About the Capillary Do not expose the ends of a polymer-filled capillary to air for more than 30 minutes. 
This allows the polymer to dry and adversely affects capillary performance. Make sure 
the autosampler is moved back and the capillary immersed in buffer as soon as 
samples are loaded.

Be careful when handling the capillary. The capillary window for the detector is very 
fragile.

If maintained properly, one capillary can be used for at least 100 electrophoretic 
separations.

Why Cut the
Capillary

For some applications, you may want to reduce the length of the 61cm or 47 cm 
capillary to reduce the run time. A capillary cutter (P/N 401958) is available for this 
purpose. Capillary cutters are small, flat squares of a hard ceramic material.

You may want to practice this technique on an old capillary before cutting new 
capillaries.

Cutting the
Capillary

To cut a capillary:

Cleaning the
Capillary Window

Clean the capillary window with a lint-free laboratory wipe moistened with ethanol.

Step Action

1 Scratch the capillary with the capillary cutter using one firm, even stroke.

2 Break the capillary at the scratch mark on the glass.

3 Examine the capillary. 

The cut end must be flat, without jagged edges.
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How to Install the Capillary on an Empty Pump Block

What to Do First The capillary can break at the detector window if twisted. Always connect the capillary 
to the pump block first, because the capillary will turn slightly as you connect it there. If 
the other end is not free to move, the capillary will twist and break.

The pump block should be clean.

Removing
Capillaries from the

Packaging

The capillaries are shipped in a curved plastic tube. Remove the capillaries by 
grasping one capillary between your thumb and forefinger, and then pulling and 
turning the capillary simultaneously.

Connecting the
Capillary to the

Pump Block

 

To connect the capillary to the pump block: 

Step Action

1 Clean the capillary window with an ethanol-dampened lab wipe.

2 Open the door covering the heat plate.

3 Remove the plastic capillary fitting on the right side of the pump block.

4 Partially screw the capillary fitting back into the pump block.

IMPORTANT Do not tighten the fitting at this point in the procedure, or the 
opening at the tip will be crushed. The capillary must be properly inserted through 
the opening before you tighten the fitting.

5 Thread one end of the capillary through the capillary ferrule.

Capillary Ferrule

Waste Valve Waste Vial
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Positioning the
Capillary in the

Detector

The central portion of the capillary window should rest over the laser detector window 
without putting strain or tension on the capillary. The window is fragile; be careful not 
to break it when you fit the capillary into its track in the detector.

Align the colored labelling mark on the capillary with the top edge of the detector plate 
and laser detector door. This will position the capillary window over the laser detector 
opening.

continued on next page

6 Adjust the end of the capillary so that it is positioned directly below the opening to 
the glass syringe. It is also acceptable to position the end of the capillary between 
the intersection of the channels and the capillary fitting.

IMPORTANT The end of the capillary must protrude well beyond the opening 
at the tip of the capillary fitting. To avoid crushing the opening, be certain that you 
see the capillary in the pump block channel before proceeding to the next step.

7 Tighten the capillary fitting finger-tight to secure the capillary.

CAUTION Overtightening can cause cracks in the gel block which will 
result in polymer leakage.

IMPORTANT The capillary will twist as the fitting is tightened. Leave the other 
end of the capillary free to twist, or the capillary will break.

To connect the capillary to the pump block: (continued)

Step Action

Position the capillary
directly below the
opening to the glass
syringe
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Procedure for
Positioning the

Capillary in the
Detector

To position the capillary:

continued on next page

Step Action

1 Open the laser detector door, and position the capillary in the vertical track of the 
detector.

2 Tape the capillary to the heat plate with thermal tape to secure the position of the 
capillary labelling mark (colored capillary mark) relative to the detector plate.

For a diagram showing how the capillary is taped to the heat plate, see “Detection 
Region Diagram” on page 1-11.

3 Close the laser detector door to secure the position of the capillary window.

Colored capillary mark

Detector plate
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Positioning the
Capillary Near the

Electrode

The capillary and cathode electrode should be as close to each other as possible. The 
capillary should protrude beyond the electrode a maximum of 0.5 mm.

To position the electrode end of the capillary:

Resetting the
Injection Counter

Reset the injection counter as follows:

continued on next page

Step Action

1 Thread the capillary through the capillary hole in the electrode thumbscrew until it 
protrudes past the tip of the electrode by about 0.5 mm.

 

2 Tape the capillary to the heat plate with thermal tape to secure the position of the 
capillary tip relative to the electrode. Tape the capillary just above the electrode 
thumbscrew and just above the detector door.

IMPORTANT To avoid damaging the 61 cm sequencing capillary, verify that the 
entire capillary is secured to the heat plate before closing the heat plate door.

3 Close the door over the heat plate.

4 With the heat plate door closed, check that the capillary has not moved relative to 
the electrode.

Step Action

1 Open the Instrument window and choose Change Capillary.

2 Click OK in the Reset window to set the injection counter to zero.
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After the Capillary
is Installed

Calibrate the autosampler after installing a capillary (see “How to Calibrate the 
Autosampler” on page 4-27).

Do not turn the capillary fitting with the detector door closed. Torque on the capillary 
can break it. Release the capillary from the detector if the capillary fitting needs 
adjustment.

How to Remove the Capillary for Storage

Removing the
Capillary for

Short-term Storage

Use this procedure if the capillary will be re-installed within one week.

Removing the
Capillary for

Long-term Storage

To remove the capillary when it will not be re-installed within one week:

Step Action

1 Run the “Seq Fill Capillary” module in Manual Control to remove any sample still in 
the capillary

2 Leave the polymer in the capillary.

3 Remove the capillary by following the installation steps in reverse order.

4 Clean the pump block.

Step Action

1 Flush the capillary free of polymer as follows:

a. Rinse the pump block.

b. Fill the glass syringe with 200-µL of water.

c. Close all valves.

d. Move the syringe drive to position 250.

e. Run the Seq Fill Capillary module from the Manual Control window to force the 
polymer out of the capillary.

It requires about 6 minutes to force the polymer from the capillary.

Note When the capillary is completely flushed of polymer, the water flowing 
through the capillary may trigger the leak detector. If this happens, click OK in the 
Pause Alert window, resume the run from the menu, and immediately cancel the 
run.

2 Remove the capillary by following the installation steps in reverse order.

3 Clean the pump block.
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How to Store the Capillary

Storing the
Capillary Off the

Instrument

To store the capillary off the instrument:

Storing the
Capillary On the

Instrument

IMPORTANT Leave the power off when storing the capillary with this method. The 
autosampler moves up when the power is turned on. Position the capillary end 0.5-mm below 
the end of the electrode and securely tape the capillary to the heat plate in this position before 
turning on the power after storing the capillary with this method. The autosampler will break the 
capillary if the instrument is turned on before moving the capillary up.

To store the capillary on the instrument:

After Re-installing a
Stored Capillary

Run a known standard to verify the condition of the capillary.

Recalibrate the autosampler after installing a capillary.

Step Action

1 Label on the capillary with the number of runs performed. 

A capillary can be used for up to 100 runs. Keep track of the number of runs 
performed on each capillary.

2 Maintain the capillary ends in two sample tubes filled with sterile deionized water 
and closed with septa.

3 Water evaporates very slowly from the tubes. Check them every week and add 
water if necessary. 

4 Always clean the pump block after removing the capillary.

Step Action

1 Run the “Seq Fill Capillary” module in Manual Control to remove any sample still in 
the capillary.

2 Turn off the instrument. The autosampler drops when the power is turned off.

3 Remove the thermal tape holding the capillary to the heat plate.

4 Lower the end of the capillary into the buffer vial in the autosampler.

5 Tape the capillary in this position and close all the doors.
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Syringe Overview

Types There are two types of syringes used with the 310 Genetic Analyzer:

� Glass

� Plastic disposable

Purpose The following table lists the purpose of the glass and plastic syringes.

Syringe Sizes

Glass Syringes Future applications will be developed for the 1.0-mL syringe only. There will be no new 
modules for the 250-µL or 2.5-mL syringe in software releases after ABI PRISM® 310 
Data Collection Software v.1.0.2.

Glass syringe sizes and intended applications are:

Plastic Syringes Plastic syringes are 5-mL disposable syringes. DNA Sequencing Polymer is packaged 
in 5-mL syringes. An empty plastic syringe is provided in the Basic Installation Kit.

Syringe Purpose

Glass � Polymer reservoir during the run.

� Contains adequate polymer to complete 
the run.

� Remains installed on the instrument 
throughout the run.

� Used for the ABI PRISM® DNA 
Sequencing Analysis Software and the 
GeneScan® Analysis Software.

Plastic � Packaging for DNA Sequencing 
Polymer (DSP).

� Transfers polymer to the glass syringe 
before a run begins.

� Removed before starting the run.

� Used for DNA sequencing applications.

� Used for cleaning the pump block.

Size Application

250-µL DNA sequencing or the GeneScan® Analysis Software with DNA Sequencing 
Polymer

1.0-mL DNA sequencing with POP-6, GeneScan® Analysis Software with POP-4®, and 
the GeneScan® Analysis Software with the GeneScan Polymer
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How to Remove the Syringe

Removing the
Syringe

To remove the syringe:

How to Inspect the Syringe

Inspecting the
Syringe

To inspect the syringe:

Step Action

1 Start the ABI PRISM® 310 Data Collection Software 310 Data Collection software 
by double-clicking the icon, if the program is not currently open.

2 Open the Manual Control window and select Home Syringe from the Function 
pop-up menu.

3 Click the Execute button.

4 Unscrew the syringe from the pump block.

Step Action

1 Inspect the glass syringe for two O-rings (P/N 221102), one behind the ferrule 
and one around the ferrule.

2 Verify that the ferrule is firmly seated in the end of the syringe.

O-rings
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How to Clean the Syringe

When to Clean the
Syringe

Thoroughly clean the syringe whenever it is removed from the pump block. Verify that 
the syringe is clean before use.

Cleaning and
Preparing the

Syringe for Use

CAUTION The teflon plunger is very susceptible to wear caused by friction. Therefore 
the pulling up and pushing down of the plunger within the barrel of the syringe should be 
minimized.

To clean and the prepare the syringe:

Step Action

1 Rinse the syringe with distilled water. Remove excess water, but do not dry 
completely.

IMPORTANT Excessive wear occurs to the Teflon fitting of the plunger if it is 
completely dry.

2 Allow the polymer to equilibrate to room temperature before loading it into the 
syringe.

IMPORTANT Precipitate present when the bottle is removed from cold 
storage should go back into solution at room temperature. Do not use the 
polymer until the precipitate dissolves.

3 Mix the polymer thoroughly by inversion before use. Let it settle for at least 
5 minutes before use.

4 Draw a small amount of polymer solution (0.20-mL maximum) into the syringe. 
Pull plunger up to the 0.60-mL marker after the polymer solution is added.

! WARNING ! Gloves and eye protection should be worn when 
handling polymer.

5 Invert the syringe gently five or six times to coat the walls with polymer and 
discard this polymer solution. This ensures that the running polymer is not diluted 
when added to the syringe.

6 For new, never-before-used syringes, perform this entire procedure twice to 
prevent air bubbles from sticking to the syringe walls.
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How to Install the Syringe

Installing the
Syringe

To install the glass syringe:

Syringe Max Travel Determine the Syringe Max Travel for each size of glass syringe that you use. Record 
the values on the Calibration sticker on the left side door.

When you install a syringe, input the correct Syringe Max Travel value in the Function 
pop-up menu of Manual Control.

Setting Syringe Max
Travel

The syringe must be empty when setting Syringe Max Travel.

Step Action

1 Install the prepared syringe on the pump block with the plunger positioned at the 
bottom of its travel.

2 Move the syringe drive toggle to the right, so it is positioned over the syringe 
plunger.

To set Syringe Max Travel: 

Step Action

1 Determine which version of ABI PRISM® 310 Data Collection Software is installed 
on your Macintosh® computer. 

With the Collection software open, select “About Collection Software” from the 
Apple menu.

2 If you have… Then…

v. 1.0.4 or later Collection software… skip to step 3.

v. 1.0.2 Collection software… a. Open the Window menu.

b. Under Preferences, select 
Sequence Injection List Defaults 
or GeneScan Injection List 
Defaults.

c. Type “139115” in the Operator 
entry window and click OK.

d. Quit the Collection software and 
then re-launch it.

3 Open the Manual Control window, select Syringe Home from the Function pop-up 
menu, and click Execute.

4 Install a clean, empty glass syringe with the syringe plunger at the bottom of its 
travel.

5 Select Syringe Max Travel in the Function pop-up menu. Note the displayed 
value, as you will enter it in the next step.

6 Select Syringe DOWN and enter the current Syringe Max Travel value. Click 
Execute.

7 After the syringe drive reaches the syringe plunger and stops moving, select 
Status from the Window menu.

Note If the plunger is not completely depressed, then choose Manual Control 
from the Window menu and Syringe Down from the Function pop-up menu. Use 
steps of 10.
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How to Home the Syringe

When to Home the
Syringe

Home the syringe after:

� Turning on the main power switch

� Resetting the ABI PRISM 310 Genetic Analyzer

Homing the Syringe To home the syringe:

8 Under the Injection pop-up window, read the number in the Gel Pump At window. 
Subtract 15 from that number.

9 Select Syringe Max Travel in the Function pop-up menu of Manual Control and 
type the number you just calculated in step 8. Click Execute.

10 Record this value on the Calibration sticker on the left side door.

Note If you install a syringe of a different size, you must input the max travel 
value for that syringe size.

11 Select Syringe Up in the Function pop-up menu of Manual Control and enter 250 
in the Value window. Click Execute.

To set Syringe Max Travel: (continued)

Step Action

Step Action

1 Open the ABI PRISM® 310 Data Collection Software.

2 Open the Manual Control window.

3 Select Syringe Home from the Function pop-up menu, and click Execute.
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How to Load Polymer into the Syringe

Before Loading
Polymer

Make sure the syringe has been properly cleaned.

Loading Polymer ! WARNING ! CHEMICAL HAZARD. Urea is a potential mutagen. Dangers cited in 
toxicity studies show reproductive and tumorigenic effects. Urea can cause irritation to 
the skin, eyes, and respiratory tract. Avoid inhalation and contact with skin, eyes and 
clothing. Always work in a fume hood. Obtain a copy of the MSDS from the manufacturer. 
Wear appropriate protective eyewear, clothing, and gloves. 

! WARNING ! CHEMICAL HAZARD. Some chemicals used with this instrument are 
potentially hazardous. Warnings are prominently displayed on the bottle labels of all 
hazardous chemicals. Material Safety Data Sheets (MSDSs) are provided by the 
manufacturer and contain information about physical characteristics, hazards, 
precautions, first aid, spill cleanup, and disposal procedures. Please familiarize yourself 
with the information contained in these documents before attempting to operate the 
instrument or using hazardous reagents. Additional copies of the MSDSs for Applied 
Biosystems chemicals are available from Applied Biosystems at no cost.

To load polymer into the syringe:

Step Action

1 Allow the polymer to equilibrate to room temperature before loading it into the 
syringe.

IMPORTANT Precipitate present when the bottle is removed from cold 
storage should go back into solution at room temperature. Do not use the 
polymer until the precipitate dissolves.

2 Mix the polymer thoroughly by inversion before use. 

Let it settle for at least 5 minutes before use.

3 Fill the syringe manually with a maximum of 0.5-mL of polymer.

Note Do not use polymer that has been on the instrument for more than one 
week. Do not return unused polymer to the original bottle.

4 Remove all air bubbles by inverting syringe and pushing air bubbles out.

IMPORTANT To avoid loss of polymer, any bubbles near the plunger head 
must be removed.

5 Take the following actions:

a. Rinse the outside of the syringe with distilled water to remove any polymer 
on the outside of the syringe. 

b. Dry the outside of the syringe with a lint-free paper.

6 Move the syringe drive toggle to the left to attach the syringe to the pump block.

7 Place the syringe through the right-hand port of the plastic syringe guide plate, 
and screw the syringe into the pump block finger-tight.

8 Manually close and tighten the waste valve below the syringe and the luer valve 
to the left of the syringe.
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How to Fill the Buffer Reservoirs

Filling the Buffer
Reservoirs

To fill the buffer reservoirs:

When to Change the
Buffer

Replace the buffer every week or every 200 runs. 

Making Buffer for a
Single Run

You can prepare fresh electrophoretic buffer for a single run by mixing 1.3-mL of 10X 
Genetic Analyzer Buffer with EDTA (P/N 402824) with 11.7-mL deionized water. You 
can also prepare a stock 1X solution of analysis buffer (for example, 5-mL 10X 
Genetic Analysis Buffer with EDTA and 45-mL deionized water). Store the stock buffer 
at 2–8°C.

Step Action

1 Dilute 5-mL of 10X Genetic Analyzer EDTA Buffer to 1X concentration (50-mL 
total volume) with distilled, deionized water. 

Note The 10X Genetic Analyzer buffer with EDTA can be diluted in a smaller 
volume. Diluted buffer can be stored at 4 °C and used within two weeks. Change 
diluted buffer on the instrument every week or 200 injections, whichever comes 
first.

2 Fill the anode buffer reservoir to the red line with 1X Genetic Analyzer EDTA 
Buffer and place the reservoir on the pump block.

3 Fill a 4-mL glass buffer vial to the fill line with 1X Genetic Analyzer EDTA Buffer. 

4 Insert the plastic cap adapter with attached septum into the glass vial and place 
the buffer vial into position 1 on the autosampler. 

This serves as the cathode buffer.

IMPORTANT Change the septum on the buffer vial every two days to avoid 
build-up of dried polymer.

5 Fill a second 4-mL glass buffer vial to the fill line with distilled water, insert the 
plastic vial lid with attached septum, and place the vial into position 2 on the 
autosampler.

6 Clip the lid off a 1.5-mL Eppendorf tube, fill with distilled water, and place it into 
position 3 on the autosampler.

Note Do not use a screw-cap tube. The screw-cap tubes are too high to clear 
the electrode and capillary.
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Autosampler Overview

When to Clean the
Autosampler

Remove dried buffer from the autosampler with a water-dampened lab wipe once a 
week.

! WARNING ! Salt accumulation on the autosampler can cause an arc during 
electrophoresis.

Tray Types One of two trays can be attached to the tray platform. A sensor in the platform 
automatically detects the type of tray.

Installing the Tray Press the tray flat against the rectangular, raised guide until the tray is flush with the 
platform.

Sample Numbering
in the 48-well Tray

Figure 4-2 shows the numbering of the tube positions in the 48-well tray:

Figure 4-2 Autosampler tray numbering (48 tube positions)

Note Because of the staggered arrangement of sample tubes in the 48-tube sample tray, the 
numbering of the tube positions across the first row is A1, A3, A5, etc. The numbering of the 
tube positions across the second row is B2, B4, B6, etc.

continued on next page

Number of Tube 
Positions

Size of sample tubes 
(mL)

48 0.5

96 0.2
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Sample Numbering
in the 96-well Tray

Figure 4-3 shows the numbering of the tube positions in the 96-well tray:

Figure 4-3 Autosampler tray numbering (96 tube positions)
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How to Home the Autosampler

When to Home the
Autosampler

Home the autosampler after:

� Turning on the main power switch

� Resetting the ABI PRISM 310 Genetic Analyzer

Homing the
Autosampler

IMPORTANT Always home the X, Y positions before the Z position. Homing the Z position 
first can bend the electrode.

To home the autosampler: 

Step Action

1 Open the ABI PRISM® 310 Data Collection Software and choose Manual Control 
from the Window menu.

2 Select Autosampler Home X, Y Axis from the Function pop-up menu, and click 
execute.

3 Select Autosampler Home Z Axis, and click execute.
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How to Calibrate the Autosampler

When to Calibrate
the Autosampler

The autosampler calibration settings are maintained in the permanent memory of the 
instrument. 

Recalibrate:

� After changing the electrode

� After changing the capillary

� If the capillary and the septa caps collide

� After a reset that clears memory

IMPORTANT The sample tray must be removed before calibrating the autosampler. If the 
sample tray is not removed, the electrode will be bent.

Calibration Markers The autosampler tray platform is shown in Figure 4-4. Use the black or silver dots on 
the front and rear of the platform to calibrate the autosampler.

Figure 4-4 Autosampler Calibration Marks

Autosampler
Calibration

Keyboard
Equivalents

These are the keyboard equivalents for the autosampler calibration:

IMPORTANT By holding the keys down (rather than tapping them), the autosampler will 
move in larger increments. Use caution when holding down the keys or the autosampler will 
travel farther than intended, causing damage to the electrode and the Teflon block of the 
autosampler.

continued on next page

Move to the Key

Rear Up Arrow

Front Down Arrow

Right Right Arrow

Left Left Arrow

Up Page Up

Down Page Down

Half Steps Use Shift Key with the above keys
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Calibrating the
Autosampler

IMPORTANT The sample tray must be removed before calibrating the autosampler. If the 
sample tray is not removed, the electrode will be bent.

To calibrate the autosampler:

Step Action

1 Remove the sample tray and Eppendorf tube from the autosampler.

2 Choose Autosampler Calibration from the Instrument menu of the Collection 
software. 

The Autosampler Calibration window appears.

Figure 4-5 Autosampler Calibration window

3 Click Start and follow the directions that appear on the screen.

4  Move the autosampler using the arrow keys in the Autosampler Calibration window 
or the arrow keys on the Macintosh® computer keyboard.

5 Align the calibration dot on the front (Front dot in Figure 4-3 on page?4-25) of the 
tray platform with the capillary. Center the capillary on the calibration point for x,y 
calibration. 

Touch the capillary to the calibration point for z calibration.

6 Click Set to save the calibration value.

7 Repeat for the rear calibration point and click Set. 

Follow the instructions on the screen to complete the calibration.
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How to Load Samples and Buffers on the Autosampler

Loading the
Autosampler

The following steps describe how to load samples, buffers, and wash solutions on the 
autosampler.

To load the autosampler: 

Step Action

1 To access the autosampler on an idle instrument, press the Tray button (see 
Figure 4-6). 

The autosampler moves forward, allowing access to all sample and buffer positions.

Figure 4-6 Location of Tray button to access the autosampler

Note On some early ABI PRISM® 310 instruments, the Tray button is located on 
the front panel where the figure shows status indicators.

Tray 
Button
Procedures for Operation 4-29



2 Load solutions on the autosampler in the numbered positions at the right side of the 
autosampler, as shown below.

Figure 4-7 Positions for solutions on the autosampler

Note The 1.5-mL tube in position 3 should not be a screw-cap tube. The 
screw-cap tube is too high to clear the electrode and capillary. Use a 1.5-mL 
Eppendorf tube with the lid clipped off for position 3.

! WARNING ! CHEMICAL HAZARD. Some chemicals used with this 
instrument are potentially hazardous. Warnings are prominently displayed on 
the bottle labels of all hazardous chemicals. Material Safety Data Sheets 
(MSDSs) are provided by the manufacturer and contain information about 
physical characteristics, hazards, precautions, first aid, spill cleanup, and 
disposal procedures. The MSDSs can be kept in the Safety Supplement 
provided with the chemistry guide. Please familiarize yourself with the 
information contained in these documents before attempting to operate the 
instrument or using hazardous reagents. Additional copies of the MSDSs for 
Applied Biosystems chemicals are available from Applied Biosystemsat no 
cost.

3 Attach the anode buffer reservoir containing the buffer solution to the pump block.

4 Load samples in the autosampler tray.

5 Press the Tray button to bring the autosampler platform forward and install the tray 
on the platform.

6 Press the Tray button to move the autosampler back.

To load the autosampler: (continued)

Step Action

Position Volume Vial Solution

1 4.0-mL buffer vial Electrophoresis buffer

2 4.0-mL buffer vial Deionized water

3 1.5-mL Eppendor
f tube

Deionized water

4,5, 6 Not Currently Used

1 2 3 4 5 6
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How to Shut Down the Genetic Analyzer

What is a
Short-Term

Shutdown

A short-term shutdown is typically for no more than two days and used to conserve 
power.

The key to a short-term shutdown is keeping the capillary in solution. This prevents 
polymer from drying in the capillary.

Performing a
Short-Term

Shutdown

To perform a short-term shutdown:

About a Long-Term
Shutdown

A long-term shutdown is appropriate when you want to turn off the 310 Genetic 
Analyzer for more then two days.

You may need to refer to the following procedures:

continued on next page

Step Action

1 Shut down the Macintosh® computer.

2 Turn off the 310 Genetic Analyzer. 

The LED status lights will turn off.

3 Store the ends of the capillary in solution.

You can store the capillary on or off the Genetic Analyzer. 

For more information, see:

� “Storing the Capillary Off the Instrument” on page 4-16 or,

� “Storing the Capillary On the Instrument” on page 4-16.

4 Close the instrument doors. 

Procedure See page

Removing the Capillary for Long-term Storage 4-15

Removing the Pump Block 4-7

How to Remove the Syringe 4-18

How to Clean the Pump Block 4-8

Cleaning and Preparing the Syringe for Use 4-19

Executing Functions 5-15

Starting a Run Module 5-15
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Performing a
Long-Term

Shutdown

To perform a long-term shutdown:

Step Action

1 Remove the capillary, syringe, and pump block. 

2 Wash the syringe and pump block.

3 Re-install the pump block and the capillary.

4 Fill the syringe with distilled and deionized water and attach it to the pump block.

5 Flush the capillary by running the Run Seq Fill Capillary module or the Syringe 
Down function in Manual Control. 

The polymer in the capillary will be flushed to the waste tube on the autosampler. 

6 Press the Tray button to present the autosampler.

7 Shut down the Macintosh® computer.

8 Turn off the 310 Genetic Analyzer.

9 Remove the capillary and store it.

10 Take the following actions:

a. Remove all chemistry and samples from the autosampler. 

b. Wipe the autosampler, trays, drip tray, and electrode with lab wipes dampened 
with water.
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How to Reset The Genetic Analyzer

About Firmware Firmware is software stored and executed in the 310 Genetic Analyzer’s battery 
backed-up memory. It communicates with the software on the Macintosh® computer, 
enabling the system to function together.

Types of Resets There are three types of reset:

When to Reset You should reset the 310 Genetic Analyzer when you experience the following 
situations:

Troubleshooting
with Resets

Perform the various types of resets in this order to resolve a problem with the Genetic 
Analyzer:

� Soft reset

� Cold boot

� Clear Memory

Call Technical Support if the problem persists after a Clear Memory reset.

continued on next page

Type of reset Result

Soft Re-starts the firmware.

Cold Deletes the firmware and reloads it.

Clear Memory Deletes the firmware and calibration data and reloads the firmware.

You must re-enter the calibration data manually.

Reset the... If...

310 Genetic Analyzer � It is behaving unpredictably.

� It does not respond to software 
commands.

Macintosh® computer and the 310 Genetic 
Analyzer

They are not communicating correctly

Note If No Port is selected in the General 
Settings in Preferences, the Macintosh® and 
310 Genetic Analyzer cannot communicate. 
Check this setting and select Modem before 
resetting.
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Performing a Soft
Reset

To do a soft reset:

Performing a Cold
Boot

Performing a Cold Boot through Manual Control

Performing a Cold Boot if Manual Control is not Working

continued on next page

Step Action

1 Push the reset button on the back of the 310 Genetic Analyzer with a pointed 
object, such as a pen.

2 Quit the ABI PRISM® 310 Data Collection Software.

3 Re-launch the Data Collection program.

4 Open the Manual Control window, choose Syringe Home, and click Execute.

5 In the Manual Control window, choose:

� Autosampler Home X,Y, and click Execute.

� Autosampler Home Z and click Execute. 

Step Action

1 Open the Manual Control Window.

2 Select Cold Boot Instrument from the pop up menu.

3 Click Execute.

4 Open the Manual Control window, choose Syringe Home, and click Execute.

5 In the Manual Control window, choose:

� Autosampler Home X,Y and click Execute.

� Autosampler Home Z and click Execute.

Step Action

1 Quit the ABI PRISM® 310 Data Collection Software.

2 Shut down the Macintosh® computer.

3 Turn off the 310 Genetic Analyzer. 

4 Hold the Tray button down for ten seconds while you turn on the Genetic Analyzer. 

This deletes the firmware. 

The three lit LED status lights indicate the absence of firmware.

5 Restart the Macintosh® computer and launch the Data Collection software. 

A dialog box appears as the firmware reloads.

6 Open the Manual Control window, choose Syringe Home, and click Execute.

7 In the Manual Control window, choose:

� Autosampler Home X,Y and click Execute. 

� Autosampler Home Z and click Execute.
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Performing a Clear
Memory Reset

Recording the Calibration Data

Resetting the 310 Genetic Analyzer

Step Action

1 Open Manual Control and record the values for:

� CCD Pixel Position X

� CCD Pixel Position Y

� Syringe Pump Force

� Syringe Max Travel

IMPORTANT Since a Clear Memory reset will delete the calibration data, it is 
imperative that you record the current calibrated values. If you forget to record this 
data before a Clear Memory reset, a service engineer will need to reestablish the 
calibration values. You can find calibration data on the calibration sticker, through 
Manual Control, or through LabView software. In this procedure, you will record the 
values manually and as a Calibration File.

2 In Manual Control, select Calibration File Make.

3 Quit the ABI PRISM® 310 Data Collection Software and shut down the Macintosh® 
computer.

4 Turn off the 310 Genetic Analyzer.

Step Action

1 Hold the Tray and Gel buttons down for ten seconds while you turn on the Genetic 
Analyzer. 

This will delete the firmware and clear the RAM. 

The three lit LED status lights indicates the absence of firmware.

2 Restart the Macintosh® computer and launch the ABI PRISM® 310 Data Collection 
Software. 

A dialog box will appear as the firmware reloads.

3 Open the Manual Control window and manually re-enter the calibration values for:

� CCD Pixel Position X (horizontal)

� CCD Pixel Position Y (vertical)

� Syringe Pump Force

� Syringe Max Travel

or choose Calibration File Send.

4 Choose Syringe Home and click Execute.

5 In the Manual Control window, choose: 

� Autosampler Home X,Y and click Execute. 

� Autosampler Home Z and click Execute.

6 Calibrate the autosampler. 

See “Calibrating the Autosampler” on page 4-28.

7 Wait 10 minutes after a Clear Memory reset to allow the temperature circuitry to 
calibrate before starting a run.
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Recovering from a Power Failure

Overview The 310 Genetic Analyzer and the Macintosh® computer can automatically recover 
from a power failure and continue a run. The Macintosh® computer must be properly 
configured for automatic recovery.

IMPORTANT Under power down or power fail situations, the autosampler drops, exposing 
an open end of the capillary to air. Check the EPT file during the next electrophoresis to be sure 
the capillary is carrying current. Polymer may have dried in the capillary and created a blockage 
that requires cleaning or replacement.

How the Genetic
Analyzer and

Macintosh Recover
from a Power

Failure

When the 310 Genetic Analyzer starts a run, the ABI PRISM® 310 Data Collection 
Software automatically creates a recovery file in the ABI PRISM® 310 folder. Data 
about the status of the run is continuously recorded in this recovery file.

When a power failure occurs, the run stops and the autosampler drops. The capillary 
is exposed to air.

When the power comes back on, the Macintosh® computer and the 310 Genetic 
Analyzer restart. The Data Collection software will review the recovery file and resume 
the run.

About the Recovery
File

The recovery file is a temporary file that is created at the start of every run and deleted 
when the run ends. It contains information necessary to recover from a power failure.

Do not throw away the recovery file, unless the recovery file is not deleted at the end 
of a run, and you are certain that a run is not in progress or waiting to be resumed.

After a Power
Failure

Check the current in the Status window when the run resumes. If it is below 4 
microamps, then its likely the polymer in the capillary dried out. This happens if the 
capillary is exposed to air for longer than 30 minutes.

Try clearing and refilling the capillary if the current is too low. However, in most cases, 
you will have to replace the capillary.

How to Configure
Your Macintosh for

Power Failure
Recovery

You must configure the Macintosh® computer so that it can automatically recover from 
a power failure.

Step Action

1 Open the General Controls control panel.

The shut down warning must be off.

2 Open the Energy Saver control panel.

Automatic restart must be on.

The sleep timer must be set to never.

3 An alias of the ABI PRISM® 310 Data Collection Software must be in the Start-up 
Items folder.
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In This Chapter Topics in this chapter include the following:
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How to Fill Out an Injection List 5-21

Displaying Raw Data 5-27
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About ABI PRISM 310 Data Collection Software

Overview The ABI PRISM® 310 Data Collection Software provides instructions to firmware 
running on the instrument and displays instrument status and raw data in real time. As 
the instrument records sample fluorescence on the detection system hardware, the 
Data Collection software running on the Macintosh® computer collects the data, 
interprets it, and stores it to the computer’s hard drive.

Four Key Tools in
the Software

To successfully run the ABI PRISM® 310 Genetic Analyzer, you need to know how to 
operate four key tools in the Data Collection software:

� Manual Control

� Sample Sheets

� Injection Lists

� Raw Data Display

Data Collection
Allows

The following table lists the functions you can do with the ABI PRISM® 310 Data 
Collection Software.

How to Find Files When files are stored on a Macintosh® disk or hard drive, the user organizes them by 
saving each one in a folder with related files. The organization of the disk can be taken 
a step further by gathering related folders together inside yet another folder.

continued on next page

monitor � Instrument Status.

� Electrophoresis History.

� Instrument Log.

automatically � Start the ABI PRISM® DNA Sequencing Analysis Software or the 
GeneScan® Analysis Software.

� Direct Analysis programs to print the data.

If... Then...

you want the location of 
a file that is not open

a. Select Find from the Macintosh® File menu. 

b. Use the pop-up menus to search the hard drive, attached 
servers, floppy disks, or the desktop. 

Search by name, date created, or other attributes of the file 
that you remember.

a file is open the name of the file and its location are displayed at the top of the 
window.

The name of the hard disk is displayed first. Folders and 
sub-folders are listed, separated by colons (:). 

For example, if the top of the window reads “Hard Disk:ABI Prism 
310®:Sample Sheets:Sample Sheet A”, a file named Sample 
Sheet A is located inside a folder named Samples Sheets, which 
is inside a folder named ABI Prism 310®, which is on the 
Macintosh drive named Hard Disk.
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About Sample
Sheets

The Sample Sheet is a form that you fill out in the ABI PRISM® 310 Data Collection 
Software to name each sample, associate it with a position in the autosampler, and 
make some choices about the sample’s processing.

There are four kinds of Sample Sheets:

� Sequencing 48 sample tubes

� Sequencing 96 sample tubes

� GeneScan® 48 sample tubes

� GeneScan® 96 sample tubes

From the Sequencing Sample Sheets, you select a:

� Mobility file (Dye Set/Primer file)

� Matrix file

About Injection
Lists

The Injection List is a form that you fill out in the Data Collection software to direct the 
processing of your samples. 

The Injection List automatically pulls sample names and associated tube positions 
from a Sample Sheet and lists them as sequential injections to the capillary.

Other information pulled from the Sample Sheet or created by the Injection List is 
displayed according to settings in the Injection List preference files.

Run parameters for each injection and the order of the injections can be changed by 
editing the Injection List.

You begin the run by clicking the Run button in the Injection List.

Two Kinds of
Injection Lists

There are two kinds of Injection Lists:

continued on next page

From this Injection List... You select a...

Sequencing � Sample Sheet

� Module file

GeneScan � Sample Sheet

� Module file

� Matrix file

� Analysis Settings file

� Size Standard file
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About Run Folders The data from each sample is stored in a sample file.

Sample files from the same run are stored in a Run folder.

Data Collection automatically creates a Run folder to hold the sample files when you 
fill out a new Injection List.

About Preference
Files

Preference files set: 

� Where the software looks for files

� How files are named

� Default settings for Sample Sheets and Injection Lists

� Macintosh®/310 Genetic Analyzer communications port

� Starting number for automatic file numbering

� How dyes are represented on screen and paper
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How to Install and Configure Data Collection Software

Installing Data
Collection Software

The Installer disk is shipped with the instrument. The Field Service Engineer installs 
310 Data Collection on the Power Macintosh® when setting up the 310 Genetic 
Analyzerr in your laboratory. Keep the Installer disk as a back up copy.

Reinstalling the Data
Collection Software

To reinstall your ABI PRISM® 310 Genetic Analyzer:

Installing Run
Modules and

Mobility Files

From time to time, you may need to add files for new applications that have been 
released since the software was written. User Bulletins may inform you of a new 
application requiring updated run module and mobility or dye set/primer files. If so, the 
files are available on disks from local representatives or through the Applied 
Biosystems web site at www.appliedbiosystems.com/techsupport.

To install these run modules and mobility files:

continued on next page

Step Action

1 Insert the Installer disk into the Macintosh® computer.

2 Double click the Installer icon.

3 Click Continue on the splash screen.

4 Click Install on the dialog box.

5 Follow the prompts.

Step Action

1 Copy the run modules into the Module folder within the Collection software folder.

2 Copy the mobility files into the ABI folder within the System folder.

3 Relaunch the Collection and/or Analysis software if either was open while the files 
were installed.
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Setting Macintosh
General Controls

About the General Controls

The Macintosh’s General Controls allows you to:

� Set a default preference for the folder to which a file will be saved

� Disable the improper shut down warning dialog box that appears when a 
Macintosh restarts after a power failure

Note Disable the shut down warning, as it interferes with the Data Collection software’s 
ability to resume after a power failure.

Setting the Macintosh General Controls

\

About Virtual
Memory

Turn Virtual Memory off. The software programs for the 310 Genetic Analyzerr are not 
tested for operation with Virtual Memory on.

About Extension
Manager

Extension Manager is a Macintosh® utility that allows you to turn off start-up 
programs. Some start-up programs (also known as inits) and control panel programs 
can conflict with the ABI PRISM® 310 Genetic Analyzer Software. 

If you believe a program to be the source of a conflict, turn it off using Extension 
Manager and restart the computer. Refer to the documentation shipped with the 
Macintosh for more instructions on Extension Manager.

Setting
PrintMonitor

Preferences

About the PrintMonitor

PrintMonitor is a Macintosh® program used to control all printing functions.

If you reinstall the Macintosh operating system, you will need to set the Preferences 
for the PrintMonitor program. PrintMonitor's Preferences must be set so that printing 
problems do not give alerts. Printing problem alerts open a dialog box on the 
computer screen and suspend all data collection until the problem is solved and the 
dialog box is closed.

Set Preferences as described here so the Macintosh® operating system can indicate a 
printing problem without suspending data collection. You can solve the problem when 
discovered, and the run in progress is not interrupted. The data is spooled to the 
printer and prints after the problem is solved.

Step Action

1 Choose Control Panels from the Apple  Menu.

2 Open General Controls. 

3 In the Documents box, select “Folder that is set by the application.” 

4 In the Shut Down Warning box, uncheck the “Warn me if the computer was shut 
down improperly” checkbox.
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Setting the PrintMonitor’s Preferences

The setting Display icon in menu bar allows the run to continue.

PrintMonitor is further described in the documentation shipped with your computer.
z

Setting Background
Printing

Set Background Printing to On in the Chooser (in the Apple  menu).

Step Action

1 Find the PrintMonitor program in the Extensions folder inside the System folder. 

2 Double-click on PrintMonitor. 

3 Select Preferences under the File menu. 

4 Set the Preferences as shown: 
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ABI PRISM 310 Data Collection Preference Files

Overview The Preferences dialog boxes are under the Window menu. Through these dialog 
boxes you select defaults–the files and locations that the Data Collection software will 
automatically use unless directed to do otherwise.

The preference files are:

� Folder Locations

� Default File Names

� Sequence Sample Sheet Defaults

� GeneScan Sample Sheet Defaults

� Sequence Injection List Defaults

� GeneScan Injection List Defaults

� General Settings

� Dye Indicators

Folder Location
Preferences

The Folder Location preferences file point the Injection List where to find the:

� Sample Sheet folder

� Module folder

� Folder Containing Run folders

� Analysis Settings folder (this folder contains mobility files, matrix files, and 
analysis settings files)

� GeneScan Parameters folder

� GeneScan Size Standard folder

The name in the button identifies the path to a folder. The files in that folder will appear 
in the pop-up menu on the Injection List.

continued on next page

Identifies the path
to a folder 
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File Names
Preferences

The Data Collection software automatically creates and names certain files. Your 
preferences for automatic file naming can be entered in this part of the Data Collection 
software.

Choose none, today’s date, or global serial number as a file name suffix from the 
pop-up menus.

The names you enter into the fields can only have alphanumeric characters. Do not 
use non-alphanumerics such as # * , ( . ) ! : . Such characters can disrupt the 
automatic creation of files.

Sample Sheets
Preferences

When you create a new Sample Sheet, a portion of the form is automatically filled in 
for you. The information comes from a preference file, which you can modify. 

Sequencing Analysis Software

For Sequencing Sample Sheets, set these Sample Sheet preferences:

Preference Description

Dye Set/Primer Default Dye Set/Primer file that will automatically appear on a 
newly-created Sample Sheet.

Matrix Default Matrix file that will automatically appear on a 
newly-created Sample Sheet.
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GeneScan Analysis Software

For GeneScan Sample Sheets, set the Size Standard Dye Color. This is the default 
dye color that will automatically be selected as the color for the size standard on a 
newly-created Sample Sheet.

Injection List
Preferences

When you create a new Injection List and choose a Sample Sheet, the software 
automatically fills out the Injection List from the Sample Sheet. You can set how you 
want the software to fill out the Injection List through the Injection List Preferences.

The Page pop up menu lets you go to another preferences page.

Sequencing Analysis Software

For Sequencing Injection Lists, set the following preferences:

Sequencing Injection List preferences. 

Preference Description

Length To Detector The distance between the end of the capillary that is in the 
sample and the capillary window. 

Enter the length that will automatically appear on a newly-created 
Injection List.

The length you enter does not affect the configuration of the 
instrument. It’s for your record-keeping purposes only.

Operator. Enter the name of the operator that will automatically appear on a 
newly-created Injection List.
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GeneScan Analysis Software

For GeneScan Injection Lists, set the following preferences:

 Module File.  A module file contains the instructions that tell the 310 Genetic 
Analyzer how to run a sample. 

It includes such things as injection time, voltage, and heat plate 
temperature. 

Choose here the default module file that will automatically appear 
on a newly-created Injection List.

Autoanalyze Automatically analyzes your samples using the analysis program 
you specify in the pop-up menu. 

Check the box to have Autoanalysis automatically enabled on a 
newly-created Injection List. From the pop-up menu, choose the 
software program you want to use to analyze your data.

Autoprint. Automatically prints your analyzed data. 

Check the box to have autoprint automatically enabled on a 
newly-created Injection List.

GeneScan Injection List. 

Preference Description

Length To Detector The distance between the end of the capillary that is in the 
sample and the capillary window. 

Enter the length that will automatically appear on a newly-created 
Injection List. 

The length you enter does not affect the configuration of the 
instrument. It’s for your record-keeping purposes only.

Operator Enter the name of the operator that will automatically appear on a 
newly-created Injection List.

Sequencing Injection List preferences. (continued)

Preference Description
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General Settings General Settings sets preferences for communication between the Macintosh® 
computer and the 310 Genetic Analyzer and sets up automated file numbering.

Module File  A module file contains the instructions that tell the 310 Genetic 
Analyzer how to run a sample. 

It includes such things as injection time, voltage, and heat plate 
temperature. 

Choose here the default module file that will automatically appear 
on a newly-created Injection List

Matrix File. A matrix file contains an algorithm that adjusts the data for 
spectral overlap of the fluorescent peaks in a dye set. 

Choose here the default matrix file that will automatically appear 
on a newly-created Injection List.

Autoanalyze Automatically analyzes your samples using the analysis program 
you specify in the pop-up menu. 

Check the box to have Autoanalysis automatically enabled on a 
newly-created Injection List. 

From the pop-up menu, choose the software program you want to 
use to analyze your data.

Analysis Parameters 
File

Holds the default start and stop point for data analysis, the default 
peak height threshold, and the default size calling method.

Size Standard File Holds the results of a run performed with fragments of known 
length. 

The file can be used to analyze other runs performed under the 
same conditions to determine the size of fragments of unknown 
length.

Autoprint Automatically prints your analyzed data. 

Check the box to have autoprint automatically enabled on a 
newly-created Injection List.

GeneScan Injection List. (continued)

Preference Description
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The following are the General Settings preferences.

Dye Indicators
Preferences

The Dye Indicators dialog box allows you to change:

� Dye Code

� Dye Color

� Plot Color

Preference Description

Page Use pop-up menu to view other preferences pages.

Global Serial Number Files can be automatically numbered. 

This is the starting point for automated numbering here. 

Set which files to include in automatic numbering through the File 
Names preferences page.

Communication Port Tell the Data Collection software which communications port 
(modem or printer) on the Macintosh® is connected to the 310 
Genetic Analyzer.

 

If you are using... Then...

for normal use Set to Modem

the printer port for diagnostics 
or communication

Go to the Chooser (in the 
Apple  menu) and turn 
AppleTalk off.

the Data Collection software 
when the Macintosh® is not 
connected to a 310 Genetic 
Analyzer

Choose No Port

When No Port is selected, the 
Macintosh® will not 
communicate with the 310 
Genetic Analyzer or generate 
alert messages about failed 
communication.
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The following are the Dye Indicator preferences.

Preference Description

Dye Code A single letter, usually related to the dye’s representational color 
or its name. 

To change the dye code, type a new letter in the code box.

Dye Color The color displayed on the computer screen to represent 
fluorescence from that dye. 

To change the color used to represent a dye, choose a new color 
from the pop-up menu.

Plot Color Color displayed on the printed electropherogram to represent 
fluorescence from that dye. \

To change the color used to represent a dye, choose a new color 
from the pop-up menu.

Reset To Factory 
Settings

Click to set all the codes and colors back to their factory settings.
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Using Manual Control

Overview Manual Control is in the Window menu.

Manual Control allows you to manually operate functions and some run modules. 

Functions are specific mechanical tasks, such as moving the autosampler, moving the 
syringe, and turning the laser on and off. 

Modules are files that tell the 310 Genetic Analyzer how to run a sample. Module files 
execute a series of functions.

Executing Functions To execute a function:

Starting a Run
Module

To start a module:

Step Action

1 Choose the function from the Manual Control pop-up menu.

2 Some functions require a value (such as temperature in °C or voltage in kV) to 
work. If the function you choose requires a value, enter it in the Value field.

3 Click the Execute button to start the function.

Step Action

1 Choose the module file you want to run from the pop-up menu. 

Note The pop-up menu will display the contents of the modules folder selected 
as the default in Folder Location preferences. To use a modules file in a folder other 
than the default folder, choose Other from the pop up menu and locate the file.

2 Click the Start button to start the module.

3 To pause or cancel a running module, click the Pause or Cancel buttons.
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How to Edit Modules

Editing Modules You can customize module files to optimize your runs. It is possible to modify the 
module files supplied with the software, but we recommend that you make copies and 
modify them.

To edit a module:

Editable Parameters The parameters that can be edited differ from module to module. You may be able to 
edit: 

� Injection time

� Injection voltage

� Run voltage

� Run temperature

� Run time

� Syringe pump time

� Pre-injection electrophoresis time

� Prerun time

Except syringe pump time, pre-injection electrophoresis, and prerun time, the 
parameters above can be altered for individual samples through the Injection List 
without permanently modifying the module. See “About Editing the Injection List” on 
page 5-23.

The Settings dialog box cannot be printed. The Log file contains the Injection List 
parameters used with the sample and it can be printed.

continued on next page

Step Action

1 Locate the module file in a folder on the Macintosh® hard drive. Select it by clicking 
once.

2 In the Macintosh® File menu, choose Duplicate to create a copy of the module file.

3 Give the copy a descriptive file name.

4 Double click the copy. This opens a Settings dialog box.

5 Edit the values you wish to change.

6 Click the Save as Default button. This will save your new settings.

Note The Save as Default button is enabled only for unlocked files. The original 
module files are locked, but copies are not locked. The Use Settings button is 
enabled only when an Injection List is open. 
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Editing Modules
Using Manual

Control

Through the Manual Control window, you can customize module files to optimize your 
runs. It is possible to modify the module files supplied with the software, but we 
recommend that you make copies and modify them.

To edit a module:

Editable Parameters The parameters that can be edited differ from module to module. You may be able to 
edit: 

� Injection time

� Injection voltage

� Run voltage

� Run Temperature

� Run time

� Syringe pump time

� Pre-injection electrophoresis

� Prerun time

Except syringe pump time, pre-injection electrophoresis, and prerun time, the 
parameters above can be altered for individual samples through the Injection List 
without permanently modifying the module. See “About Editing the Injection List” on 
page 5-23.

continued on next page

Step Action

1 Locate the module file in a folder on the Macintosh hard drive. Select it by clicking 
once.

2 In the Macintosh File menu, choose Duplicate to create a copy of the module file.

3 Give the copy a descriptive file name.

4 Open the Manual Control window.

5 Choose the copy from the pop-up list in Manual Control.

6 Click the page icon. This opens a Settings dialog box.

7 Edit the values you wish to change.

8 Click the Save as Default button. This will save your new settings.
Using Data Collection Software 5-17



About Module
Parameters

The following parameters can be changed only by editing a module.

Parameter Description

Syringe Pump Time This is the time used to fill the capillary with polymer.

You may wish to experiment with slightly shorter times to 
maximize throughput.

Pre-injection 
Electrophoresis

Pre-injection electrophoresis is a prerun of the refilled capillary 
for ion equilibration, before samples are electrokinetically 
injected.

Prerun Time After electrokinetic injection, the sample is electrophoresed prior 
to data collection at the running voltage. 

This improves resolution of peaks and stability of electrical 
current during the run. 

You you may wish to experiment with increased prerun times to 
improve peak resolution and current stability for some samples.
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How to Fill Out a Sample Sheet

Sequencing Sample
Sheets

Drag the column markers at the top of columns to change their width.

To fill out a sequencing Sample Sheet:

Dye Set/Primer

The Dye Set/Primer file contains mobility correction data for the sample. Note that the 
Dye Set/Primer file choice must be consistent with the sequencing reaction chemistry, 
polymer, and filter set.

Matrix

The Matrix file contains data that corrects for spectral overlap between the fluorescent 
dyes.

GeneScan Sample
Sheets

Drag the column markers at the top of columns to change their width.

To fill out a GeneScan Sample Sheet:

Step Action

1 Choose New from the File menu. 

2 In the dialog box, click the appropriate icon for either a 48- or 96-well sample tray 
Sample Sheet. A Sample Sheet opens.

3 Type the name of your sample in the Sample column. 

4 Choose the Dye Set/Primer and a Matrix file for your sample. Enter comments for 
the sample in the Comments field.

5 Repeat this process for all the samples.

6 When finished, save the Sample Sheet. We recommend that you save it to the 
default Sample Sheet folder.

Step Action

1 Choose New from the File menu. 

2 In the dialog box, click the appropriate icon for either a 48- or 96-well sample tray 
Sample Sheet. A Sample Sheet opens.

3 Type the name of your sample in the Sample column. 

4 Identify the size standard color by clicking in the Std column. A diamond appears 
next to the color used for the size standard.

5 Indicate the colors present in the sample by checking boxes in the Pres column.

6 Enter sample information into the Sample Info column, and any comments in the 
Comments column.

Note The Genotyper™ software requires that you fill out the Sample Information 
column. See the Genotyper DNA Fragment Analysis Software User’s Manual.

7 Repeat this process for all the samples.

8 When finished, save the Sample Sheet. We recommend that you save it to the 
default Sample Sheet folder.
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Color

These are the colors of your dyes. You set them in the Dye Indicators preferences.

Std

A marker appears in this column to indicate that a particular dye in your sample is a 
standard. Click in the box to turn it on or off.

Pres

This checkbox indicates that a sample or standard is present for that dye. 

If you do not choose to launch and run ABI PRISM® GeneScan® Analysis Software 
automatically, or if you re-analyze data later, you can make changes to this selection 
through the analysis software. Raw data is collected for all colors, but only the colors 
for which a sample is present are automatically analyzed by ABI PRISM® GeneScan® 
Analysis Software. 
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How to Fill Out an Injection List

Filling Out a
Sequencing Injection

List

To complete a sequencing Injection List:

There is a shortcut if several samples require the same module:

Sequencing Injection
List Fields

Drag the column markers at the top of columns to change their width.

Step Action

1 Choose New from the File menu.

2 In the dialog box, click the Sequence Injection List icon. This will create the folder 
for the run and open the Sequence Injection List.

3 Choose the Sample Sheet for the experiment from the pop-up menu. This will 
automatically transfer the Sample Sheet information to the Injection List.

4 For each sample, choose a module file from the pop up menu in the Module 
column. The default set in the Preferences will automatically appear.

5 Check the AutoAnlz box to automatically launch Sequencing Analysis software.

6 Check the AutoPrt box to automatically print the data

Step Action

1 For the first sample in the Injection List that requires the module, use the pop up 
field to select it.

2 Select the module fields for all the subsequent samples that require that module.

3 Choose Fill Down from the Edit menu. All selected module fields will be filled in with 
the module.

Fields in the Injection List form. 

Field Description

Sample Sheet Displays the selected Sample Sheet.

Page Icon Opens the selected Sample Sheet.

Length to Detector The distance between the end of the capillary that is in the 
sample and the capillary window. The length you enter will not 
affect the configuration of the instrument. It is for record-keeping 
purposes only.

Operator The name you enter here will appear on printed data.

Tube and Sample Name The sample’s name and position in the autosampler.

Module The file that contains the specific functions executed to process 
samples.

Inj Secs The duration of the injection in seconds.

Inj kV The voltage during the injection in kilovolts.

Run kV The voltage during the run in kilovolts.

Run °C  The temperature of the heat plate during the run in degrees 
Celsius.

Run Time The duration of the data collection in minutes. This is less than 
the total run time.

AutoAnlz Determines if raw data is automatically analyzed by the 
Sequence Analysis software.
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Filling Out a
GeneScan Injection

List

Drag the column markers at the top of columns to change their width.

Completing a GeneScan Injection List

Using the Fill Down Function

There is a shortcut if several samples require the same files:

continued on next page

AutoPrt Determines if analyzed data is automatically printed.

Finish Time Displays the time raw data collection for the sample finished.

Fields in the Injection List form. (continued)

Field Description

Step Action

1 Choose New from the File menu.

2 In the dialog box, click the GeneScan Injection List icon. This will create the folder 
for the run and open the GeneScan Injection List.

3 Choose the Sample Sheet for the experiment from the pop-up menu. This will 
automatically transfer the Sample Sheet information to the Injection List.

4 For each sample, choose:

� A module file from the pop up menu in the Module column

� A matrix file from the pop up menu in the Matrix file column

� An Analysis Parameters file from the pop up menu in the Analysis Parameters 
column

� A Size Standard file from the pop up menu in the Size Standard column

These are filled out automatically if the Injection List Preferences have been set.

5 Check the AutoAnlz box to automatically launch the GeneScan® Analysis Software.

6 Check the AutoPrt box to automatically print the data

Step Action

1 For the first sample in the Injection List that requires the file, use the pop up field to 
select it.

2 Select the field for all the subsequent samples that require that file.

3 Choose Fill Down from the Edit menu. All selected fields will be filled in with the file.
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GeneScan Injection
List Fields

The fields in the Injection List form are:

About Editing the
Injection List

Change Run Parameters

After a module is selected in the Injection List, the following fields are automatically 
filled in with information from the module:

� Injection time

� Injection voltage

� Run voltage

� Run Temperature

� Run time

You can edit these parameters by selecting a field and typing in a new value. This 
changes the run conditions for one run. It does not permanently alter the module. 

For information about editing a module, see “Editing Modules Using Manual Control” 
on page 5-17.

Fields in the GeneScan Injection form. 

Field Description

Sample Sheet Displays the selected Sample Sheet.

Page icon Opens the selected Sample Sheet.

Length to Detector The distance between the end of the capillary that is in the 
sample and the capillary window. The length you enter in the 
Injection List will not affect the physical configuration of the 
instrument. It is for record-keeping purposes only.

Operator The name you enter here will appear on printed data.

Tube and Sample Name The sample’s name and position in the autosampler.

Module The file that contains the specific functions executed to process 
samples.

Inj Secs The duration of the injection in seconds.

Inj kV The voltage during the injection in kilovolts.

Run kV The voltage during the run in kilovolts.

Run °C  The temperature of the heat plate during the run in degrees 
Celsius.

Run Time The duration of the data collection in minutes. This is less than 
the total run time.

Matrix File The matrix file to be used.

AutoAnlz Determines if raw data is automatically analyzed by the 
GeneScan® Analysis Software.

Analysis Parameters The parameters file to be used.

Size Standard The size standard file to be used.

AutoPrt Determines if analyzed data is automatically printed.

Finish Time Displays the time raw data collection for the sample finished.
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Change Order of Samples

The injections are sequentially numbered. In the Tube and Sample Name column, use 
the pop up menus to select a sample for each injection. 

Remember that the samples in the tray must match the positions in the Injection List.

Lines in the Injection List can be cut from one location and pasted into another. 
Holding down the option key when selecting an injection number selects the whole 
line.

Add a Line to the Injection List

Choose Insert from the Edit menu after selecting an injection. The new line will add 
above the selected injection.

Do not add lines above an injection that is running.

Run a Sample More Than Once

The injections are sequentially numbered. Add a line to the Injection List. Use the pop 
up menus in the Tube and Sample Name column to select the sample for more than 
one injection or copy and paste the entire injection on the new line.

Change the Module for a Sample

Use the pop up menu in the Module column to select a module.

Change Sample Sheet Items from the Injection List

The following files on a Sample Sheet can be changed after viewing the Sample Sheet 
from the Injection List:

� Dye Set/Primer

� Matrix

� Analysis parameters

� Size standard

The color of standards and which colors are present in a sample can be changed on 
GeneScan Sample Sheets.

Changing Items on the Sample Sheet from the Injection List

Note It is not possible to add samples to a Sample Sheet once it has been saved to a folder.

continued on next page

Step Action

1 Click the Page icon to view the Sample Sheet from the Injection List.

2 Change the Sample Sheet.

3 Save the Sample Sheet.

4 From the Injection List, select Sample Sheet <none>.

5 Re-select the Sample Sheet from the Injection List.
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About Run
Parameters

Electrokinetic Injection (Voltage and Time)

The electrokinetic injection time and voltage can be varied to regulate the amount of 
DNA brought into the capillary for analysis. 

The objective is to inject into the capillary just enough signal for adequate peak height 
(good signal to noise) while minimizing the peak widths.

There are no specific requirements for the voltage and current during the 
electrokinetic injection. Injections at 200 volts/cm are not distinguishable from 
injections at 25 volts/cm; however, a lower voltage and current are preferred since 
timing of the injection is more accurate.

Typically, a voltage of 50 volts/cm is used for the electrokinetic injection. At this value 
injection times of 5–60 seconds are required to obtain adequate peak height, 
depending on the application. Excessive injection time can cause loss of resolution.

Electrophoresis Running Voltage: Sequencing

Resolution and base calling are better at lower field strengths. Increasing the field 
strength allows shorter run times, but reduces base calling accuracy.

For Sequencing Samples using... The standard running voltage is...

DSP 160 volts/cm. 

For a 47-cm capillary, this translates to 7.5 
kV. 

The current at this voltage is 7–10 µA. 

The time required for a 450 base fragment to 
reach the detector window is about 135 
minutes with these run conditions.

POP-6 and long-read sequencing is 200 volts/cm. 

For a 61-cm capillary, this translates to 12.2 
kV. 

The current at this voltage is 4–6 µA. 

The time required for a 600 base fragment to 
reach the detector window is about 120 
minutes with these run conditions.

POP-6 and RAPID sequencing, s 320 volts/cm. 

For a 47-cm capillary, this translates to 15 
kV. 

The current at this voltage is 5–8 µA. 

The time required for a 400 base fragment to 
reach the detector window is about 35 
minutes with these run conditions.
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Electrophoresis Running Voltage: GeneScan Analysis Software

For GeneScan samples using POP-4, the standard running voltage is 319 volts/cm. 
For a 47-cm capillary, this translates to 15 kV. The current at this voltage is 8–9 µA. 
The time required for a 400bp fragment to reach the detector window is about 25 
minutes with these run conditions.

Resolution is better at lower field strengths. Increasing the field strength allows shorter 
run times, but reduces resolution.

Electrophoresis Temperature

The heat plate of the instrument is routinely set at 50 °C for Sequencing Analysis 
applications and 60 °C for denaturing GeneScan® Analysis Software applications.

The temperature limits of the heat plate are 60 °C down to 5 °C above room 
temperature.

Electrophoresis Running Time

You can change the running time for special requirements. For example, you can 
shorten the data collection time if you only need information about short extension 
products.

Typically, set the electrophoresis running time at an interval 10% higher than the 
average migration time of the maximum fragment size of interest to ensure sufficient 
data collection.

Starting the Run To begin a run, click the Run button on the Injection List.
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Displaying Raw Data

Overview During a run you can monitor:

� Real-time raw data

� Instrument status

� Instrument errors

The Raw Data
Window

The Raw Data window shows data detected as it passes the capillary window, with a 
different colored line representing each filter. The computer simultaneously updates 
the Raw Data window with four lines every few seconds during instrument operation.

Choose Raw Data from the Window menu.

Resizing Raw Data Double-click the left side of the Raw Data window to display the Set Scale dialog box 
where you can enter values to scale the Raw Data.

Why Raw Data and
Analyzed Data
Differ in Color

The colors in the real-time data display differ from the colors in the display of data after 
analysis. 

The ABI PRISM® 310 Data Collection Software defines specific areas on the CCD 
camera from which to collect light intensities. These areas correspond to different 
wavelengths of light. The result is similar to using a physical filter to separate the light 
wavelengths. This is referred to as a “virtual” filter, since no physical filtering hardware 
is used.

On the real-time display (the Raw Data window), the data collection software displays 
these intensities, color-coded according to wavelength. Blue, green, yellow, and red 
(in that order) represent the wavelengths of the dye emissions within each dye set. 
Blue represents the shortest wavelength, and red represents the longest. The colors 
on the real-time displays therefore represent the relative wavelengths of the dyes 
being detected.
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A virtual filter set represents the relative wavelengths of the dye set as blue, green, 
yellow, and red regardless of the absolute value of the wavelengths in nanometers. 
The colors do not represent actual wavelengths. They represent the relative 
wavelengths of the four dyes in each dye set.

Each of the chemistries is associated with a dye set. The relative wavelengths of the 
dye labels are not consistent across dye sets. Therefore the color associated with a 
base in the raw data depends on the chemistry used to label it.

The analysis software may re-assign the colors to standardize data collected with 
different labelling chemistries.

Data Display after
Analysis:

Sequencing

The analysis program converts the information collected by the Data Collection 
software, so that after analysis the color assigned to a base is consistent regardless of 
the sequencing chemistry used for labelling:

Virtual Filters for
DNA Sequencing

In sequencing applications, the dyes corresponding to the colors in the raw data are 
listed below.

Virtual Filters for
GeneScan

In GeneScan® Analysis Software applications, the dyes corresponding to the colors 
are listed below.

Color of 
Analyzed Data Base

Blue  C

Green A

Black G

Red T

Color

Virtual Filter A Virtual Filter E

Dye Primer Dye Terminator

dRhodamine Terminators 
BigDye™ Primers, or BigDye™ 

Terminators

Blue 5-FAM R110 dR110

Green JOE R6G dR6G

Yellow TAMRA TAMRA dTAMRA

Red ROX ROX dROX

Color

Corresponding Dye

Virtual Filter A
Virtual Filter 

C
Virtual Filter 

D
Virtual Filter 

F

Blue 5-FAM or R110 6-FAM 6-FAM 5-FAM

Green JOE or R6G TET HEX JOE

Yellow TAMRA HEX NED NED

Red ROX TAMRA ROX ROX
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How to Display Run Status and History

Observing
Instrument Status

During a run, the current status of the instrument is displayed in the Status window. 
Choose Status from the Window menu.

The Status window displays: 

� Time remaining in the current function.

� Actual electrophoresis voltage, heat plate temperature, and laser power.

� Set points for the electrophoresis voltage, heat plate temperature, and laser 
power.

� Actual electrophoresis current.

The Status window is updated about once per second.

The Log File The Log file contains a comprehensive record of all error and status messages 
generated by the Data Collection software during a run. A Log file is created for each 
run and stored in the Run folder. 

The Log File records:

� The injection parameters.

� Electrophoresis parameters.

� Instrument status at a few different times during data collection for each sample.

� The module.

� Total number of data points collected for each sample.

The Log File is useful for troubleshooting. If there is a problem with the data, compare 
the information recorded in the Log File against your expectations for the run. Was a 
parameter set incorrectly? Was the wrong module selected? Does a component of the 
instrument fail to reach the set parameters?

Choose Log from the Window menu to view the Log file. The Log file is a text file. Only 
32K of the Log file can be viewed from Data Collection. If it is larger than 32K, open it 
in a word processing application to view the complete file.
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The information in the file is formatted as follows:

The entry in the first column, xxx, is variable. The possible entries are:

Electrophoresis
History

The Electrophoresis History window plots the actual values for the electrophoresis 
power supply, laser power, and heat plate temperature over the course of the run. The 
information in the Electrophoresis History Window is stored in each sample file.

Choose Electrophoresis History from the Window menu during a run to view the 
Electrophoresis History.

xxx  month/day/year  hour:minute:second  Description of event

Entry Meaning

… System start, system stop or file created

--> message sent to instrument

<-- message received from instrument

*** warning

### Macintosh or instrument error
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The amps, volts, laser mW, and temperature scales are adjustable. The pop-up 
windows for adjusting scale overlay the history window, and all four are identical.

Adjusting the Amp, Volts, Laser, and Temperature Scales.

Step Action

1 Double-click one of the fields in the window, or click a field once and choose Scale 
from the Edit menu. 

The Set Scale dialog box appears.

2 In the fields of the Set Scale dialog box, type the scale’s maximum and minimum 
values.

3 Click OK.

Click here to adjust scale

Time scale

Heat plate temp

Laser power

EP Current

EP Voltage

Click here to adjust scale
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How to Import and Export Files

Importing Files You can import from tab-delimited text files into the grids of the Sample Sheet and 
Injection List windows. 

Each row in the text file should contain the information for one row in the grid in the 
same order as the columns of the grid. Everything up to the first tab in the text file is 
imported into the first field in the grid.

Importing Tab-Delimited Text Files into Data Collection Software Windows

Exporting Files Use the Export command to save the contents of a window grid (for example, from the 
Sample Sheet or the Injection List) into a tab-delimited text format. This format is 
useful with most database, word processing, or spreadsheet programs.

To export information to tab-delimited text format:

Step Action

1 Open the window into which you wish to import information, and click the top left 
column of the grid.

2 Choose Import from the File menu.

3 In the dialog box that appears, choose the name of the file containing the text you 
wish to import.

4 Click OK.

Step Action

1 Click the window containing the information you wish to export, to make it active. 
The window must be one of the windows containing a grid. 

It is the information in the grid that is exported.

2 Choose Export from the File menu.

3 Type a file name in the dialog box that appears.

4 Click OK.
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Recovery Files

About Recovery
Files

The 310 Genetic Analyzer is designed to resume operation after power failure. To 
resume the run, the instrument must have some record of the instrument status at the 
moment power failed. 

At the start of a run, the Data Collection software creates a temporary file called the 
Recovery file. This file is updated continuously during the run. If the laboratory loses 
power, the instrument status is saved in the Recovery file. The 310 Genetic Analyzer 
searches for the Recovery file when power is restored and uses the information in it to 
resume the run at the correct step.

What to Do with
Recovery Files

Do nothing with the Recovery file. The 310 Genetic Analyzerr will delete the Recovery 
file when the run ends. If the Recovery file has not been deleted, but you are certain 
that a run is neither in progress nor waiting to be resumed, put the Recovery file in the 
Trash.

About Matrix Files

Why You Need
Matrix Files

A good matrix file is required to analyze raw data.

Each fluorescent dye contains components of other colors. A matrix file corrects for 
this spectral overlap in the filter set. This is an example of a matrix file:

The amount of blue color in the blue dye, green color in the green dye, etc., is forced to 
1.00 when the software creates a matrix.

The amount of green, yellow, and red in the blue dye is determined and recorded in 
the matrix file. The same process is repeated for the other dyes. The overlap will be 
subtracted from the data peaks when the matrix is applied, allowing the analysis 
software to “call the peaks, that is, identify the predominant dye in a fluorescent peak.

How Many Matrix
Files?

Create a separate matrix file for each run condition that affects the collection of 
spectra. Some examples are:

� A new dye is used.

� The pH of polymers or buffers has changed.

� A different type of polymer is used.

Run the matrix standards under the sample run conditions and make a matrix file. Use 
that matrix file to analyze any and all samples run under those conditions.

Color Blue Green Yellow Red

Blue 1.0000 0.3952 0.0587 0.0010

Green 0.6592 1.0000 0.7803 0.0082

Yellow 0.3161 0.4388 1.0000 0.0382

Red 0.1120 0.2042 0.6178 1.0000
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Introduction

In This Chapter Topics in this chapter include the following:

Topics See page

General Care 6-2

Caring for the Pump Block 6-3

Caring for the Electrode 6-3

Caring for the Autosampler 6-4

Caring for the Glass Syringe 6-5

Loading Enough Polymer 6-6

How to Manually Test the Autosampler Calibration 6-6

How to Check for Polymer Leaks 6-7

How to Avoid Capillary Clogs 6-10

Monitoring Communication Between the Macintosh Computer and the 
Instrument

6-11

How to Maintain and Care for Your Macintosh Computer 6-12
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General Care

Laboratory
Temperature

Ensure that the ambient temperature is between 15 and 30 °C whenever the 
instrument is in operation, including nights and weekends.

Do not keep the instrument in direct sunlight or under heating or air conditioning vents.

Laboratory
Humidity

Ensure that the humidity is below 80%. Avoid excessive condensation on the 
instrument.

Voltage Spikes Do not plug the Macintosh® computer and 310 Genetic Analyzer into the same circuit 
used by other laboratory devices, especially centrifuges, refrigerators or freezers. 
Ensure that the circuit is grounded. Check with your laboratory’s building facilities 
personnel if you have questions about the quality of power in your laboratory.

Put the Macintosh® computer and 310 Genetic Analyzer on a line conditioner or an 
uninterruptible power supply if voltage spikes and power outages are a persistent 
problem.

Cleaning Clean the electrode, heat plate, and autosampler often to avoid the build up of 
conductive debris that causes arcing. Wiping with a water-dampened lab wipe is 
sufficient.

Clean the pump block as often as recommended. Polymer that dries in the pump block 
can be difficult or impossible to remove.

Protect the instrument from excessive dust.

Cables Avoid twisting power cords around 310 Genetic Analyzer data communication cables. 
Power cords can affect the performance of computer cables.

The distance over which data communications are reliable depends upon both 
networking protocol and the type and quality of the cable. Connect the 310 Genetic 
Analyzerr and the Macintosh® computer that is collecting data with no more than six 
feet of cable. Use the cables provided with the instrument.
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Caring for the Pump Block

When to Clean the
Pump Block

Clean the pump block when:

� Installing the syringe.

� Removing the capillary.

� Changing between the ABI PRISM® DNA Sequencing Analysis Software and the 
GeneScan® Analysis Software applications

� Shutting down the instrument.

� The instrument has run for 4 days without any of the above occurring.

It is especially important to clean the pump block if a syringe containing polymer was 
installed on the block for more than a week. At room temperature, sufficient urea 
decomposition occurs in one week to cause transient current increases during 
electrophoresis.

IMPORTANT If polymer is allowed to dry in the pump block channels, the pump block may 
be ruined. It can be difficult or impossible to resolubilize dried polymer. Clean the pump block as 
often as recommended.

Do not clean the pump block with organic solvents or boiling water.

For more information, see “Cleaning the Pump Block” on page 4-8.

Caring for the Electrode

How to Avoid
Bending the

Electrode

Always recalibrate the autosampler if the cathode electrode is removed, replaced, or 
cleaned.

The electrode may bend if:

� A screw top tube is used in position 3 of the autosampler.

� The Z position of the autosampler is homed before the X, Y positions.

� The autosampler is not properly calibrated.

� Keys are held down when moving the autosampler with keyboard equivalents.

� The electrode is too long. The electrode should be flush with the translucent 
stripper plate.

Read “Autosampler Overview” on page 4-24, “How to Home the Autosampler” on 
page 4-26, and “How to Calibrate the Autosampler” on page 4-27 for instructions on 
operating the autosampler correctly.

Cleaning the
Electrode

Clean the electrode if it has been touched, if it is new, when autosampler buffer 
solutions are replaced, or every 48 hours. Crystals formed on the electrode can fall 
into the sample and clog the capillary.

Since the capillary is removed from buffer while the electrode is cleaned, complete the 
procedure quickly, so that the capillary does not dry out.
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Caring for the Autosampler

When to Calibrate
the Autosampler

The autosampler calibration settings are maintained in the permanent memory of the 
instrument. 

Recalibrate:

� After changing the electrode.

� After changing the capillary.

� If the capillary and the septa caps collide.

� After a reset that clears memory.

� When prompted by the instrument.

IMPORTANT The sample tray and Eppendorf tube must be removed before calibrating the 
autosampler. If the sample tray is not removed, the electrode will be bent.

An autosampler that is not calibrated can cause damage to the cathode electrode, 
capillary, and autosampler, and can result in poor data collection—or no data—due to 
improper capillary position in a sample tube.

When to Clean the
Autosampler

Remove dried buffer from the autosampler with a water-dampened lab wipe at least 
once a week.

! WARNING ! Salt accumulation on the autosampler can cause arcing during 
electrophoresis.
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Caring for the Glass Syringe

General Care Syringe barrels and plungers are matched at the factory. Keep barrels and plungers as 
a set.

The glass syringes are fragile. Do not drop them.

About Syringe
O-Rings

Inspect the two o-rings for degradation before each use. Replace them if they appear 
cracked, torn, flattened or otherwise worn.

About Syringe
Plungers

Always lubricate the plunger with water before inserting it into the barrel.

IMPORTANT Moving the plunger up and down in the barrel when the parts are dry will 
damage the syringe.

When to Clean the
Syringe

Thoroughly clean the syringe whenever it is removed from the pump block.

Verify that the syringe is clean before use.

How to Store the
Syringe

Syringe barrels and plungers are matched at the factory. Keep barrels and plungers as 
a set. Do not mix up barrels and plungers during storage.

Store the syringe away from direct sunlight. Sunlight degrades plastics.

Store the syringe dry. Lubricate the plunger with water before inserting it or moving it 
up and down in the barrel.

O-rings
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Loading Enough Polymer

Running Out of
Polymer During a

Run

If the instrument runs out of polymer during an injection, the injection is cancelled. An 
alert appears on the Macintosh® computer screen.

Check the Log file. Injections that last 1–2 minutes and Out of Polymer errors are 
recorded there when the syringe empties.

Starting a Run
without Enough

Polymer

The run will not start if the syringe encoder indicates that the syringe is located more 
than 500 steps from the Home position, because there is not enough polymer for the 
number of injections indicated in the injection list.

If the run will not start, remove the syringe and pump block and take the following 
actions:

How to Manually Test the Autosampler Calibration

Manually Test the
Autosampler

Calibration

The electrode and capillary must be immersed in the sample during electrokinetic 
injection. Minimum sample volume is 10-µL. Briefly microcentrifuging the sample to 
bring it to the bottom may be necessary.

If the electrode and capillary do not make contact with the sample, current problems 
and low signal problems can result.

To manually test that the autosampler calibration is allowing the capillary and 
electrode to make contact with your samples:

Action See page

Clean the pump block 4-8

Clean the syringe 4-19

Step Action

1 Put an empty tube in position A5 of the autosampler.

2 Open Manual Control from the Window menu of Data Collection software.

3 Use the Autosampler to Position function to send the autosampler to position A5.

4 Execute the Autosampler Up function.

5 Use the Autosampler Z Max Travel function to lower capillary and electrode into the 
tube.

6 Visually inspect the depth of the capillary and electrode in the tube.
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How to Check for Polymer Leaks

Overview Leaks can cause high rates of polymer consumption. 

Severe leaks usually mean one or more of the manual valves are not closed. 

Leaks may also occur at the ferrule sealing the capillary to the pump block, at the 
Teflon seal of the plunger in the glass syringe or at the valve to the buffer reservoir.

Check the base of the glass syringe for polymer leaks (visible as a white residue), 
especially at the interface between the glass barrel and the metal tip.

About the Leak
Detect Error

If the instrument pauses with a Leak Detect error message, check for:

� Polymer leaks

� Bubbles in the glass syringe

Bubbles in the glass syringe will compress as the syringe tries to inject polymer into 
the pump block and capillary. The software assumes the syringe travel for 
compressing the bubble is for polymer delivery. More than 15 counts on the syringe 
drive encoder triggers a Leak Detect error. These counts might be the result of 
compressing a bubble in the syringe.

Avoid bubbles in the glass syringe when filling it with polymer.

Checking for Leaks Run the Seq Fill Capillary module to check for leaks:

continued on next page

Step Action

1 Open the ABI PRISM® 310 Data Collection Software and the Manual Control 
window.

2 Press the Tray button. 

The autosampler tray moves forward.

3 Place a small tube containing 0.5-mL of water in tube position 3 in the front of the 
autosampler.

4 Press the Tray button again to move the autosampler back to its original position.

5 Select Seq Fill Capillary from the Module pop-up menu on the Manual Control 
screen.

6 Note the position of the end of the glass syringe plunger and write it down.

7 Click Start.

8 After the module has run, again note the position of the plunger, and subtract it from 
the initial value. 

The module should consume 4 - 7 µL of polymer per 10-minute fill. Check for leaks 
if more than 7-µL of polymer was consumed.
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Correcting Leaks at
the Syringe

To correct leaks at the syringe:

=

Correcting Leaks at
the Valve to the

Buffer Reservoir

To correct leaks at the valve to the buffer reservoir:

Step Action

1 Replace the syringe if polymer leakage is: 

� Excessive past the plunger’s seal.

� Between the metal collar and the glass barrel.

Loss of only a few microliters of polymer out of a full syringe is normal and 
acceptable.

2 If polymer has leaked from the base of the glass syringe, check for the presence of 
two o-rings and a plastic ferrule. 

Replace the o-rings if they are worn. 

O-rings Metal collar and glass barrel

Step Action

1 Remove the pump block and rinse it with warm water.

2 Flush the pump block channel to the anode buffer reservoir with warm water and 
take the following actions (see figure below):

a. Attach a 5-mL plastic syringe filled with warm water to the pump block.

b. Plug the other pump block openings with plugs provided in the Basic 
Installation Kit. 

c. Clean each pump block channel with distilled, deionized water, removing and 
replacing plugs to direct the water through each channel in turn. 

d. Clean the channel to the buffer reservoir thoroughly.

e. Re-install the block on the instrument.
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If the Buffer
Reservoir Fills Up

If the buffer reservoir is filling up, check for:

� Leaks at the valve to the buffer reservoir.

� Bubbles in the glass syringe.

Bubbles in the syringe compress and expand. During expansion, they can drive 
polymer into the buffer reservoir.

3 If leaks continue at the buffer reservoir valve, contact an ABD Service 
Representative.

Step Action

Channel to the anode 
buffer reservoir

Buffer reservoir
valve
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How to Avoid Capillary Clogs

Verifying That the
Capillary Fills

Correctly

Capillaries used with Performance Optimized Polymers are uncoated. A proper coat of 
polymer is especially important for these capillaries. Routinely check that capillaries fill 
properly.

To determine if the capillary is filling properly, check the Log File. The syringe drive 
encoder should move one or two counts per injection for the 1.0-mL syringe.

 

Avoiding Capillary
Clogs

Clogged capillaries cause current problems during electrophoresis. 

If there are... This...

zero counts Indicates that the capillary did not fill and 
may be clogged.

more than 15 counts May indicate a polymer leak. 

For more information, see “Checking for 
Leaks” on page 6-7.

Cause Prevention

Proteins Purify your DNA templates.

Run samples with TSR to avoid drawing protein into the capillary.

Large molecular weight 
DNA

Purify your DNA templates.

Run samples with TSR to avoid drawing large molecular weight 
DNA into the capillary.

Bacteria Use deionized, distilled water. Water is the most common source 
of bacterial contamination.

Crystallized buffer or 
polymer

Clean the electrode every two days.

Check for crystals at the connection of the glass syringe and 
pump block.

Bring polymer to room temperature before use.

Do not expose the end of a filled capillary to air for more than 30 
minutes.
6-10 Maintenance



Monitoring Communication Between the Macintosh Computer and the 
Instrument

About the
Communications

Diagnostics Window

The window shows information for all Send and Reply messages since the ABI 
PRISM® 310 Data Collection Software was last launched.

The window displays the:

� Number of messages

� Number of characters

� Duration of last message in milliseconds

� Number of retries

� Number of serial errors

Large numbers of retries indicate poor cable routing (see “Cables” on page 6-2), 
broken pins on connectors, or bad cables.

Serial retries indicate broken pins on connectors or bad cables.

Long duration for replies indicates a Macintosh® serial driver problem. 

Take the following actions:

� Resetting the PRAM (see “Resetting the Macintosh PRAM” on page 6-13).

� Reloading the Mac OS.

Accessing the
Communications

Diagnostics Window

Accessing the Communications Diagnostics Window

To access the Communications Diagnostics window, the Status window must be 
active. Open or click on the Status window before trying to access the 
Communications Diagnostics window. 

Opening the Communications Diagnostics window

Hold down the control and option keys simultaneously.

If there is no communication, the Communications Diagnostics window is not 
accessible.
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How to Maintain and Care for Your Macintosh Computer

Overview Computers require regular attention and maintenance to operate efficiently and 
consistently. 

Because the ABI PRISM® 310 Genetic Analyzer software on the Macintosh® computer 
works with large files and accesses the hard disk often, it is especially important to 
follow the procedures described here to minimize errors during operation. 

Hard Disk
Maintenance

Follow these guidelines for optimal performance of the ABI PRISM® 310 Genetic 
Analyzer programs and the Macintosh® computer.

� Install only one System on a hard disk.

� Back up all programs and files regularly.

� Use a hard disk maintenance program (such as Norton Utilities) regularly to 
reorganize a fragmented disk. 

The Norton Utilities program is provided with the 310 Genetic Analyzer.

� Use discretion when adding software programs, especially Control Panels and 
extension files.

Each of these guidelines is discussed in more detail below.

Only One System File Required

The Macintosh® requires only one System file to operate. This System file is located in 
the System Folder on the hard disk and is essential for all operations. 

You do not receive a System file with the ABI PRISM® 310 Genetic Analyzer programs, 
but other applications might furnish an additional System file. If you copy a program to 
your hard disk, avoid copying additional System files. 

For more complete information about the System file and the System Folder, refer to 
the manuals that came with the computer.

Regularly Backing Up All Programs and Files

Although the hard disk is extremely reliable, it is still subject to the whims of fate and 
power. Always back up your computer’s hard disk so you do not lose the data you 
have spent hours collecting and analyzing. Keep the back ups in a safe place.

When you use the ABI PRISM® 310 Data Collection Software and analysis programs 
regularly, a large number of data files may accumulate on your hard disk and consume 
available disk space. Make floppy copies of the data files you use infrequently, and 
remove the originals from your hard disk to reclaim storage space for future work.

Using a Hard Disk Maintenance Program Regularly

Whenever files are written to the hard disk, opened and rewritten, their physical 
location on the disk changes. This “fragments” the disk. If a significant amount of 
fragmentation occurs, the system runs slowly, and files may be lost. Protect your data 
by running a disk optimizer program at least once a month.
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Use Discretion When Adding Software Programs

� Keep an anti-viral software application loaded on your hard disk and use it to 
inspect your hard disk either when you start up or shut down (at least once a day). 

Viruses can simply be annoying, but they can also, in the worst case, destroy all 
information stored on your hard disk. This could include the System software, ABI 
PRISM® 310 Genetic Analyzerr software, and data files.

� Use the Macintosh® computer only for ABI PRISM® 310 software. Prevent program 
conflicts before they occur. Do not load games or other software programs onto 
your hard disk.

� Do not use any Extensions or games (this includes custom start-up sounds and 
graphics) other than those that came on your original System Disk, or on the 
ABI PRISM® 310 software disks.

Eliminating
Conflicts Between

Inits

Use the Extension Manager control panel to select a group of extensions that starts 
up with conflicting inits. Refer to the documentation shipped with the Macintosh® 
computer for more instructions on Extension Manager. The best practice is to avoid 
using the Macintosh® computer for anything except Applied Biosystems software.

How to Turn Off All Extensions

You can turn off all Extensions by holding down the Shift key while you restart your 
computer. (You will need to restart it again to turn them back on.) Start the Macintosh® 
computer with all Extensions off if you suspect that programs are conflicting. If the 
problem disappears, an “init” conflict is the likely source.

Resetting the
Macintosh PRAM

Restart the Macintosh while holding down these four keys:

� Apple ()

� Option

� p

� r

When to Reset the
Macintosh PRAM

Reset the PRAM if the Macintosh® computer:

� Crashes

� Gives Type 11 error messages

� Has problems communicating through the serial port

� Gives Coprocessor Not Found messages

Resetting the PRAM on a regular basis may help prevent errors. Consult the 
information provided with your computer.

continued on next page
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Communication Port
Settings

In General Settings (in the Preferences menu of Data Collection software), choose the 
modem port for optimum communication between the instrument and Macintosh® 
computer.

Turn AppleTalk off if the Macintosh® printer and instrument Diagnostic ports are 
connected. 

EtherTalk will default to the printer port if the network is disconnected or down. If the 
Macintosh® computer is not connected to an Ethertalk network, do not select the 
Ethertalk protocol in the Network or AppleTalk control panels (in the Macintosh® Apple 
 menu).

The Macintosh® computer locks up if AppleTalk or EtherTalk try to use the Macintosh® 
printer port when it is connected to the instrument Diagnostic port.
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7
Troubleshooting 7
Introduction

In This Chapter Topics in this chapter include the following:

Topics See page

How to Troubleshoot Data 7-2

Problems with Automatic Data Analysis 7-3

Problems with Current 7-4

Problems with Signal Strength and Quality 7-6

Problems with Peak Number and Position 7-10

Problems with Peak Quality and Resolution 7-14

Problems with Poor Amplification 7-16

Problems with Extra Peaks 7-20
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How to Troubleshoot Data

Troubleshooting
Data

When troubleshooting 310 Genetic Analyzer problems:

Check Our Web
Address

Often a small amount of time invested in troubleshooting a problem yourself can save 
you inconvenience. Our site on the World Wide Web includes answers to frequently 
asked questions and allows downloads of software upgrades. 

Of course, Applied Biosystems Field Application Specialists, Technical Support 
Specialists, Field Service Engineers and Sales Representatives are available to fully 
support the 310 Genetic Analyzer. Please contact the nearest Applied Biosystems 
office, visit us on the Web atwww.appliedbiosystems.com/techsupport, or call us 
toll-free in the U.S.

Step Action

1 Understand:

� The chemistry

� Labeling of the samples

� How the 310 Genetic Analyzerr collects data

� How the data analysis software programs work

Review the experiment for errors in primer design, sample quantitation and 
purification, pipetting problems, software preference settings and other common 
mistakes.

2 Examine the data. Describe the problem as specifically as possible:

� Is it a problem with the sample peaks, the baseline, or the peaks of only one 
color?

� Does the problem exist in all parts of the run or does it affect only DNA 
fragments of a certain length?

� Is the problem visible in raw data? analyzed data? log files?

Continue to ask these types of questions until you have described the problem as 
specifically and thoroughly as possible.

3 List possible causes of the problem. See the troubleshooting tables in this chapter 
for help.

4 For each “possible cause” you have listed, ask:

Does other information support or contradict this as the cause of the problem?

5 If necessary, collect more information to narrow the list of possible causes.

6 Correct the problem and test the fix.
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Problems with Automatic Data Analysis

Problems with automatic data analysis. 

Observation Possible Causes Recommended Actions

Data was not 
automatically 
analyzed

Sample Sheet not completed or 
completed incorrectly

Review and correct Sample 
Sheet

Injection List not completed or 
completed incorrectly

Complete Injection Lists as 
described

Analysis preferences set 
incorrectly in 310 Data Collection 
software

Check the ABI PRISM® 310 Data 
Collection Software preferences:

Select Autoanalyze with 
GeneScan® Analysis Software 
under the GeneScan® Injection 
List Defaults

Select Autoanalyze with 
ABI PRISM® DNA Sequencing 
Analysis under the Sequencing 
Injection List Defaults

Insufficient free RAM Restart computer before 
collecting data

Note Always restart the 
computer before collecting data.

Conflicting extensions (inits) Choose Extensions Manager 
from the Control Panels. Turn off 
any conflicting extensions and 
restart computer. 

See “How to Maintain and Care 
for Your Macintosh Computer” on 
page 6-12.
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Problems with Current

Problems with current. 

Observation Possible Causes Recommended Actions

No current Too little or no buffer in anode 
buffer reservoir

Replenish buffer reservoir.

Too little or no buffer in 
autosampler position 1

Replenish buffer in position 1 of 
autosampler.

Electrode bent a. Remove electrode.

b. Straighten electrode.

c. Replace electrode.

d. Recalibrate autosampler.

Capillary bent away from 
electrode

a. Tape capillary securely to heat 
plate to keep capillary from 
shifting position. 

b. Recalibrate autosampler.

Unfilled capillary, bubbles in 
capillary and block

a. Examine the instrument for 
leaks. See “How to Check for 
Polymer Leaks” on page 6-7. 

b. Rerun module.

Pump block is plugged with 
urea or crystallized buffer

Remove and clean block. 

Loose valve fittings or syringe Tighten valve fittings and syringe.

Anode buffer valve does not 
open

Open buffer valve:

a. Push down on the valve with 
your finger.

b. Release the valve. It should 
spring to the “open” position.

Note If the valve is stuck, it 
should be cleaned. See 
“Correcting Leaks at the Valve to 
the Buffer Reservoir” on page 6-8 
for directions.

Plugged, broken, or 
nonconducting capillary

Replace the capillary.

Poor quality water in buffer 
solutions

Remake buffer with fresh distilled, 
deionized water.

Old, defective, or incorrectly 
made buffer or polymer 

Replace buffer or polymer.

Corrupted firmware Resend firmware.
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Low current Small bubble in capillary 
blocking current flow

Rerun module.

Plugged, broken, or 
nonconducting capillary

Replace the capillary.

Poor quality water in buffer 
solutions

Remake buffer with fresh distilled, 
deionized water.

Old, defective, or incorrectly 
made buffer or polymer 

Replace buffer or polymer.

Fluctuating current Too little buffer in anode buffer 
reservoir

Replenish buffer reservoir.

Small bubble in capillary 
blocking current flow

Rerun module.

Broken or cracked capillary Replace the capillary.

Arcing to conductive surface on 
the instrument

a. Clean the heat plate, 
electrode and autosampler.

b. Ensure that the ambient 
temperature is between 15 
and 30 °C and the humidity is 
below 80%. Check for 
excessive condensation on 
the instrument.

Current is normal 
at beginning of run 
and then 
decreases rapidly 
over the next 
several minutes

Loss of anode buffer capacity Replace the buffer.

Overloaded capillary a. Use TSR or formamide.

b. Decrease the electrokinetic 
injection time or voltage.

Current too high Decomposition of urea in the 
polymer

a. Clean the syringe and pump 
block.

b. Install new polymer.

Incorrect buffer formulation 
(most likely too concentrated)

Replace buffer with appropriate 1X 
running buffer.

Arcing to conductive surface on 
the instrument

Clean the heat plate, electrode and 
autosampler.

Ensure that the ambient 
temperature is between 15 and 
30 °C and the humidity is below 
80%. Check for excessive 
condensation on the instrument.

Problems with current. (continued)

Observation Possible Causes Recommended Actions
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Problems with Signal Strength and Quality

Problems with signal strength and quality. 

Observation Possible Causes Recommended Actions

No signal No sample added a. Check pipet calibration.

b. Examine the efficiency of 
the PCR and/or cycle 
sequencing reactions.

c. Remake sample.

Template not accurately quantitated 
(DNA sequencing)

Quantitate template. Refer to 
the sequencing kit protocol for 
appropriate DNA quantities.

Sample not at bottom of tube Spin sample tube in 
microcentrifuge.

Air bubble at bottom of sample tube Spin sample tube in 
microcentrifuge to remove air 
bubbles.

Volume of sample too low Sample volume must be at 
least 10-µL.

Capillary misaligned with cathode Align capillary and cathode. 

Note The capillary should 
be adjacent to, but not 
touching, the cathode. The 
capillary should protrude 
0.5 mm past the cathode.

Capillary bent out of sample tube Align capillary and cathode. 
Recalibrate autosampler.

Verify whether a bent capillary 
is the problem by watching:

� The movement of the 
autosampler tray during 
run operation.

� For injection current and 
EP current during data 
collection.

Autosampler not calibrated 
correctly

Calibrate autosampler in X, Y, 
and Z directions.

IMPORTANT The 
capillary should almost touch 
the Z calibration point.

Sealed sample tube septum (that 
is, septum will not open to allow 
electrode into sample tube)

You can either:

� Replace septum or, 

� Open the septum by 
pinching it.

Septum not placed in the sample 
tube properly

Replace septum.

Insufficient injection time Increase the electrokinetic 
injection time or voltage.
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Signal too low Insufficient sample added a. Check pipet calibration.

b. Examine the efficiency of 
the PCR and/or cycle 
sequencing reactions

c. Remake sample

Dust or particulates have collected 
on the capillary window and or the 
internal optics

Clean window with ethanol and 
a Kimwipe.

If no improvement, contact 
your service representative to 
clean the internal optics.

Capillary not correctly aligned in the 
window

Align capillary in window. 

See “Procedure for Positioning 
the Capillary in the Detector” 
on page 4-13.

Volume of sample too low Sample volume must be 10 µL.

Samples added to formamide that 
has degraded to formic acid and 
formate ions (leading to injection of 
insufficient sample)

Use freshly deionized 
formamide. See “Denaturing 
and Loading Samples” on 
page 2-40 or 3-28.

Salts in sample (leading to injection 
of insufficient sample)

 Remove ions by:

� Dialyzing sample

� Ethanol precipitation

� Spin column purification

Sample not thoroughly mixed Mix sample by pipetting up and 
down several times.

Template not accurately quantitated 
(DNA sequencing)

Quantitate template. Refer to 
the sequencing kit protocol for 
appropriate DNA quantities.

Insufficient [F]dNTPs added to PCR 
reaction (GeneScan®)

Reamplify using more 
[F]dNTPs or examine the 
efficiency of the PCR.

Capillary and/or electrode not 
immersed in sample

Recalibrate the autosampler.

Insufficient injection time Increase the electrokinetic 
injection time or voltage.

CCD camera not calibrated Contact you r service 
representative.

Problems with signal strength and quality. (continued)

Observation Possible Causes Recommended Actions
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Signal too high Too much sample injected into 
capillary

Decrease injection time or 
injection voltage.

Dilute sample.

Reamplify using less [F]dNTPs 
(GeneScan®)

Unincorporated [F]dNTPs 
(GeneScan® Analysis Software)

Purify the PCR product.

Unincorporated ddNTPs (ABI 
PRISM® DNA Sequencing Analysis 
Software)

Use ethanol precipitation or 
spin column purification

Signal too high in 
first part of run 
(sequencing)

Excess DNA template depletes 
nucleotides in reaction mix, leading 
to excess of short fragments 

Quantitate template. Refer to 
the sequencing kit protocol for 
appropriate DNA quantities.

Peak height 
decreases 
throughout run

Sample evaporation Use septa.

High baseline Dirty capillary window Clean capillary window using 
95% ethanol and lint free 
paper.

Dirty syringe Clean the syringe with warm 
water.

Dirty pump block Clean the pump block with 
warm water as described in 
Chapter 4.

Capillary moved out of position in 
front of detector window

Position capillary in front of 
laser window.

Precipitate in polymer Allow polymer to equilibrate to 
room temperature before 
using.

Old, defective, or incorrectly made 
buffer or polymer 

Replace buffer and polymer.

Dirty detector window Clean the detector window 
carefully using lense paper.

Defective capillary Replace the capillary.

Matrix made incorrectly resulting in 
too much correction (indicated by 
troughs under peaks)

Note Matrix problems only show 
in analyzed data and not the raw 
data.

Remake matrix. 

Be sure to:

� Remove primer peak (or 
aberrant off-scale peaks) 
from scan range.

� Pick start and stop points 
on flat parts of the 
baseline when viewing 
raw data.

� Make matrix using same 
polymer, buffer, and run 
conditions as sample 
injections.

Problems with signal strength and quality. (continued)

Observation Possible Causes Recommended Actions
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Noisy baseline Old, defective, or incorrectly made 
buffer or polymer 

Replace buffer or polymer.

Weak or low signals and or an 
elevated baseline

See “Problems with Signal 
Strength and Quality” on 
page 7-6.

A noisy baseline in raw data could 
be electrical noise

Contact your service 
representative.

Dirty detector window Clean the detector window.

Plugged, broken, or nonconducting 
capillary

Replace the capillary.

Salts in sample (leading to injection 
of insufficient sample)

 Remove ions by:

� Dialyzing sample.

� Ethanol precipitation.

� Spin column purification.

Capillary not refilling a. Check for leaks.

b. Check for bubbles in the 
syringe.

c. Replace capillary if 
clogged.

d. Increase capillary refill 
time.

Spikes in baseline Precipitate in polymer Allow polymer to equilibrate to 
room temperature before 
adding to capillary.

Old polymer (POP 4™ or POP 6™) Use fresh polymer.

Low baseline with 
no color separation

Laser problem Contact your service 
representative.CCD problem 

Cap misaligned Ensure that the window is in 
the groove in the front of the 
laser.

Problems with signal strength and quality. (continued)

Observation Possible Causes Recommended Actions
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Problems with Peak Number and Position

Problems with peak number and position. 

Observation Possible Causes Recommended Actions

Extra peaks in 
additional colors 
displayed 
underneath each 
peak.

Note This 
shows up clearly in 
analyzed data and 
may not be an 
obvious problem in 
the raw data. This 
is because it is 
common to have 
extra peaks in other 
colors displayed in 
the raw data.

Too much sample injected into 
capillary

Problem with sample preparation. 
See “Problems with Extra Peaks” 
on page 7-20.

Decrease injection time or 
injection voltage.

Dilute sample.

Too little sample injected into 
capillary (matrix overcorrects)

Increase injection time or 
injection voltage.

Quantitate DNA in sample. 
Refer to protocol for correct 
quantity.

Incorrect matrix chosen Check matrix selection on 
Injection List.

If correct, you may want to 
create a new matrix.

Incorrect Run Module Filter set 
chosen

Verify module filter set with 
dyes being run with charts on 
page 2-43 and page 3-26.

Wrong filter set used

Many small 
extraneous peaks 
appearing next to a 
high-intensity peak

Background above Minimum Peak 
Height value.

Increase value for Minimum 
Peak Height. Reanalyze data.

Sample DNA overloaded. 
(Extraneous peaks represent 
nonspecific DNA comigrating with 
main fragment peak.)

Load less sample and repeat 
electrophoresis. 

Too much sample injected into 
capillary

Decrease injection time or 
injection voltage.
7-10 Troubleshooting



Extra peaks when 
sample is known to 
contain DNA from a 
single source

Samples not fully denatured Make sure the samples are 
heated at 95 °C for five 
minutes prior to loading onto 
autosampler. 

Unoptimized PCR Check efficiency of the PCR. 
See ABI PRISM® GeneScan 
Chemistry Guide for detailed 
suggestions.

Renaturation of denatured samples Load samples immediately 
following denaturation, or store 
on ice until you are ready to 
load.

IMPORTANT Do not store 
samples on ice for more than 
two hours before loading.

Note Too much DNA also 
promotes renaturation, but 
before you add less DNA you 
will need to assess the signal 
strength and quality.

Extra peaks are 1-4 
nt larger or smaller 
than expected peak 
(GeneScan®)

PCR artifact Refer to Troubleshooting PCR 
Amplification on page 7-16.

Size-standard 
peaks not 
recognized when 
defining size 
standard 
(GeneScan®)

Height of a size-standard peak less 
than the Peak Amplitude Threshold 
for the size-standard color (in 
Analysis Parameters)

Note 50 RFU is the default 
threshold

Rerun sample, adding the 
recommended amount of size 
standard.

Lower the value for the 
size-standard color in the Peak 
Amplitude Threshold field. 

Peaks missing from size-standard 
definition.

Check GeneScan® Analysis 
Parameters to make sure the 
correct scan range is defined.

Minimum Peak Half Width is set too 
high (in Analysis Parameters)

Lower the value for the 
Minimum Peak Half Width.

Problems with peak number and position. (continued)

Observation Possible Causes Recommended Actions
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Peak positions off 
throughout size 
range 
(GeneScan®)

Note Refer to 
the ABI PRISM® 
GeneScan 
Chemistry Guide 
for detailed 
information on 
factors that affect 
sizing.

Incorrect Sample Sheet Check Sample Sheet selection 
in data collection program.

Change in size-calling method. Use consistent size-calling 
method.

Incorrect internal size standard. Use correct GeneScan® size 
standard.

Incorrect polymer composition. Check urea concentration and 
polymer composition against 
protocol.

Incorrect electrophoresis 
temperature

Check the Injection List for 
temperature setting.

If correct on Injection List, 
check the Log for a recording 
of the actual electrophoresis 
temperature.

Incorrectly defined size standard Define size-standard peak 
sizes separately for each 
incorrectly sized injection.

Runs get 
progressively 
slower (peaks 
come off at higher 
and higher scan 
numbers)

Capillary not refilling a. Check for leaks.

b. Check for bubbles in the 
syringe.

c. Replace capillary if 
clogged.

d. Increase capillary refill 
time.

Syringe out of polymer Fill syringe with fresh polymer.

Ambient temperature in laboratory 
changing

Ensure that the ambient 
temperature is between 15 and 
30 °C whenever the instrument 
is in operation, including nights 
and weekends. 

Do not keep the instrument in 
direct sunlight.

Runs get 
progressively faster 
(peaks come off at 
lower and lower 
scan numbers)

Water in syringe When loading syringe:

a. Prime syringe with small 
volume of polymer.

b. Invert syringe to coat 
capillary walls.

c. Discard polymer.

d. Fill syringe with fresh 
running polymer.

Ambient temperature in laboratory 
changing

Ensure that the ambient 
temperature is between 15 and 
30 °C whenever the instrument 
is in operation, including nights 
and weekends. 

Do not keep the instrument in 
direct sunlight.

Problems with peak number and position. (continued)

Observation Possible Causes Recommended Actions
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Peak spacing too 
high (sequencing)

Capillary clog See “Avoiding Capillary Clogs” 
on page 6-10.

Arcing to conductive surface on the 
instrument

a. Clean the heat plate, 
electrode and 
autosampler.

b. Ensure that the ambient 
temperature is between 
15 and 30 °C and the 
humidity is below 80%. 

c. Check for excessive 
condensation on the 
instrument.

Irregular peak 
spacing 
(sequencing)

Wrong mobility file Use correct mobility file.

Some but not all 
loci visible on 
electropherogram 
(GeneScan®)

Sample DNA is degraded Quantitate DNA and add more 
template. Repeat amplification.

Wash the sample in an Amicon 
Centricon-100 column and 
repeat amplification. 

Note For fragments smaller 
than 130 bp the Amicon 
Centricon-30 column is 
preferable.

Sample contains PCR inhibitor (for 
example, heme compounds, EDTA, 
or certain dyes)

a. Quantitate DNA and add 
minimum necessary 
volume of PCR product. 

b. Repeat amplification.

Problems with peak number and position. (continued)

Observation Possible Causes Recommended Actions
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Problems with Peak Quality and Resolution

Problems with peak quality and resolution. 

Observation Possible Cause Recommended Actions

Fuzzy/smeared 
peaks

Too much sample DNA Decrease injection time and/or 
voltage.

Dilute PCR sample before 
adding to 
formamide/size-standard mix.

Poor resolution Poor capillary performance Replace capillary.

Capillary clog (especially peaks 
that start normally but abruptly 
become broad at some point in run)

See “Avoiding Capillary Clogs” 
on page 6-10.

Old, defective, or incorrectly made 
buffer or polymer 

Replace buffer or polymer.

Injection time too long (broad 
peaks)

Decrease injection time.

Incorrectly prepared or degraded 
sample

Prepare new sample.

Incorrect buffer formulation Check if buffer formulation 
matches protocol 
requirements.

Incorrect polymer composition Check if polymer composition 
matches protocol 
requirements.

Electrophoresis voltage too high Decrease electrophoresis 
voltage by as much as 4 kV.

Note Increase 
electrophoresis time 
accordingly.

Sample concentrated by 
evaporation leaving excess salt 
behind.

Do not concentrate sample by 
evaporation. Use an Amicon 
Centricon®-100 column if 
necessary. 

Incomplete strand separation due 
to insufficient heat denaturation

Make sure the samples are 
heated at 95 °C for 5 minutes 
prior to loading onto 
autosampler. 

Too much DNA in sample Dilute sample before adding to 
formamide.

Wrong capillary used for POP-4™ or 
POP-6™ runs

Verify that you are using the 
correct capillary.
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Poor resolution Oil in sample (from DNA Thermal 
Cycler 480)

Carefully pipette PCR product 
without oil carryover.

Remove oil by organic 
extraction.

Poor quality water Use freshly autoclaved, 
distilled, deionized water.

Bacterial contamination in water 
vials or buffer

Change water and buffer vials 
regularly.

Syringe empty or incorrect Syringe 
Max Travel value

Fill syringe if necessary and 
recalibrate Syringe Max Travel 
value.

Capillary too short Increase capillary length.

Note Increase 
electrophoresis time 
accordingly.

Ethanol contamination 
(sequencing)

Remove ethanol by 
evaporation.

Peaks “trail” or 
shoulder into next 
peak

Template not accurately quantitated 
(DNA sequencing)

Quantitate template. Refer to 
the sequencing kit protocol for 
appropriate DNA quantities.

False stop (large 
peak in all four 
colors in dye primer 
sequencing)

Secondary structure a. Denature at 95° C for 5 
minutes.

b. Try dye terminator 
sequencing.

Failure to separate transformed and 
non-transformed vectors.

Use proper techniques to 
isolate transformed vector.

Primer-dimer formation during PCR 
amplification

Use different primers. 

For more information, see the 
following user manuals:

�  ABI PRISM® GeneScan 
Chemistry Guide 

�  ABI PRISM® DNA 
Sequencing Chemistry 
Guide

Problems with peak quality and resolution. (continued)

Observation Possible Cause Recommended Actions
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Problems with Poor Amplification

Problems with poor amplification. 

Observation Possible Cause Recommended Actions

Faint or no signal 
from sample DNA 
and from positive 
control

Insufficient injection or a 
mis-positioned capillary

Check that the capillary is 
0.5-mm or less, and is aligned 
with electrode end.

If you adjust the capillary, then 
recalibrate the autosampler.

Insufficient enzyme in reactions Use the recommended amount 
of enzyme.

Incomplete activation of AmpliTaq 
Gold™ DNA Polymerase.

Repeat amplification, making 
sure to hold reactions initially 
at 95 °C for 11 minutes.

Too little sample DNA added to 
reaction. 

Quantitate DNA and use the 
amount recommended in the 
protocol.

Incorrect or suboptimal thermal 
cycler parameters

Check protocol for correct 
thermal cycler parameters.

If the correct parameters were 
used, they may need to be 
optimized for your specific 
application. 

For example, allow a linear 
increase in extension time with 
increasing cycle number, 
increase time at denaturation 
plateau, and so on.

PCR Master Mix not well mixed 
before aliquoting

Vortex PCR Master Mix 
thoroughly.

Primer concentration too low Use the recommended primer 
concentration.
7-16 Troubleshooting



Faint or no signal 
from sample DNA 
and from positive 
control (continued)

Primers degraded Use new primers.

Note Preincubation at 
95 °C for 5 - 10 minutes should 
inactivate proteases or 
nucleases.

Too little free Mg2+ in reaction Check that you added 
sufficient total Mg2+ given the 
total dNTP concentration.

Note [Free Mg2+] = 
[Total Mg2+] - [Total dNTP]

Incorrect pH Verify buffer pH and buffer 
concentration.

Wrong PCR tube Use:

� Applied Biosystems 
GeneAmp® Thin-Walled 
Reaction Tubes for the 
DNA Thermal Cycler 480.

� MicroAmp® Reaction 
Tubes with Caps for the 
GeneAmp® PCR System 
(9700, 9600, and 2400).

MicroAmp® Base used with 
tray/retainer set and tubes in 
GeneAmp® PCR System (9700, 
9600, or 2400)

Remove MicroAmp® Base 
from tray/retainer set and 
repeat amplification.

Verify GeneAmp® PCR System 
protocols and programmed 
parameters

Refer to the thermal cycler 
user’s manual and check 
instrument calibration.

Tubes not seated tightly in the 
thermal cycler (DNA Thermal 
Cycler 480)

a. Push reaction tubes firmly 
into contact with block 
after first cycle. 

b. Repeat amplification.

GeneAmp® PCR System 9600 
heated cover misaligned

Align 9600 heated cover so 
that white stripes align after 
twisting the top portion 
clockwise.

Problems with poor amplification. (continued)

Observation Possible Cause Recommended Actions
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Good signal from 
positive control but 
faint or no signal 
from sample DNA

Sample contains PCR inhibitor (for 
example, heme compounds, EDTA, 
or certain dyes)

Quantitate DNA. 

Dilute if possible in order to 
add minimum necessary 
volume. Repeat amplification.

Wash the sample in an Amicon 
Centricon-100 column and 
repeat amplification. 

Note For fragments smaller 
than 130 bp use the Amicon 
Centricon-30 column instead.

Add bovine serum albumin 
(BSA) to the PCR reaction 
mixture. 

Sample DNA is degraded If possible, evaluate the quality 
of DNA sample by 

� Using the QuantiBlot 
Human DNA Quantitation 
kit.

� Running an agarose yield 
gel. 

If DNA is degraded, reamplify 
with an increased amount of 
DNA.

Incorrect pH Verify buffer pH and 
concentration.

If correct, quantitate sample 
DNA. Too little or too much 
DNA can alter the pH.

Primer choice not optimal (for 
example, primers may be annealing 
to sites of template secondary 
structure or may have internal 
secondary structure)

Use different primers. 

For more information, see the 
following:

� ABI PRISM® GeneScan 
Chemistry Guide 

�  ABI PRISM® DNA 
Sequencing Chemistry 
Guide 

Poor yield for 
multiplex PCR

Incorrect thermal cycling 
parameters

Add a 2 minute down-ramp 
time to thermal cycling profile 
between the denaturation and 
annealing stages, 

Note For multiplex PCR, a 
short down-ramp time is not 
necessarily optimal.

Problems with poor amplification. (continued)

Observation Possible Cause Recommended Actions
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Yield gets 
progressively 
poorer for 
successive PCR 
amplifications 
performed over 
time

Expired or mishandled reagents Check expiration dates on all 
reagents.

If not expired, verify that 
reagents are being stored and 
used according to 
manufacturer’s instructions.

Compare with PCR 
performance using fresh 
reagents.

Inconsistent yields 
with control DNA

Combined reagents not spun to 
bottom of sample tube

Place all reagents in apex of 
tube and spin briefly after 
combining.

Combined reagents left at room 
temperature or on ice for extended 
periods of time (encouraging 
mispriming and other primer 
artifacts)

Keep reactions on ice and load 
immediately.

Pipetting errors Follow all these precautionary 
measures:

� Calibrate pipettes.

� Attach tips firmly.

� Check all phases of 
pipetting technique.

� Whenever possible 
minimize pipetting small 
volumes (for example, 
make master mixes).

Note You may also want to 
consider using a 2-µL or other 
high-precision pipette

Problems with poor amplification. (continued)

Observation Possible Cause Recommended Actions
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Problems with Extra Peaks

Problems with extra peaks. 

Observation Possible Causes Recommended Actions

Extra peaks appear 
with no discernible 
pattern

Mixed sample Verify quality and integrity of 
sample.

Presence of exogenous DNA Use appropriate techniques to 
avoid introducing foreign DNA 
during laboratory handling.

Nonspecific priming (that is, 
primer-template mismatch)

Check for good primer design.

Add less template DNA. 

Note High DNA 
concentrations promote 
nonspecific annealing.

Add less primer DNA

Note High primer 
concentrations promote 
nonspecific annealing.

If you are not using AmpliTaq 
Gold DNA Polymerase, 
consider performing 
Hot-Start™ Technique.

Increase annealing 
temperature in 2 - 5 °C 
increments.

Decrease annealing and/or 
extension times.

Increase primer length.

Perform a second amplification 
with nested primers.

Perform Touchdown PCR. 

Primer-dimer and primer-oligomer 
artifacts

Check primers for 3' 
complementarity.

Design longer primers.

Reduce primer concentration.

Reduce number of PCR 
cycles.

Raise the annealing 
temperature in 2 - 5 °C 
increments.

Increase amount of target 
DNA.

Incomplete restriction (and/or 
ligation if performing AFLP)

Repeat restriction (and/or 
ligation).

If performing AFLP, too much DNA 
in reaction so that insufficient 
adaptor is present

Use the recommended amount 
of template DNA.
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Extra peaks with 
pattern

PCR run contaminated with 
Amplicons

a. Decontaminate 
equipment, tools, and 
working area. 

b. Check disposables and 
reagents as potential 
contaminated source.

Presence of split 
peaks differing in 
size by one base 
pair (GeneAmp®)

(Extra peak of size 
n + 1)

Partial nontemplate addition of an 
extra nucleotide (usually 
adenosine) to the blunt end of the 
PCR product

Add the correct amount of 
Mg2+ to the reaction mix.

Note High Mg2+ 
concentrations can lower the 
frequency of nontemplate 
nucleotide addition and vice 
versa.

Increasing the extension time 
at 72 °C will increase the 
frequency of nontemplate 
nucleotide addition.

For more suggestions refer to 
the ABI PRISM® GeneScan 
Chemistry Guide.

Problems with extra peaks. (continued)

Observation Possible Causes Recommended Actions
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A
Applied Biosystems 
Limited Warranty A
To What This
Warranty Applies

Applied Biosystems warrants to the Customer that, for a period ending on the earlier 
of one year from completion of installation or fifteen (15) months from the date of 
shipment to the Customer (the “Warranty Period”), the ABI PRISM® 310 DNA 
Sequencer purchased by the Customer (the “Instrument”) will be free from defects in 
material and workmanship, and will perform in accordance with the performance 
specifications contained in the Instrument User’s manual that accompanies the 
instrument (the “Specifications”). During the Warranty Period, if the Instrument fails to 
perform in accordance with such specifications, Applied Biosystems will repair or 
replace the Instrument at no charge to the Customer, subject to the conditions below.

To What This
Warranty Does Not

Apply

This Warranty does not apply to the Instrument's valves, reagent lines, or 
performance, unless the Customer uses only reagents and solvents supplied by 
Applied Biosystems or expressly recommended by Applied Biosystems, or to 
damages caused by reagents or solvents not supplied by Applied Biosystems, even 
though recommended by Applied Biosystems. This Warranty does not extend to any 
Instrument or part thereof (i) that has been the subjected of misuse, neglect or 
accident, (ii) that has been modified or repaired by any party other than Applied 
Biosystems or (iii) that has been used in a manner not in accordance with the 
instructions contained in the Instrument User's Manual. This Warranty does not cover 
the customer-installable consumable parts for the Instrument that are listed in the 
Instrument User's Manual.

Applied Biosystems
Obligation

Applied Biosystems obligation under this Warranty is limited to repairs or 
replacements that Applied Biosystems deems necessary to correct covered defects or 
failures of which Applied Biosystems is notified prior to expiration of the Warranty 
Period. All repairs and replacements under this Warranty shall be performed by 
Applied Biosystems on-site at the Customer's location at Applied Biosystems 
expense.

No agent, employee, or representative of Applied Biosystems has any authority to 
bind Applied Biosystems to any affirmation, representation, or warranty concerning 
the Instrument that is not contained in the printed product literature or this Warranty 
Statement. Any such affirmation, representation or warranty made by any agent, 
employee, or representative of Applied Biosystems shall not be binding on Applied 
Biosystems.

Applied Biosystems shall not be liable for any incidental, special, or consequential 
loss, damage or expense directly or indirectly arising from the purchase or use of the 
Instrument. Applied Biosystems makes no warranty whatsoever with regard to 
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products or parts furnished by third parties; such products or parts will be subject to 
the warranties, if any, of their respective manufacturers.

This Warranty is limited to the original Customer and is not transferable.

THIS WARRANTY IS THE SOLE AND EXCLUSIVE WARRANTY AS TO THE 
INSTRUMENT AND IS IN LIEU OF ANY OTHER EXPRESS OR IMPLIED 
WARRANTIES, INCLUDING, WITHOUT LIMITATION, ANY IMPLIED WARRANTY OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE AND OF ANY 
OTHER OBLIGATION ON THE PART OF APPLIED BIOSYSTEMS.

What is Conveyed by
Purchase

The purchase price of this ABI PRISM 310 Genetic Analyzer includes a grant of license 
under U.S. Patent No. 5, 567, 292, and method claims of its foreign counterparts, to 
use this particular instrument for electrophoresis methods employing fluorescence as 
a means of detection. No licenses or rights are conveyed with this purchase either 
expressly, by implication, or estoppel.
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480, GeneAmp DNA Thermal Cycler
performing PCR on kit A

3-17 to 3-18
thermal cycling conditions 3-18

48-well tray
GeneScan

materials required 3-5
sample sheet for Kit A 3-35

sample numbering 4-24
sequencing, materials 

required 2-8
877 Integrated Thermal Cycler

performing PCR on kit A
3-18 to 3-22

9600, GeneAmp PCR System
performing PCR on kit A

3-14 to 3-16
thermal cycling conditions

3-16
96-well tray

GeneScan
materials required 3-5
sample sheet for Kit B

3-36
sample numbering 4-25
sequencing, materials 2-7

96-well tray adaptor 1-22
96-well tray, using septa strips 

with 1-20
9700, GeneAmp PCR System

performing PCR on kit A
3-14 to 3-16

A
ABI 310 Genetic Analyzer. See 310 

Genetic Analyzer
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software required for 
sequencing 2-8

agarose gel, using to evaluate 
sample 7-18

amber LED light, status defined 1-5
amplification, troubleshooting

7-16 to 7-19
analysis parameters file 5-12

analyzing data 2-65
Anode electrode, about 4-3
autosampler

calibrating 4-27 to 4-28
calibration markers 4-27
how to 4-28
keyboard equivalents 4-27
when to calibrate 4-27

calibrating for GeneScan 
experiment 3-12
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experiment 2-16

calibrating, when to 6-4
cleaning, when to 4-24, 6-4
installing tray 4-24
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buffers 4-29 to 4-30
moving through Manual 

Control 4-26
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parts list 1-9
power down warning 4-36
tray types 4-24
wash solutions, positions 4-30

Autosampler Calibration window
using to calibrate 4-28

autosampler calibration, how to 
manually test 6-6

B
backing up files 6-12
base, color assigned after 

analysis 5-28
Beer’s Law, converting A260 to 

concentration 2-22
bubbles, in polymer 6-7, 6-9
buffer reservoir, filling up during 

run 6-9
buffers

correcting leaks 6-8
filling reservoirs, how to 4-23
loading for GeneScan 

experiment 3-12
loading for sequencing 

experiment 2-17
loading on autosampler 4-29 to 

4-30
replacing, when to 2-10, 3-6
storing

sequencing 2-10, 3-6
sequencing with DSP 2-75
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C
cables and power cords, routing 6-2
calibrating autosampler 4-27 to 4-28

calibration markers 4-27
how to calibrate 4-28
keyboard equivalents 4-27
when to calibrate 4-27, 6-4

calibration of autosampler, how to 
manually test 6-6

cancelling running module 5-15
capillary

about 1-20
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window 4-10
connecting to the pump block

GeneScan 3-11 to 3-12
sequencing 2-15 to 2-16

cutting the capillary 4-10
filling with DNA Sequencing 

Polymer (DSP) 2-74
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block 4-11 to 4-15
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4-11 to 4-12
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4-12 to 4-13
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counter 4-14
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removing for storage 4-15
removing from package 1-20
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5-18
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installed 4-2
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(table) 1-20

capillary clogs, how to avoid 6-10
capillary window

testing for position
GeneScan 3-40

capillary, verifying correct fill
6-10

Cathode electrode
about 4-3
cleaning 3-10
preparing 4-4 to 4-6

cleaning 4-6, 6-3
installing 4-4
straightening the 

electrode 4-6
trimming 4-5

chemistries, DNA sequencing 2-3
cleaning

autosampler, when to 6-4
capillary window, how to 4-10
Cathode electrode, how to

4-6, 6-3
electrode, how to 3-10
pump block, how to 4-8
syringe 4-19, 6-5

cleaning, general 
recommendations 6-2

clogged capillary, how to avoid
6-10

cold reset, performing 4-34
Collection software

about 5-2 to 5-4
installing and configuring

5-5 to 5-7
other software programs 1-19
special software for data collection 

and analysis 1-18
using to fill syringe 2-68 to 2-73

color
assigned to bases after data 

analysis 5-28
guide, raw data displays 1-16

Communication Port, general 
settings 5-13

communication port, setting 5-13
communication problem, reset 

PRAM 6-13
communication retries, about 6-11
communication, between Macintosh 

and instrument, 
monitoring 6-11

Communications Diagnostics 
window 6-11

computer 1-13
RAM requirements 1-13
system requirements 1-13

computer maintenance 6-12 to 6-13
hard drive maintenance

6-12 to 6-13
inits, eliminating conflicts 6-13

configuring Collection software
5-5 to 5-7

consumables 1-19 to 1-25
GeneScan consumables 1-25
sequencing consumables 1-24
shared consumables

1-20 to 1-23
coprocessor not found error, 

Macintosh 6-13
copying, matrices using DataUtility 

software 1-18
cycle sequencing

about 2-5

D
data analysis, troubleshooting 7-3

DataUtility program
copying matrix files 1-18
viewing raw data of matrix 

runs 2-55, 2-63
Deionizing formamide 3-28
detection system

parts list 1-12
positioning capillary in the 

detector 4-12 to 4-13
DNA

templates
quantity 2-22

DNA Sequencing
chemistries 2-3
Polymer (DSP)

filling the capillary 2-74
preparing syringe

2-66 to 2-73
setting up reagents for 2-75
storing 2-74

 See Also sequencing
dRhodamine

matrix standards, about 2-45
Dye Indicators preferences

5-13 to 5-14
dye set, colors and virtual filter, 

GeneScan 1-17
dye set, colors and virtual filters, 

sequencing 1-16
dye set, virtual filters and matrix 

files 1-15
dye sets

and wavelengths, colors 
represented by 5-28

choosing for sequencing 2-42
dyes, compatibility under virtual 

filters 1-15

E
electrical, troubleshooting 7-4 to 7-5
electrodes 4-3 to 4-6

about 4-3
cleaning for GeneScan 3-10
cleaning for sequencing 2-15
positioning the capillary near the 

electrode 4-14
preparing the Cathode 

electrode 4-4 to 4-6
cleaning 4-6, 6-3
installing 4-4
straightening the 

electrode 4-6
trimming 4-5

Electrokinetic Injection (Voltage and 
Time) parameter 5-25

electrophoresis
Electrophoresis History 

window 5-30 to 5-31
pre-injection (prerun) 5-18
running time 5-26
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running voltage 5-25
temperature 5-26
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sequencing 2-10, 3-6
sequencing runs with DSP 2-75
See Also buffers
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file) 5-29 to 5-30

error, leak detect 6-7
experiments

GeneScan 3-1 to 3-45
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for run 3-7 to 3-13
materials required 3-3 to 3-5
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3-42 to 3-45
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3-34 to 3-36
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loading 3-28 to 3-33
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sample 2-63 to 2-65
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terminators 2-5
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2-11 to 2-17
Injection List, preparing 2-49 

to 2-50, 3-37 to 3-38
materials required 2-6 to 2-8
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2-55 to 2-62
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preparing 2-45
reagents, setting up 2-10
required files for 
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2-42 to 2-44

sample sheet, preparing
2-47 to 2-48

samples, denaturing and 
loading 2-40 to 2-41

samples, running and 
monitoring 2-53

software required 2-8
summary of procedures 2-5
switching between 

sequencing and 
GeneScan 2-9
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2-66 to 2-73

using Polymer (DSP)
2-74 to 2-75

exporting files 5-32
Extension Manager

eliminating conflicts between 
inits 6-13

when installing software 5-6

F
fax, technical support xvii
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box 5-8
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box 5-9
File, recovery 5-33
files

autonumbering 5-13
importing/exporting 5-32
location, how to find 5-2
required for sequencing

2-42 to 2-44
See Also matrix files

filters, virtual and dye set, matrix 
file 1-15

firmware, about 4-33
firmware, resending 4-34
Formamide, how to deionize 3-28
formamide-size standard mix, 

preparing 3-29
fragmented memory, using hard disk 

maintenance program 6-12

G
gels, evaluating samples using an 

agarose gel 7-18
General Settings preferences 5-12
GeneScan 3-1 to 3-45

310 Genetic Analyzer, how it 
works 1-3

color guide for displaying raw 
data 1-17

consumables 1-25
Electrophoresis Running Voltage

about 5-26
GeneScan Sample Sheets, how to 

fill out 5-19 to 5-20
Genetic Analyzer, preparing for 

run 3-7 to 3-13
calibrating autosampler 3-12
cleaning and loading the 

syringe 3-7
cleaning the electrode 3-10
cleaning the pump block 3-7
filling pump block 3-10
installing capillary

3-11 to 3-12
loading buffers 3-12

preheating heat plate 3-13
Injection List

how to fill out 5-22 to 5-23
preferences 5-11 to 5-12

materials required 3-3 to 3-5
matrix files

creating GeneScan matrix 
file 3-42 to 3-45

preparing matrix standard 
samples 3-29

shared consumables, with DNA 
sequencing 1-20 to 1-23

software
described 1-18
required 3-5

summary of procedures 3-3
switching between sequencing, 

and 2-9, 3-6
virtual filters 5-28

Genetic Analyzer, preparing
2-11 to 2-17

calibrating autosampler 2-16
electrode, cleaning 2-15
GeneScan, preparing for run 3-7 

to 3-13
installing capillary 2-15 to 2-16
loading buffers 2-17
preheating heat plate 2-17
pump block, cleaning 2-11
pump block, filling 2-14
syringe, cleaning and 

loading 2-12
See Also GeneScan: Genetic 

Analyzer, preparing
glass syringes

parts lists 4-17
sizes, applications 4-17
See Also syringe

Global Serial Number, using to 
automatically number 
files 5-13

green LED light, status defined 1-5

H
hard disk maintenance 6-12 to 6-13
heat plate

preheating for GeneScan 
experiment 3-13

preheating for sequencing 
experiment 2-17

help
e-mail addresses xvii
fax numbers xvii
internet address xx
safety information xxi
technical support xvii to xxii
telephone numbers xvii

history 5-29 to 5-31
Electrophoresis History 

window 5-30 to 5-31
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Log file, about 5-29 to 5-30
homing, autosampler 4-26
humidity, in the laboratory 6-2

I
importing files 5-32
improper shutdown warning, 

disabling 5-6
inits

disabling 5-6
eliminating conflicts 6-13

injection counter
resetting, GeneScan 3-12
resetting, sequencing 2-16

Injection List
adding rows 2-51, 3-39
changing sample order 2-52, 

3-39
configuring for kit A and B for 

GeneScan 3-37
defined 5-3
how to fill out 5-21 to 5-26

editing parameters
5-23 to 5-24

GeneScan Injection 
List 5-22 to 5-23

sequencing Injection 
List 5-21 to 5-22

modifying change run 
parameters 2-51, 3-39

multiple injections, making 2-50, 
3-38

preferences 5-10 to 5-12
preparing

sequencing 2-49 to 2-50, 
3-37 to 3-38

installing
autosampler tray 4-24
capillary, on empty pump 

block 4-11 to 4-15
Cathode electrode 4-4
Collection software 5-5 to 5-7
mobility files 5-5
syringe 4-20 to 4-21

Instrument file 2-61
internet address xvii

K
keyboard, autosampler calibration 

equivalents 4-27
kit A/B, injection list 3-37

L
leak detect error 6-7
leaks

polymer, checking for 6-7 to 6-9
syringe, correcting leaks at 6-8

LEDs (lights)
indicating instrument status 1-5

service LEDs, table of 1-6
loading samples

GeneScan 3-31
sequencing 2-41

Log file, about 5-29 to 5-30
long-term shutdown 4-31 to 4-32

M
Macintosh computer 1-13

Communication Port, general 
settings 5-13

configuring for automatic 
recovery 4-36

disabling improper shutdown 
warning 5-6

maintenance 6-12 to 6-13
hard drive 6-12 to 6-13
inits, eliminating 

conflicts 6-13
RAM requirements 1-13
recovering from power 

failure 4-36
setting general controls 5-6
system requirements 1-13

Macintosh, crashes 6-13
Macintosh, locks up 6-14
Macintosh, type 11 error 6-13
maintenance, system

autosampler
when to calibrate 6-4
when to clean 6-4

checking for polymer leaks
6-7 to 6-9

pump block, caring for 6-3
syringe, caring for 6-5
See Also Macintosh computer

manual control
moving the autosampler 4-26
moving the syringe 4-21

Manual Control window 5-15 to 5-18
editing a module 5-17 to 5-18
executing a function 5-15
starting a module 5-15

materials required
GeneScan 3-3 to 3-5
sequencing 2-6 to 2-8

matrix file, virtual filters and dye 
set 1-15

matrix files
about 2-44, 3-27, 5-33
copying matrices using DataUtility 

software 1-18
creating DNA matrix file from 

matrix standards
GeneScan 3-42 to 3-45
sequencing 2-55 to 2-62

creating DNA matrix from a 
sample 2-63 to 2-65

GeneScan
creating matrix file

3-42 to 3-45
number of files needed 5-33
why matrix files are needed 5-33

matrix standards
checking quality

GeneScan 3-44
sequencing 2-60 to 2-62

denaturing the matrix standard 
samples

GeneScan 3-30 to 3-31
sequencing 2-45

preparing standard samples
GeneScan 3-29
sequencing 2-45

mobility files, installing 5-5
See Also files, required for 

sequencing
modules

editing 5-17 to 5-18
pausing 5-15
Seq Fill Capillary module, 

checking for leaks 6-7
starting 5-15

monitoring
raw data 5-27 to 5-28
run of the instrument

GeneScan 3-40
sequencing 2-53

O
On/Off switch, placement 1-6
o-rings

syringe, part number 1-23
See Also syringes

P
parameters

editing Injection List 5-23 to 5-24
Electrophoresis Running 

Temperature 5-26
Electrophoresis Running 

Time 5-26
Electrophoresis Running 

voltage 5-25
Run 5-25 to 5-26
voltage and time 5-25

parts list
back of instrument 1-6 to 1-7
behind the doors 1-8 to 1-12

autosampler parts 1-9
detection system parts 1-12
pump block parts 1-10 to 

1-11
front of instrument 1-5
 See Also consumables

Pause Alert window, using when leak 
detector triggered 4-15

pausing, a run 5-15
PCR on kit A
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pooling PCR products
produced on the 480 3-23

thermal cycling conditions
for the 480 3-18
for the 9600 or 2400 3-16

with GeneAmp PCR System 
2400 3-14 to 3-16

with GeneAmp PCR System 
9600 3-14 to 3-16

with the 877 Integrated Thermal 
Cycler 3-18 to 3-22

peaks, troubleshooting
extra peaks 7-20 to 7-21
number and position 7-10 to 7-12
quality and resolution

7-14 to 7-15
plastic syringes

parts list 4-17
sizes, applications 4-17
See Also syringe

polymer
checking for leaks 6-7 to 6-9

correcting leaks at the 
buffer 6-8

correcting leaks at the 
syringe 6-8

how to 6-7
filling pump block with 4-9
GeneScan polymer 1-25
loading syringe 4-22
sequencing polymer, types 

available 1-24
polymer POP-6 2-11 to 2-17

calibrating autosampler 2-16
electrode, cleaning 2-15
installing capillary 2-15 to 2-16
loading buffers 2-17
preheating heat plate 2-17
pump block, filling 2-14
syringe, cleaning and 

loading 2-12
polymer, bubbles in 6-7, 6-9
polymer, not enough 6-6
pooling PCR products

produced on the 480 3-23
power cord, about 1-7
power cords and cables, routing

6-2
power down warning 4-36
power failure, recovering from 4-36
power troubleshooting 7-4 to 7-5
PRAM, how to reset 6-13
preferences 5-8 to 5-14

Dye Indicators preferences
5-13 to 5-14

File Location preferences 5-8
File Names preferences 5-9
General Settings preferences

5-12
Print Monitor, setting 5-6

Sample Sheets preferences
5-9 to 5-10, 5-10 to 5-12

preferences file, 310 data collection, 
purpose 5-4

pre-injection electrophoresis, editing 
parameter 5-18

prerun time, editing parameter
5-18

primer files, choosing for 
sequencing 2-42

Print Monitor, setting in 
Preferences 5-6

pump block
cleaning

for GeneScan 3-7
for sequencing 2-11

cleaning, how to 4-8
connecting capillary to

GeneScan 3-11 to 3-12
sequencing 2-15 to 2-16

filling 4-9
channels with polymer

GeneScan experiment
3-10

sequencing experiment
2-14

installing capillary on empty 
block 4-11 to 4-15

after installing 4-15
connecting to block

4-11 to 4-12
positioning in the detector

4-12 to 4-13
positioning near the 

electrode 4-14
resetting injection 

counter 4-14
parts list 1-10 to 1-11
removing pump block 4-7
replacing pump block 4-9
when to clean 6-3

pump block, cleaning 2-11
pump time, syringe 5-18

Q
quantitation

converting A260 to 
concentration 2-22

quickstart, experiments
GeneScan 3-1 to 3-45

Genetic Analyzer, preparing 
for run 3-7 to 3-13

materials required
3-3 to 3-5

matrix file, creating
3-42 to 3-45

reagents, setting up 3-6
sample sheet, preparing

3-34 to 3-36
samples, denaturing and 

loading 3-28 to 3-33
samples, running and 

monitoring 3-40
summary of procedures 3-3
switching between 

sequencing and 
GeneScan 3-6

sequencing 2-2 to 2-75
analyzing data 2-65
cycle sequencing

using terminators 2-5
Genetic Analyzer, preparing

2-11 to 2-17
Injection List, preparing 2-49 

to 2-50, 3-37 to 3-38
materials required 2-6 to 2-8
matrix file, creating

2-55 to 2-62
from a sample

2-63 to 2-65
matrix standards, 

preparing 2-45
reagents, setting up 2-10
required files for 

sequencing
2-42 to 2-44

sample sheet, preparing
2-47 to 2-48

samples, denaturing and 
loading 2-40 to 2-41

samples, running and 
monitoring 2-53

software required 2-8
summary of procedures 2-5
switching between 

sequencing and 
GeneScan 2-9

syringes, preparing
2-66 to 2-73

using Polymer (DSP)
2-74, 2-75

quitting 4-31 to 4-32

R
RAM

requirements 1-13
reset, performing 4-35

raw data
and analyzed data, difference 

between 5-27
Raw Data window 5-27 to 5-28

raw data and analyzed data, 
difference 5-27

resizing 5-27
reagents

preparing for GeneScan 
experiment 3-6

preparing for sequencing 
experiment 2-10

setting up runs with DSP 2-75
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Recovery files 5-33
red LED light, status defined 1-5
reference table, run modules and dye 

set/primer files 2-43
refilling

capillary 5-18
removing
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